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1. Contact Information

Redlake
3440 East Britannia Drive
Tucson, AZ  85706-5006
USA

Telephone:  520-547-2772
Toll Free:  800-462-4307
Toll Free for Technical Support Only:  800-854-7006

Email for Technical Support:  support@redlake.com
Email for Sales:  sales@redlake.com

World-wide office locations and contact information is available on our website:
www.redlake.com

The information in this manual is for information purposes only and is subject to change 
without notice. Redlake Inc., hereafter referred to as Redlake, makes no warranty of any 
kind regarding the information contained in this manual, including but not limited to implied 
warranties of merchantability and fitness for a particular purpose. Redlake shall not be 
liable for errors contained herein nor for incidental or consequential damages from the 
furnishing of this information. No part of this manual may be copied, reproduced, 
recorded, transmitted or translated without the express written permission of Redlake. 

Send comments regarding the manual to info@redlake.com

Copyright © 2007 Redlake Inc.
Manual Version 3.5.4
PN  91000122-003
July 26, 2007
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2. Precautions

 2.1. Temperature
The HG-100K/LE will operate satisfactorily in an environment where the ambient 
temperature is between 0° C and 45° C (32° F and 113° F). The HG-TH/CH will operate in 
an environment where the ambient temperature is between 0° C and 40° C (32° F and 
104° F). The HG-XR/XL will operate in an environment where the ambient temperature is 
between -10° C and 45° C (14° F and 113° F).The maximum humidity is 80%, non-
condensing, at 40° C. 
The internal temperature of the cameras will run higher than the ambient temperature.

 2.2. Battery
The HG-100K/LE/XR/XL and HG-TH Controller battery pack contains small amounts of 
harmful substances. A battery pack may explode if it is incorrectly replaced, exposed to 
fire or water, short-circuited or disassembled. Do not put batteries in trash that is disposed 
of in landfills. Replace with approved batteries only. When disposing of depleted batteries, 
comply with local ordinances and your company's safety standards.

 2.3. Laser
Do not focus a laser beam on the sensor directly or by reflection, as it will cause 
permanent damage to the sensor. Any laser powerful enough to produce localized heating 
at the surface of the sensor will cause damage, even if the camera power is off. Laser 
damaged sensors are NOT covered by the warranty.

 2.4. Storage
Use the original shipping carton when transporting the HG-100K/LE/XR/XL/TH/CH 
camera, HG-TH Camera Controller and Hub Sync Unit (HSU). If you must ship your 
camera system frequently, you may wish to purchase a carrying case. Please contact your 
Redlake representative for details. 

 2.5. Signal Levels
Always check the voltage on the trigger line before connecting to the camera. Signal 
levels above 5 volts at the Sync In and Trigger In TTL inputs can cause permanent 
damage to the system. For additional information, see “Configurable Input Connector 
(Sync In)” on page 121.

 2.6. Shock and Vibration
HG-100K/LE/XR/XL/TH/CH components including cameras, heads, cables, connectors, 
HSUs and controllers are designed to perform to specification in environments where they 
may be routinely subject to high-G shock and vibration. 
For additional information see “Appendix A Camera Specifications” on page 98.
They are not designed to withstand crushing or shearing blows. Components must be 
installed such that they will not be subject to collisions with other objects. All cables must 
be dressed with sufficient strain relief so that connections are not stressed when 
component positions shift during high-G events. Damage to camera components due to 
crushing or shearing blows or excessive strain on cables will not be covered under the 
manufacturer's warranty.
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 2.7. Bend Radius on the HG-TH Tethered Head Cable
Do not bend the HG-TH Tethered Head cables at an angle greater than 5 cm in radius. It 
will cause permanent damage to the cable and will adversely affect imaging performance 
and reliability. 

 2.8. HG-TH Controller Heat Sink Device
The HG-TH Controller will operate satisfactorily in most environments (for example, on a 
workbench or tabletop) with the heat sink and rubber feet mounted. The rubber feet and 
heat sink may be removed if the Controller is mounted on a metal object that will act as a 
heat sink. For more information, see “HG-TH Camera Controller Dimensions and 
Mounting Holes” on page 109.
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3. Compliance Certifications

FCC Declaration
This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits provide reasonable protection 
against harmful interference in a residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed and used in accordance with 
the instructions, may cause harmful interference to radio communications. However, there 
is no guarantee that interference will not occur in a particular installation. If this equipment 
does cause harmful interference to radio or television reception, which can be determined 
by turning the equipment off and on, the user is encouraged to try to correct the 
interference by one or more of the following measures:

1. Reorient or relocate the receiving antenna.

2. Increase the separation between the equipment and receiver.

3. Connect the equipment into an outlet on a circuit different from that to which the  
receiver is connected.

4. Consult the dealer or an experienced radio/TV technician for help.
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4. System Description

MotionXtra HG-100K, HG-LE, HG-XR, HG-XL, HG-TH, and HG-CH are high-speed, 
digital imaging systems, designed to operate in the most challenging and rugged 
environments. This section will introduce you to the system level concepts of the 
MotionXtra HG digital imaging systems. 

For more information, see “System Components” on page 7.

 4.1. MotionXtra HG-100K System
The HG-100K is a rugged, high-resolution, high-speed camera designed to withstand 
harsh environments. A 1000Base-T Ethernet interface allows remote camera control and 
fast image transfer. A small backup battery is included within the camera to preserve the 
recording should a power failure occur after the event. The HG-100K model features an 
exclusive 1.7 megapixel CMOS sensor, and is capable of recording 1,000 fps at 1504 x 
1128 pixel resolution and up to 100,000 fps at smaller resolutions.

 4.2. MotionXtra HG-LE System
Built on the same design and with the same features of the HG-100K, the HG-LE is an 
economical variant using one-half the sensor resolution and one-half the memory. The 
HG-LE offers mid-range frame rates and resolution at an affordable price. Its setup and 
operation are identical to the HG-100K.

 4.3. MotionXtra HG-XR Camera System
The rugged 100G rated design of the HG-XR along with its extended record capability 
makes it the perfect solution for recording events such as missile launches, explosives 
tests, automotive rollover tests and for biomechanical research. The on-board IRIG/GPS 
time decoder provides extremely accurate synchronization on the range. At full resolution 
and 1000 fps, an HG-XR, with the full memory option, records for longer than 20 seconds. 
Longer record times are possible at reduced resolutions.

 4.4. MotionXtra HG-XL Camera System
The HG-XL is identical to the HG-XR with the exception that the HG-XL does not have 
IRIG synchronization or time stamp.

 4.5. MotionXtra HG-TH Tethered Head Camera System
The tethered-head design offers significant versatility with small, lightweight Camera 
Heads that fit into confined spaces or onto low mass mounting surfaces. Flexible in 
configuration, select from one to four Camera Heads with 4 GB or 8 GB of memory.  
The camera system provides advanced features for synchronized, multi-view imaging in  
high-G environments.

 4.6. MotionXtra HG-CH Compact Head Camera System
The compact head design is based on the HG-TH, using the same controller and offering 
identical functionality, but with less weight and the ability to fit into more confined spaces.   
HG-CH and HG-TH camera heads can be used interchangeably to suit the desired 
application.
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 4.7. Camera Control Unit
The Camera Control Unit (CCU) is a user-supplied PC with MotionCentral control software 
installed. With the proper network configuration, the CCU can also provide a 
communication link from the discrete camera network to a user's network backbone for file 
transfer. Install additional CCUs within the same discrete network to enable remote 
viewing and control of the cameras. 

 4.8. MotionCentral Camera Control Software
MotionCentral control software is a Microsoft® Windows®-based application designed for 
set up and control of one or many networked MotionXtra HG systems and legacy* camera 
systems concurrently. It provides the ability to view live images from the camera for set up 
and to play back images from the camera or computer hard drive. MotionCentral offers 
ease of use with an intuitive user interface.

* The term "legacy," as it is used in this manual, refers to earlier Redlake camera systems  
(e.g., HG-2000, CR-2000, and HG-TX) 

 4.9. Display Control Unit
The DCU (Display Control Unit) is a portable PC or Tablet PC used primarily for setting up 
cameras, including framing field of view, focusing and setting the f-stop. Connect it directly 
to a camera, HSU or networked hub. The DCU runs the same MotionCentral software as 
the CCU so it is fully capable of all camera control functions. 

 4.10. Hub Sync Unit
The HSU (Hub Sync Unit) is an eight-port network switch ideal for use in high-G 
environments. It supports the networking of multiple MotionXtra HG camera systems as 
well as connectivity to Legacy camera systems through J-Boxes and D-Boxes. The HSU 
provides a precision clock for the frame and trigger synchronization of multiple camera 
systems. The HSU also provides power to connected cameras.
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5. System Components

 5.1. HG-100K/LE/XR/XL Cameras

5.1.1.  HG-100K/LE Connectors and Indicators
MODE indicator – if the MODE light is off, it indicates that the camera is in Live or 
Standby mode. If the yellow light is blinking, that indicates that the camera is in Record 
mode. A steady yellow light indicates that the camera has been triggered.

MEMORY indicator – a steady red light indicates that the camera contains images that 
have not yet been accessed. A blinking green light indicates that the camera is either 
playing or downloading an image from memory. A yellow light indicates that there are 
captured images in memory that have been accessed. If the light is off, it indicates that 
there is memory available.

RESET button – resets the camera's micro controller (camera "warm boot"). The camera 
will retain its configuration settings (resolution, frame rate, exposure, etc.) and images in 
memory. 

OFF button – turns the battery power off, not the power from the main source. When the 
camera is on battery power, pressing the OFF button deletes any images currently in 
camera memory.

Camera connector – is a ruggedized RJ-45 connector for 100/1000Base-T 
communications between the camera and the CCU.

SYNC IN connector – connects an external device for synchronizing the camera. 

TRIG IN connector – connects an external device for triggering the camera. 

STROBE OUT connector – outputs pulses for synchronizing the timing of a strobe, 
camera or other peripheral device with the camera's exposure.

DCU connector – is a standard RJ-45 connector for 100Base-TX communication with the 
DCU. The primary function of the 100Base-TX is image display during focus and set up of 
the camera. This connector is not high-G rated and is not intended for use during high-G 
events.

STP connector – (Sync/Trigger-Return/Power) connects cameras to HSU, and HSUs to 
other HSUs. For more information, see “STP Cable Lengths and Timing” on page 138.

COM indicator – a steady green light indicates that the camera is connected to the 
system. A blinking green light indicates that the camera is transmitting or receiving 
information.

PWR indicator – a green light indicates that the power is on and the battery is fully 
charged. A red light indicates that the camera has lost power and is using the battery 
backup system to preserve image data in memory. A green light with intermittent flashing 
yellow indicates that power is on, but the battery is not fully charged. 

SYNC indicator – a green light indicates that there is a sync signal present. If the green 
light is off, there is no sync signal present.



MotionXtra User’s Manual

Redlake 7/26/07 8

 Figure 5.1: HG-100K/LE back panel
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5.1.2.  HG-XR/XL Connectors and Indicators
MODE indicator – if the MODE light is off, it indicates that the camera is in Live or 
Standby mode. A blinking yellow light indicates that the camera is in Record mode. 
A steady yellow light indicates that the camera has been triggered.

MEMORY indicator – a steady red light indicates that the camera contains images that 
have not yet been accessed. A blinking green light indicates that the camera is either 
playing or downloading an image from memory. A yellow light indicates that there are 
captured images in memory that have been accessed. If the light is off, that indicates there 
is memory available.

LIVE button – sends live composite video out of the COMP OUT connector to an  
NTSC/PAL video monitor.

RESET button – resets the camera's micro controller (camera "warm boot"). The camera 
will retain its configuration settings (resolution, frame rate, exposure, etc.) and images in 
memory. 

OFF button – turns the battery power off, not the power from the main source. When the 
camera is on battery power, pressing the OFF button deletes any images currently in 
camera memory.

CCU connector – is a ruggedized RJ-45 connector for 100/1000Base-T communications 
between the camera and the CCU.

IRIG UNMOD connector – a standard BNC for unmodulated IRIG input.*

IRIG MOD connector – is a standard BNC for modulated IRIG input.*

IRIG GPS indicator – blinks when it sees a signal and goes steady green when the 
camera is locked to an IRIG or GPS signal. *

GPS ANT connector – is an SMA connector for connecting a GPS antenna to the camera.

TRIG IN connector – connects an external device for triggering the camera. 

STROBE connector – outputs pulses for synchronizing the timing of a strobe, camera, or 
other peripheral device with the camera's exposure.

DCU connector – is a standard RJ-45 connector for communication with the DCU. The 
primary function of the 100Base-TX is image display during focus and set up of the 
camera. This connector is not high-G rated and is not intended for use during high-G 
events.

SYNC IN connector – connects an external device for synchronizing the camera. 

COMP OUT connector – connects an NTSC/PAL video monitor for composite video 
output.

STP connector – (Sync/Trigger-Return/Power) connects cameras to HSU, and HSUs to 
other HSUs. For more information, see “STP Cable Lengths and Timing” on page 138.

COMM indicator – a steady green light indicates that the camera is connected to the 
system. A blinking green light indicates that the camera is transmitting or receiving 
information.

PWR indicator – a green light indicates that the power is on and the battery is fully 
charged. A red light indicates that the camera has lost power and is using the battery 
backup system to preserve image data in memory. A green light with intermittent flashing 
yellow indicates that power is on, but the battery is not fully charged. 

SYNC indicator – a green light indicates that there is a sync signal present. If the green 
light is off, there is no sync signal present.

Lens Control connector – a serial interface for lens control (located on the front of the 
camera).

Additional connector – not yet implemented (located on the front of the camera).

*  IRIG functionality is only available on the HG-XR.
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 Figure 5.2: HG-XR back panel
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 5.2. HG-TH/CH Camera System

5.2.1.  HG-TH Camera Head Connectors and Indicators
PWR indicator – a green light indicates the camera is ready for operation. A yellow light 
indicates the power is on.

SYNC indicator – if the SYNC light is on, a sync signal is present and sourced from the 
Root Hub. The light flashes when sync is present but the Root Hub is not present. 

MODE indicator – if the MODE light is off, it indicates that the camera is in Live or 
Standby mode. A blinking yellow light indicates that the camera is in Record mode. A 
steady yellow light indicates that the camera has been triggered.

STROBE OUT connector – outputs pulses for synchronizing the timing of a strobe, 
camera, or other peripheral device with the camera's exposure.

Camera Head connector – provides a connection from the Camera Head to the Camera 
Controller via the Tethered Head cable. 

 Figure 5.3: HG-TH Camera Head top view
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5.2.2.  HG-CH Connectors and Indicators 
SDR Cables – two cables attached to the Camera Head connect to the Interface Unit.

SDR Cable connectors – located inside the cable clamp on the Interface Unit, these two 
connectors accept the left and right SDR cables from the Camera Head.

PWR indicator – a green light indicates the camera is ready for operation. A yellow LED 
indicates the power is on.

SYNC indicator – if the SYNC LED is on, a sync signal is present and sourced from the 
Root Hub. The LED flashes when sync is present but the Root Hub is not present. 

MODE indicator – if the MODE LED is off, it indicates the camera is in Live, or Standby 
mode. If the yellow LED is blinking, it indicates the camera is in Record mode. A steady 
yellow light indicates that the camera has been triggered. 

STROBE OUT connector – outputs pulses for synchronizing the timing of a strobe, 
camera, or other peripheral device with the camera's exposure.

Camera Head connector – provides a connection from the Interface Unit to the Camera 
Controller via the Tethered Head cable.           

 Figure 5.4: HG-CH Camera Head front view

 Figure 5.5: HG-CH Interface Unit top view
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5.2.3.  HG-TH Camera Controller Connectors and Indicators
CCU connector – is a ruggedized RJ-45 connector for 100/1000Base-T communications 
between the camera and the CCU.

COM indicator – a steady green LED indicates that the camera is connected to the 
system. A blinking green light indicates that the camera is transmitting or receiving 
information.

RESET camera "warm boot" button – resets the camera's micro controller. The camera 
will retain its configuration settings (resolution, frame rate, exposure, etc.) and retain 
images in memory.

HEAD SELECT button – turns the output to the NTSC/PAL monitor on/off. In multi-
camera head configurations, it switches the output to the next camera connected to the 
controller. 

OFF (battery off) button – turns the battery power off, not the power, from the main 
source. The OFF button deletes the images currently in the memory only when the 
camera is on battery power.

POWER indicator – a green light indicates that power is on and the battery is fully 
charged. A red LED indicates that the camera has lost power and is using the battery 
backup system to preserve image data in memory. A green light with intermittent flashing 
yellow indicates that the power is ON, but that the battery is not fully charged. 

MODE indicator – if the MODE LED is off, it indicates that the camera is in Live or 
Standby mode. If the yellow LED is blinking, it indicates that the camera is in Record 
mode. A steady yellow light indicates that the camera has been triggered.

MEM indicator – a steady red light indicates the camera contains images that have not 
yet been accessed. A blinking green LED indicates the camera is either playing or 
downloading an image from memory. A yellow LED indicates there are captured images in 
memory that have been accessed. If the LED is OFF, it indicates that there is memory 
available.

DCU 100Base-TX connector – is a standard RJ-45 connector for 100Base-TX 
communication with the DCU. The primary function of the 100Base-TX is image display 
during focus and set up of the camera. This connector is not high-G rated and is not 
intended for use during high-G events.

SYNC IN connector – connects an external device for synchronizing the camera. 

Composite Out BNC connector-connects an NTSC/Pal monitor for composite video 
output.

TRIG IN connector – connects an external device for triggering the camera.

SYNC indicator-a green LED indicates that there is a sync signal present. If the green 
LED is off, there is no sync signal present.

Camera Head connectors – connects the Camera Heads to the Camera Controller via 
the Tethered Head cable.

HD-1, HD-2, HD-3, HD-4 indicators – indicates that the Camera Heads are connected to 
the camera LAN.

STP connector – (Sync/Trigger-Return/Power) connects cameras to HSU, and HSU to 
HSU. For more information, see “STP Cable Lengths and Timing” on page 138.
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 Figure 5.6: HG-TH Camera Controller
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5.2.4.  HSU Connectors and Indicators
POWER connector – connects the HSU to the power source. Each HSU in a multi-HSU 
network requires a separate power source. 

LINK connector – connects one HSU to another in a daisy chain configuration for  
multi-HSU LAN configurations. Use the Link Connector to establish an HSU as a Root 
Hub by installing the Root Hub Cap on the Link Connector. 

CAMERA 1, 2, 3, 4, 5 connectors – STP (Sync/Trigger-Return/Power) connectors for  
HG-100K/LE/XR/XL cameras or HG-TH Camera Controllers to the camera LAN  
(Local Area Network). For more information, see “STP Cable Lengths and Timing” on 
page 138.

POWER indicator – a green light indicates that the power is on.

TRIGGER IN connector – an external switch closure device for triggering the camera.

SYNC indicator – a green LED indicates a Sync signal present or that the Root Hub Cap 
is installed. A blinking light indicates the HSU is locked onto an incoming signal but the 
"root bit" is absent from the signal. If the green LED is off, there is no Sync signal present.

IRIG CLK connector – not implemented.

IRIG TRIG connector – not implemented.

HD J/D Box – connects a J or D Box for connecting legacy cameras such as the HG-TX.

LINK indicator and 1000Base-T connector – LED indicates connection status. 
Ruggedized RJ- 45 connector for 100/1000Base-T communications with a daisy-chained 
HSU.

CAMERA 1, 2, 3, 4, 5 indicators and 1000Base-T connectors – LED indicates 
connection status. Ruggedized RJ- 45 connector for 100/1000Base-T communications 
with other devices.

DCU indicator and 1000Base-T connector – LED indicates connection status. 
Ruggedized RJ- 45 connector for 100/1000Base-T communications with a DCU or CCU 
computer.   
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 Figure 5.7: HSU front panel 
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6. Before You Begin
 6.1. Minimum Package Contents

The total package you receive will depend on the specific cameras, and components 
ordered. Please check to make sure that at a minimum, all of the items listed are included 
in the package.    

 6.2. CCU System Requirements
The HG-100K/LE/XR/XL/TH/CH system is capable of displaying, processing, and 
downloading vast amounts of video data. The following are recommendations for running 
the MotionCentral control software on a CCU controlling a multi-camera imaging network.     

*An SVGA monitor capable of 1600 x1200 resolution is recommended to take advantage of the 
camera's full resolution, but resolutions of 1280 x 1024, 1024 x 768, will also be supported to 
accommodate a wider range of monitors and video cards.)

** The ability to reset the receive buffer may not be available on some computers . Check with the 
manufacturer for more information on resetting the receive buffer. 

HG-100K/LE HG-XR/XL HG-TH/CH

HG-100K/LE camera(s) HG-XR/XL camera(s) HG-TH/CH camera head(s) 
and cables

MotionCentral software CD 
with user's manual and quick 
start guide

MotionCentral software CD 
with user's manual and quick 
start guide

MotionCentral software CD 
with user's manual and quick 
start guide

Power pigtail Power pigtail Power pigtail

10m rugged Ethernet cable 10m rugged Ethernet cable 10m rugged Ethernet cable

C-mount and F-mount lens 
adapters 

C-mount and F-mount lens 
adapters 

Camera Controller 

Mounting Plate Mounting Plate Interface unit(s) (HG-CH only)

GPS antenna

Carrying case

Power supply

CCU's Controlling Networks of up to 3 
Cameras

CCU's Controlling Networks of More than 3 
Cameras

2.4 GHz Intel® Pentium 4 Processor Dual 2.4 GHz Intel® Xeon Processors

512 MB of RAM 2 GB of RAM

Gforce4 128 MB AGP Graphics Controller 
(or equivalent)

Gforce4 128 MB AGP Graphics Controller 
(or equivalent)

(1) 3COM 3C996B-T 1000Base-T Ethernet 
Card (or equivalent). Minimum receive buffer 
256 K, recommended 1 M.

(2) 3COM 3C996B-T Gigabit Ethernet Card 
(or equivalent). Minimum receive buffer 256 K, 
recommended 1 M**.

Keyboard and Mouse Keyboard and Mouse

21" Color Monitor, with 1600 x1200 resolution* 21" Color Monitor, with 1600 x1200 resolution*

40 GB Hard Disk Drive 80 GB Hard Disk Drive

Windows® XP or 2000 Pro (with the latest 
service patch) or higher, Microsoft.NET™ 
runtime support.

Windows® XP or 2000 Pro (with the latest 
service patch) or higher, Microsoft.NET™ 
runtime support.
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 6.3. DCU System Requirements
The DCU runs the same MotionCentral software as the CCU, and is capable of displaying, 
processing and downloading video data. The DCU is for set up of individual cameras only 
and not for downloading vast amounts of image data, therefore, the following 
recommendation is for running the MotionCentral control software on a DCU.     

 6.4. Camera Network Requirements for Multi-Camera 
Configurations
Multi-camera configurations require either a Redlake HSU or a commercial networking 
switch to create a camera LAN. If you are using a commercial networking switch use a 
Gigabit Ethernet switch for the best download performance. 

For more information see “Set up the Camera Network” on page 35.

6.4.1.  NIC (Network Interface Controller)
Connect the CCU to the Camera LAN using a 1000Base-T Ethernet NIC in a fan-out tree 
configuration. The system supports 100Base-TX, but offers less performance for 
downloading a large numbers of TIFF and Type-2 images. If the PC does not already have 
one installed, begin by installing a 1000Base-T network interface controller (NIC) in the 
CCU. Follow the NIC manufacturer's instructions for installation.

A DCU requires either a 100Base-TX or 1000Base-T Ethernet NIC. Follow the NIC 
manufacturer's instructions for installation.

For more information see “Set up the Camera Network” on page 35.

 6.5. Lenses
The HG-100K, HG-XR, and HG-XL ship with Nikon F-mount and C-mount lens adapters. 
The HG-LE, HG-TH, and HG-CH ship with C-mount lens adapters. 

HG-100K/LE/XR/XL high-G applications, two Box-Mount lens adapters are available: 

• 20007036-001 Flange Focal Distance = 45.6 mm

• 20007036-002 Flange Focal Distance = 50.4 mm

HG-TH high-G applications, Box-Mount lens adapters are available: 

• 10000667-002 Flange Focal Distances = 45.6 mm and 50.4 mm

Box-Mount adapters ship with a set of shims of varying thickness to accommodate various  
high-G lenses. In addition, the camera front has a machined surface to mount high-G 
lenses directly.

Recommended Minimum System Requirements for the DCU

Intel III processor 800 MHz

256 MB of RAM

Integrated Intel® Direct AGP graphics with 8 MB Dynamic Video Memory Technology

10/100 Base-TX Ethernet port. Minimum receive buffer 256 K, recommended 1 M.

20 GB Hard Disk Drive

Recommended Resolution on the DCU 1024 x 768

Windows® XP or 2000 Pro (with the latest service patch) or higher, Microsoft.NET™ runtime support.
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 6.6. HG-100K/LE/XR/XL/TH/CH STP Cables
STP stands for Sync/Trigger-Return/Power.

• 30007000-001, 5m STP Cable 

• 30007000-002, 10m STP Cable

• 30007000-003, 25m STP Cable

• 30007000-005, 50m STP Cable

• 30007000-006, 75m STP Cable

• 30007000-004, 100m STP Cable 

• 30007001-001, Power Pigtail cable, 2 m

• 10007029-001, STP Connector for Customer-built cables

 6.7. HG-100K/LE/XR/XL/TH/CH Ethernet Cables
• 30007002-002, 10 m Rugged Ethernet Communication Cable 

• 30007002-003, 25m Rugged Ethernet Communication Cable

• 30007002-005, 50m Rugged Ethernet Communication Cable

• 30007002-006, 75m Rugged Ethernet Communication Cable

• 30007002-004, 100m Rugged Ethernet Communication Cable

For cable lengths longer than 100 m, contact http://www.omnitron-systems.com for  
copper to fiber converters. 

 6.8. HG-TH/CH Cable Options
• 30007084-001, Trigger/Sync In Cable, OB Series, LEMO, 3 m, FGG-08-302-CLCD31

• 30007083-001, Sync/Strobe Out Cable, 00 Series, LEMO, 3 m, FGG-00-302-CLAD30

• 03100324-004, 3 m Camera Head cable for clamp style Camera Controller

• 03100324-005, 6 m Camera Head cable for clamp style Camera Controller

• 03100324-006, 10 m Camera Head cable for clamp style Camera Controller

• 30007082-004, 3 m, Cable assy, straight ends

• 30007082-005, 6 m, Cable assy, straight ends

• 30007082-006, 10 m, Cable assy, straight ends

• 03100325-001, Connector; cbl, 2-pin male, solder, lemo plug

• 03100326-001, Connector; cbl, 2-pin male, crimp, lemo plug

• 30003401-001, SDR cable, left

• 30003402-001, SDR cable, right
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7. Hardware

 7.1. Providing Power to the Cameras
The STP (Sync/Trigger-Return/Power) connector provides power to the cameras and 
Camera Controllers. Use either a pre-wired power supply (contact your Redlake dealer for 
options), a power supply or battery wired to a camera Power Pigtail cable, or an STP 
cable connected to an HSU to supply power to the camera or Camera Controller. The 
cameras and Camera Controllers require a minimum of 24 VDC.

Always use a UL Listed power supply whenever possible. See “Appendix A Camera 
Specifications” on page 98 for more information.

 7.1.1.  Using the Camera Power Pigtail cable
A Camera Power Pigtail cable is provided with every camera and Camera Controller. It 
consists of an STP connector wired to a 2 m cable with bare wires at the opposite ends. 
This cable can be used to provide power to any HG-100K/LE/XR/XL camera or HG-TH 
Camera Controller.

• Apply 24 to 50 volts DC to the Power Pigtail connections

• Confirm correct wiring.
       

 7.1.2.  Power Management
The HG-100K/LE/XR/XL/TH system has four power management modes:

• Normal – the sensor is active 

• Standby – the sensor is inactive 

• Battery Backup – initiated at loss of DC power. Battery backup retains captured 
images stored in memory.

• Off – everything is off, including the image SDRAM.

Pin Signal Name Color 

B CAM_PWR_RET GREEN 

C CAM_PWR ORANGE 

D CAM_PWR RED 

E CAM_PWR WHITE 

F CAM_PWR_RET BLACK 

N CAM_PWR_RET BLUE 

P CAM_PWR YELLOW 

S CAM_PWR_RET BROWN 
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 7.1.3.  Camera Power Requirements Table

 7.1.4.  Using an HSU to Supply Power to Cameras
The optional Hub Sync Unit, or HSU consists of a Gb Ethernet switch, and a distribution 
source for power, synchronization signals and trigger signals. This section covers only the 
power distribution portion of the HSU functionality.

Total wattage for the camera configuration to be attached to the HSU must not exceed the 
power limit of the HSU. When calculating the power input to the HSU, it is wise to measure 
the voltage input from the user-supplied power supply under load and at the maximum 
temperature that the supply will see as it may vary. It is also wise to select power supplies 
with approximately 2x the nominal wattage rating required for the system, especially if the 
power supply is to be mounted such that it will become hot with use. 

While HSUs may be daisy-chained together to support large camera LANs of up to 250 
cameras, each HSU is powered separately through its Power Input connector. Power may 
be applied to this connector via the HSU power pigtail supplied with each HSU. The HSU 
requires 20 to 50 VDC.

Camera Normal Standby

HG-100K/LE camera 42 W 14 W

HG-XR/XL camera 65 W 37 W

Two port HG-TH Camera Controller with 1 HG-TH/CH Camera Head attached 35 W 22 W

Two port HG-TH Camera Controller with 2 HG-TH/CH Camera Heads attached 45 W 25 W 

Four port HG-TH Camera Controller with 1 HG-TH/CH Camera Head attached 45 W 25 W 

Four port HG-TH Camera Controller with 2 HG-TH/CH Camera Heads attached 60 W 30 W 

Four port HG-TH Camera Controller with 3 HG-TH/CH Camera Heads attached 75 W 35 W 

Four port HG-TH Camera Controller with 4 HG-TH/CH Camera Heads attached * 90 W * 38 W

* NOTE:  Unless otherwise specified by a label on the front panel of the HSU, 
assume that the Maximum Wattage per Camera connection is 80 W. 
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 7.1.5.  Using the HSU Power Pigtail
A Camera Power Pigtail cable is provided with every camera and Camera Controller. 
It consists of an HSU power connector wired to a 2m cable with bare wires at the opposite 
ends.

• Apply 20 to 50 volts DC to the Power Pigtail connections

• Confirm correct wiring.         

 7.1.6.  HSU Power Requirements Table
Calculate the total power required by all cameras and the HSU to select a power source 
with sufficient capacity. The voltage input to the HSU determines the total power available 
to distribute to the cameras and Camera Controllers.         

    

 7.1.7.  Battery/Backup
The HG-100K/LE/XR/XL/TH has a 3.6 V Lithium Ion battery backup that provides power 
for retaining and recovering images should a power fault occur. The battery will maintain 
the images in memory for some length of time, depending on model.

 7.1.8.  Before Initial Use of the Backup Battery
To ensure the best performance of the backup Lithium Ion battery, follow these directions 
before initial use and after long periods of inactivity.

1. Charge the battery fully. (POWER LED will be solid green.)

2. Allow the battery to fully discharge by unplugging the camera from its power 
source and leaving the camera ON with only battery backup power. (POWER LED 
will be solid red.)

3. Charge the battery. (POWER LED will alternate from green to amber until fully 
charged.)

Pin Signal Name Color 

A CAM_PWR ORANGE 

B CAM_PWR RED 

G CAM_PWR WHITE 

F CAM_PWR YELLOW 

C CAM_PWR_RET GREEN 

D CAM_PWR_RET BLUE 

E CAM_PWR_RET BROWN 

H CAM_PWR_RET BLACK 

HSU Voltage Input 20 to 24 
VDC

25 to 32 
VDC

33 to 50 
VDC

Total Watts Available 200 W 225 W 300 W

Maximum Watts per Camera connection * 80 or 90 W * 80 or 90 W * 80 or 90 W *

* NOTE:  Unless otherwise specified by a label on the front panel of the HSU, 
assume that the Maximum Wattage per Camera connection is 80 W. 
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 7.2. Record Modes and Triggering
Definition of Terms:

• Session Length – Number of frames to be recorded. This is selectable by the user 
and can be any number from 1 to the maximum number of frames that can be 
recorded into memory at the specified resolution.

• Trigger (Event Trigger) – delivered either through dedicated hardware or via 
Ethernet command, the Trigger is used to set Frame 0 for a camera recording in 
Normal Mode

• Trigger Frame – Frame during which the Trigger is received or validated

• Trigger de-bounce – User-selectable delay that specifies the length of time a 
hardware trigger must be "true" before the trigger is validated. This is used to filter out 
spurious signals caused by mechanical switches or transient spikes. This is typically 
set from 0 to 120 µsec.

• Trigger Delay – User selectable delay in milliseconds used to delay the time the 
trigger is validated from the time it is received

• Time 0 – The time the trigger is validated

• Trigger Frame – The frame during which a trigger is validated

• Pre-Trigger Frames – Frames recorded into memory prior to the Trigger Frame

• Post-Trigger Frames – Frames recorded into memory after the Trigger frame.

 7.2.1.  Record Modes 
HG-100K/LE/XR/XL/TH/CH cameras employ several recording modes to capture high-
speed digital imagery most effectively. 

 7.2.1.1.    Normal Mode
One of the challenges of capturing digital images of a high-speed event is triggering the 
camera at precisely the correct time. Depending on the event, it may be possible to 
construct a trigger pulse (or switch closure) that can be sent to the camera just as the 
event is to occur. With some applications, however, it may not be possible to generate 
such a signal until the event is already in progress, or even until the event is over.

The HG-100K/LE/XR/XL/TH/CH cameras accommodate these application challenges by 
having the ability to furnish both pre-trigger and post-trigger frames.

In order to furnish pre-trigger frames, all MotionXtra cameras have memory that can be 
configured by the user to record a selectable number of pre-trigger frames, n, into a 
circular buffer. When the camera goes into record mode, it will fill this buffer, and then 
overwrite it continually until an event trigger is received. When the trigger is received the 
camera will retain the last n images written into the circular buffer, and then continue to 
record frames until the total number of frames programmed for the session is exhausted.

 7.2.1.2.    Ready
Ready is used for "Normal mode" only. It sets the camera into record mode when the 
configurable (Sync-In) input goes "true." When the camera is in Ready mode, the camera 
records pre-trigger frames into the buffer and waits for a trigger signal (see Normal Mode, 
above).
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 7.2.1.3.    External Sync
Some applications require that the camera's exposure for each frame be synchronized to 
some external device. This device could be another camera, to which it must be closely 
synchronized, or some other clock source driving cameras and other instrumentation used 
on the same test.

External Sync takes one frame per pulse that the camera receives at the Configurable 
Input (Sync-In). The minimum allowable interval between pulses is determined by the 
exposure setting. (See Appendix G for details.)

When cameras operate in External Sync mode, the event trigger is configured for pre- and 
post-trigger frames just as it is with Normal mode. External Sync may not be used for 
ROC or BROC modes (see below).

 7.2.1.4.    ROC Mode (Record on Command)
For some applications, several bursts of high-speed image capture of unspecified lengths 
may be required.

ROC records continuously at a selectable frame rate whenever the signal level at the 
Configurable Input (Sync-In) is "true." In this way any number of bursts of any number of 
frames may be taken until the available image memory is exhausted.

 7.2.1.5.    BROC Mode (Burst Record on Command)
BROC is very much like ROC except that the number of frames to be captured in each 
burst is selected by the operator. Each time the Configurable Input (Sync-In) goes "true," 
the selected number of frames is recorded. This may be repeated until memory is 
exhausted. Any signals received at Sync-In while the camera is already recording a burst, 
will be ignored. 

 7.2.2.  Triggering
There are three ways that a camera can receive an event trigger:

1. Command sent via application software

2. TTL pulse (programmable polarity) or switch closure at the camera's Trigger In 
connector

3. Switch closure or negative-going pulse at any HSU, or TTL pulse (programmable 
polarity) on any camera connected to a valid HSU network

 7.2.2.1.    Triggering Cameras via Software
One or more cameras may be triggered (Normal Mode) via application software. 
For details on how this is done in MotionCentral, please refer to “Record an Event Using 
MotionCentral” on page 82.  For details on how this is done using other camera control 
software, please refer to the appropriate documentation.

When selected cameras receive a broadcast command via the Ethernet network from a 
software trigger, from MotionCentral or software based on the MotionCentral SDK or the 
MotionXtra Command Protocol, cameras will interpret the trigger as they receive it from 
the network. Delay times will be dependant on the host PC (CCU) and the network 
infrastructure. Typical delay times and possible skews between cameras are likely to be in 
the neighborhood of a few milliseconds.

If networked cameras are recording at frame rates where the frame period is shorter than 
the skews between cameras' receipt of a trigger, frame numbering and trigger offset 
timestamps may be off by one or more frame times. Because of this, the software trigger 
should be used only for tests where frame sync and trigger offset timestamp is not 
important, or for an emergency backup in case a hardware trigger fails.
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 7.2.2.2.    Triggering Cameras using Trigger-In (Valid HSU 
not present)
When cameras operate with the hardware trigger, distributed among all cameras, the 
cameras will all interpret the trigger in unison plus/minus any propagation delays inherent 
in the hardware distribution of the trigger signal, which in most cases should be less than 
one microsecond. 

Given this scenario, the frame timing among cameras will be within one frame. The 
accuracy of the time-0 (trigger) offset for frame 0 (trigger frame) among all cameras will be 
within a microsecond (depending on propagation delays). The accuracy of the offset for all 
pre-trigger and post-trigger frames will depend on the clock skews of the individual 
cameras, with a maximum of .01 percent at 1000 fps, or approximately 100 µsec.

 7.2.2.3.    Triggering Cameras using Hardware Trigger-In at 
the Camera or HSU with a valid "Root HSU" present
When cameras are connected via an HSU network, the entire camera network will trigger 
when a trigger is received at any camera (configurable polarity) or at any HSU (switch 
closure or negative-going pulse).  Cameras will all validate the trigger within 1 µsec of 
each other, but validation will happen at sometime between 500 µsec and 600 µsec after 
receipt of the trigger.

The "IRIG Trigger" output on the HSU will toggle at within 1 µsec of trigger validation by 
the cameras. This signal can be used to trigger ancillary instruments or it may be 
monitored by the user if the trigger validation time needs to be recorded.

Frame 0 Frame 1

Exposure

Trigger

Trigger Validation

500 to 600 µsec
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 7.2.2.4.    How to Connect a Hardware Trigger to Multiple 
HG-100K/LE/XR/XL Cameras
Connect trigger device to one camera’s Trigger In. Connect the remainder of the cameras 
to the first camera using T connections to the Trigger In port. Use a 50  terminator at the 
end of the chain.  For more information on trigger timing, see “Offset and Trigger Timing” 
on page 70.  

 7.2.2.5.    How to Connect a Hardware Trigger to an HSU 
A hardware trigger can be applied to any camera or HSU with cameras attached to an 
HSU network with a valid root hub.

Connect an external trigger device to the Trigger In BNC port on the HSU.

For more information on trigger timing, see “Offset and Trigger Timing” on page 70. 

 

 Figure 7.1: Trigger device connected directly to an HG-100K/LE/XR/XL

 Figure 7.2: Trigger device connected to an HSU
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 7.3. Frame Synchronization
The following section explores possible synchronization strategies in implementing 
networks of MotionXtra cameras and the implied accuracies of each. As this is a very 
flexible architecture with many possible permutations in setup, it is impossible to represent 
all of the possibilities, but it should be possible to gain a good enough understanding of 
the principles involved to use this as a guide to understand and predict the outcomes of 
whatever system design you may choose to implement.

 7.3.1.  Cameras Networked Using a Commercial Ethernet 
Switch-No External Synchronization

 7.3.1.1.    HG-100K/LE/XR/XL 
In this implementation, the cameras get their internal time of day from the host computer. 
Frame clocks, however are internal to each camera, so frame timing and frame rate 
accuracy depend on the accuracy of the onboard clock of each camera. Frame timing 
accuracy for all of these cameras is .01% @ 1000 fps. 

When cameras in this configuration operate with the "software" trigger, either through 
MotionCentral or some other software based on the MotionCentral SDK or the MotionXtra 
Command Protocol, where the trigger is a broadcast command to all selected cameras via 
the Ethernet network, cameras will interpret the trigger as they receive it from the network. 
Delay times will be dependant on the host PC (CCU) and the network infrastructure. 
Typical delay times and possible skews between cameras are likely to be in the 
neighborhood of a few milliseconds.

When cameras in this configuration operate with the "hardware" trigger, distributed among 
all cameras, the cameras will all interpret the trigger in unison plus/minus any propagation 
delays inherent in the hardware distribution of the trigger signal, which in most cases 
should be less than a microsecond. Given this scenario, the frame timing among cameras 
will be within one frame. The accuracy of the time-0 (trigger) offset for frame 0 (trigger 
frame) among all cameras will be within a microsecond (depending on propagation 
delays). The accuracy of the offset for all pre-trigger and post-trigger frames will depend 
on the clock skews of the individual cameras, with a maximum of .01% @ 1000 fps, or 
approximately 100 µsec/sec.

 7.3.1.2.    HG-TH/CH
HG-TH/CH camera heads connected to a single controller share a common clock. When 
all heads are operating at the same frame rate, synchronization between heads will be to 
within 1.25 µ seconds, meaning that for each frame, each head will commence an 
exposure within 1.25 µ seconds of the others.
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 7.3.2.  Frame Synchronization Methods

 7.3.2.1.    Cameras Synchronized via Signal From External 
Sync Source
In this scenario, cameras operate in external sync mode. An external sync source is 
connected to the cameras using 50 Ohm coax cabling. There are a variety of possible 
configurations to fan the signal out to the cameras. The simplest, shown here, is to 
connect one camera directly to the sync source, then connect the remainder of the 
cameras to the first cameras Strobe Out connector using "T" connections. A 50 Ohm 
terminator is used at the end of the chain. (see diagram)

Results:

Cameras will all lag the sync source by 4 µsec +/- .5 µsec. Synchronization between 
cameras will be approximately +.5 µsec. All cameras will capture frames at the same 
frame rate.

If a common event trigger is applied to all cameras (50 Ohm cabling is recommended with 
a 50 Ohm terminator) the trigger offset data will be within 1 µsec for the trigger frame, but 
may drift over time from camera to camera, limited by the frame rate accuracy 
(.01% @ 1000 fps). This is due to differences in the cameras' internal clocks. Time stamps 
will also vary from camera to camera for the same reason.

If the cameras are triggered via Software Trigger, they will mark time 0 differently, 
depending on propagation of the trigger command over the network.

Scenario 1:  Cameras synchronized via Sync In using External Sync
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 7.3.2.2.    Cameras Synchronized via Master / Slave Method
The Master camera runs in Normal, BROC, or ROC mode (not External). The Strobe-Out 
delay for the Master is set at -4 µsec (Negative delay). This will force the Strobe-Out signal 
to precede the actual exposure and will null-out the normal 4 µsec lag between Sync In 
and the beginning of exposure. 

Slave cameras are set to External mode. 50 Ohm cabling is run from the Strobe Out of the 
Master to the Sync In of the first Slave camera. Additional cameras are connected via "T" 
connectors and 50 Ohm coax cables with a 50 Ohm terminator at the end of the chain.  
(See drawing.)

Results:

All cameras are frame synchronized to within +/- .5 µsec. All cameras will capture frames 
at the same frame rate.

If a common hardware event trigger is applied to all cameras (50 Ohm coax cabling is 
recommended with a 50 Ohm terminator) the trigger offset data (offset time stamp in 
border data) will be within 1 µsec for the trigger frame, but may drift over time from camera 
to camera, limited by the frame rate accuracy (.01% @ 1000 fps, or 1ms per 10 seconds). 
This is due to differences in the cameras' internal clocks. Time stamps will also vary from 
camera to camera for the same reason.

If the cameras are triggered via Software Trigger, they will mark time 0 differently, 
depending on propagation of the trigger command over the network.       
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 7.3.2.3.    Cameras in a network connected via HSU(s)
When cameras are connected via an HSU network of up to 250 cameras (see section on 
HSU implementation), all cameras operating in Normal mode will receive frame 
synchronization and trigger timing through the STP cable. All camera time stamps will be 
based on the same clock within the Root HSU.

Results:

All cameras will be frame synchronized to within +/- 1.25 µsec of each other. Cameras 
may be configured to capture frames at different frame rates, but the frame to frame 
accuracy is maintained.

If the cameras are triggered through software, they will each receive their triggers 
independently and their accuracy will vary depending on the camera LAN. If cameras are 
triggered via hardware trigger (received on any camera or HSU on the network), all 
cameras will see a trigger delay of .6 ms and all will mark time 0 and all subsequent trigger 
offsets (every frame) with an precision of +/- 1.25 µsec.             

Scenario 3:  Cameras are connected via a network of HSUs. HSUs
may fan out five deep from root HSU with up to 250 cameras.

HG-x 1

HG-x 2

HG-x n

Root HSU

HSU

STP Cables
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 7.3.2.4.    HG-XR/XL cameras with locked IRIG or GPS signal
When an IRIG signal is distributed among HG-XR cameras, all cameras will receive IRIG 
time data and all will lock their frame clocks to the 1 Hz IRIG clock. Each camera, 
regardless of frame rate, will be framed synchronized at each 01.000000 s IRIG time 
unless it is configured with a phase offset. (Phase offsets may be positive or negative in 
1 µsec increments up to one frame time.)

Results:

HG-XR cameras have modulated and un-modulated IRIG inputs. For modulated (analog) 
IRIG, all cameras will be synchronized to within +10 µsec of each other. For un-modulated 
(TTL) IRIG, all cameras will be synchronized to within +1 µsec of each other.

The HG-XR/XL also has a GPS decoder. When GPS is selected as the time base and the 
cameras are able to maintain a GPS lock, all cameras will be synchronized to within 
+10 µsec of each other. In all of these cases IRIG/GPS timestamps will be written to each 
frame.

If a common hardware event trigger is applied to all cameras the trigger offset data (offset 
time stamp in border data) will be within the specifications listed above for each frame as 
long as the camera maintains its lock to the IRIG/GPS signal. If at any time the camera 
looses IRIG/GPS lock, it will revert to its internal clock until IRIG/GPS lock is resumed. 

If the cameras are triggered via Software Trigger, they will mark time 0 according to the 
time each camera validates the trigger (“Triggering Cameras via Software” on page 24), 
which could differ by a few milliseconds among the distributed cameras. All trigger offset 
timestamps will have the same inaccuracies. But the actual IRIG timestamp and relative 
frame synchronization will remain accurate as specified.
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8. Install and Configure the Software

The PC or tablet computer must be running a Windows® operating system. MotionCentral 
is compatible with the Windows® 2000 Pro and Windows® XP with the latest Microsoft® 
updates and service packs.

Compatibility tests of MotionCentral with Windows® XP reveal that MotionCentral is fully 
compatible with Windows® XP Service Pack 2 when the Firewall component is disabled. 
Disable the Service Pack 2 Firewall by selecting the Windows® Control Panel > Network 
Connections > Properties tab for the camera network connection. Consult your system 
administrator for further assistance and information regarding Windows® XP Service 
Pack 2. 

Required: Install the latest version of Microsoft.NET™ runtime support before installing 
MotionCentral. 

 8.1. Install MotionCentral Software
1. Insert the distribution CD into the computer's CD-ROM drive. If the computer is set 

up for autorun the installer will run automatically. If not, select the MotionCentral 
directory and then double-click SETUP.EXE from the directory file list.

2. Select a path and the installer will place MotionCentral's files in the appropriate 
locations.

3. Exit when installation is complete.

4. The setup program will solicit a pathname for the location of its files. The 
recommended default path is C:\Program Files\Redlake. Select another path if 
desired. 

 8.1.1.  Install .NET Runtime 
Install ONLY if prompted by MotionCentral.

1. Insert the CD into the CD-ROM and open the Required Software folder. Double-
click the file named DOTNETFX.EXE. This will launch the .NET installer. 

2. Once the installation is complete, reboot the system.

 8.1.2.  Install MotionCentral on the DCU 
MotionCentral software comes pre-installed on DCUs purchased from Redlake. If 
purchased separately, you will need to install MotionCentral. If the tablet computer you 
have selected to be your DCU has a CD-ROM drive, follow the Install MotionCentral 
Software Instructions above. 

If the DCU does not have a CD-ROM drive, the files can be loaded and the software 
installed by connecting the DCU to a network and copying the files directly to the DCU. 

NOTE:  If .NET runtime is not installed on the computer a prompt will 
display stating that .NET must be installed before MotionCentral can be 
installed.
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 8.2. Application Startup and Software Configuration
1. Double-click the MotionCentral icon from the Windows® desktop. Alternatively, 

from the Windows® Taskbar, select Start > All Programs > MotionCentral.

2. From the Main Menu, select File > Setup to bring up the Configuration dialog box.

3. From the Network Adapter drop-down list, select the adapter for the camera LAN. 
Make certain that the adapter matches the NIC card connected to the camera 
LAN.

 8.3. Set up Network Communications 

 8.3.1.  Select the Network Communications Performance 
The Network Performance box contains a slider to change the performance settings for 
network communications. When MotionCentral starts up it sends a GAP value to the 
camera. This GAP value is the number of camera clock cycles between packets of data 
sent from the camera to MotionCentral. The default GAP value of 2500 will be sufficient on 
most PCs that are 1 GHz and above in processor speed. Faster performance settings can 
be achieved when larger receive buffers on the network card are utilized. For more 
information on minimum and recommended network receive buffers see “CCU System 
Requirements” on page 17.

Slower PCs may require a longer GAP value to download a Type-2 or TIFF file. If the error 
message "SegmentsOutOfOrder" displays when downloading a TIFF or Type-2, use the 
Network Performance slider to increase the GAP time.

1. From the Main Menu, select File > Setup.

2. From the configuration dialog box move the Network Performance slider to the left 
to increase the download speed and to the right to slow the download speed and 
increase reliability.

 8.3.2.  Select the Ethernet Speed for the PC
1. From the Main Menu, select File > Setup.

2. From the Configuration dialog box use the radio buttons to select one of the 
following Ethernet Speed options:

• Automatic is the default setting that will run at 100 Mbps and switch to 1000 
Mbps speed when downloading TYPE 2 and TIFF files. The NIC in the CCU, as 
well as any attached Ethernet switches, must be capable of auto-negotiation 
between these two speeds.

• The 100 Megabit setting will send images to the PC at 100 Mbps only.
• The Gigabit setting will send all images to the PC at 1000 Mbps speed.

NOTE:  Only one copy of the application program can be active at a time on 
a single machine, but multiple CCU and DCU computers can be 
simultaneously active.

NOTE:  Increasing the GAP value increases the time between packets of 
data sent from the camera to the PC, which in turn increases the overall 
download time. Therefore, increase the GAP value using small increments 
only. 
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 8.3.3.  Set up Communications with Legacy Cameras
The Support HG/CR/TX check box enables MotionCentral to operate with older cameras; 

1. From the Main Menu, select File > Setup.

2. From the Configuration dialog box click on the box Support for HG/CR/TX

 8.3.4.  Set up the Message Level for the System Status 
Window
Used primarily for diagnostics, the Message Level drop-down lists five severity levels for 
logging messages in the system status log window.       

 8.4. Add MotionCentral to the Windows Startup (Optimal)
Add the MotionCentral program application executable (.exe) file to the Windows® Startup 
menu so that whenever the CCU boots, MotionCentral will automatically launch without 
locating and double-clicking the icon. This is particularly useful on a DCU.

1. Locate the MotionCentral folder and right-click on the MotionCentral.exe icon and 
select Create Shortcut.

2. Right-click on the MotionCentral shortcut and select Copy. 

3. Navigate to the startup folder on the C drive, and paste the shortcut in the 
Programs folder within the correct user’s directory as shown in the example.

Directory Path: 
C:\Documents and Settings\Correct User\Start Menu\Programs\Startup

 Figure 8.1: Configuration dialog box

NOTE:  There may be more than one user profile on the system. Make sure 
the shortcut is pasted into the correct user’s startup folder.
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9. Set up the Camera Network

 9.1. One Camera Static IP System with a CCU
The HG-100K/LE/XR/XL/TH/CH uses Ethernet and IP networking for communications 
between the different devices in the system. Networking with the camera takes place 
either through the 1000Base-T Camera LAN CCU connector, or the 100Base-TX DCU 
connector. The 1000Base-T operates at either 100 Mbits or 1000 Mbits, whereas the DCU 
Port operates at a fixed rate of 100 Mbits. 

For proper operation of an IP network, the devices on the network must have unique IP 
addresses within the same subnet. These address assignments can be set statically by 
the system administrator or dynamically using a DHCP protocol. 

In a one-camera Static IP system, the devices on the network are:

• HG-100K/LE/XR/XL camera or HG-TH Camera Controller with camera head attached

• CCU (PC with Gigabit NIC card)

Attach these devices with a single Ethernet cable using the camera's or camera 
controller's 1000Base-T Camera LAN connector and the Ethernet port of the CCU. In its 
default configuration, the 1000Base-T connector on the camera and Camera Controller 
comes up at 100 Mbits and switches to 1000 Mbits when moving TIFF or Type-2 data. The 
NIC in the CCU must be capable of auto-negotiation between these two speeds. 

For more information on setting the Ethernet Speed, see “Select the Ethernet Speed for 
the PC” on page 33.

The HG-100K/LE/XR/XL 1000Base-T port comes with a factory default IP address of 
192.168.0.2 with its DHCP client turned OFF (set for static addressing). The HG-TH 
Camera Controller's Camera Head ports come with a factory default IP address of 
192.168.0.2, 192.168.0.3, 192.168.0.4, 192.168.0.5, with the DHCP clients turned OFF 
(set for static addressing). The CCU terminal should be set to a static address of 
192.168.0.1. For information on setting the IP address, see “Setting IP Address 
Parameters” on page 42.

 Figure 9.1: Single camera system using static IP addressing
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 9.2. Multi-Camera Static IP System
In a Static IP system with more than one camera, the following devices are on the 
network:

• HG-100K/LE/XR/XL cameras or HG-TH Camera Controllers with Camera Heads

• HSU/switch

• CCU

Attach these devices with Ethernet cables using the HSU or commercial switch. The HSU 
is an unmanaged layer 2 only Ethernet switch so it does not have an IP address. Each 
HG-100K/LE/XR/XL/TH/CH camera, Camera Head HD port on the Camera Controller and 
the CCU must have a unique IP address. Set the CCU to 192.168.0.1 and set each 
camera or Camera Head (HD) port on the Camera Controller one increment above that. 
For example, the attached cameras could have the following IP addresses, 192.168.0.2, 
192.168.0.3, 192.168.0.4, 192.168.0.5. For information on setting the IP address, see 
“Setting IP Address Parameters” on page 42.     

 Figure 9.2: Multi-camera system using static IP addressing



MotionXtra User’s Manual

Redlake 7/26/07 37

 9.3. One Camera DHCP System
Automatically assign IP parameters using the DHCP protocol. In a one-camera system, 
the devices on the network are:

• HG-100K/LE/XR/XL Camera or HG-TH Camera Controller and Camera Heads

• CCU (running DHCP server and client)

Connect these two devices with a single Ethernet cable using the 1000Base-T connector 
on the camera or Camera Controller and the Ethernet port of the CCU. In its default 
configuration the camera's or Camera Controller's 1000Base-T connector comes up at 
100 Mbits and switches to 1000 Mbits when moving TIFF or Type-2 data. The NIC in the 
CCU must be capable of auto-negotiation between these two speeds. 

For more information on selecting the Ethernet speed, see “Select the Ethernet Speed for 
the PC” on page 33

All HG-100K/LE/XR/XL cameras and Camera Head (HD) ports on the HG-TH Camera 
Controllers ship with the 1000Base-T port set with a factory-set default IP address and its 
DHCP client turned OFF (set for static addressing). To run with DHCP the camera must 
have its DHCP client turned ON. For information on setting the IP address, see “Setting IP 
Address Parameters” on page 42.

In the DHCP configuration above, there is DHCP a client running in the camera or Camera 
Controller and the CCU. There must be a DHCP server running on the network, typically 
this is the CCU. A DHCP server does not come standard with the Windows® operating 
systems. Redlake has tested a DHCP server called vDHCP Server for Windows®, a 
product from Paul Smith Computer Services. Contact them on the Web at http://
www.pscs.co.uk.

 Figure 9.3: Single camera using DHCP
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 9.4. Multi-Camera DHCP System
In a DHCP system with more than one camera, the following devices are on the network:

• HG-100K/LE/XR/XL cameras or HG-TH Camera Controller with Camera Heads 

• 1 HSU or Commercial Switch

• CCU

Connect these devices with Ethernet cables using the HSU or commercial switch as a 
central connection point. The HSU is an unmanaged layer 2 only Ethernet switch so it 
does not have an IP address. Each camera or Camera Controller and the CCU must have 
their DHCP clients turned on (static addressing turned off). For information on setting the 
IP address, see “Setting IP Address Parameters” on page 42.

In the DHCP configuration above, there are DHCP clients running in the camera, Camera 
Controller and CCU. There must also be a DHCP server somewhere on the network; 
typically, this is on the CCU. A DHCP server does not come standard with the Windows® 
operating systems. Redlake has tested a DHCP server called vDHCP Server for 
Windows®, a product from Paul Smith Computer Services. Reach them on the Web at 
http://www.pscs.co.uk.

 Figure 9.4: Multi-camera system using DHCP

NOTE:  Install a vDHCP Server software or equivalent on the CCU.
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 9.5. DCU Configuration
Use the DCU for configuration and local camera setup. A DCU attaches directly to the 
DCU port on the camera or Camera Controller. Although complete camera system 
functionality is available, the DCU Port on the camera always runs at 100 Mbits. The 
Ethernet port in the DCU must be capable of running at this speed.

The DCU moves between cameras and hubs quickly and efficiently without worrying 
about setting IP parameters. To allow for this flexibility the DCU Port on the camera or 
Camera Controller will therefore always have a DHCP server running and the attached 
DCU will run with its DHCP client turned on. The DCU Port on the camera and Camera 
Controller cannot be set up to run a DHCP client, only a server.

The default IP addresses of the cameras or Camera Controller's DCU port is 90.0.0.1. The 
DHCP server in the camera or Camera Controller connected to a DCU will issue IP 
addresses ranging from 90.0.0.2 through 90.0.0.11to configure other devices.

 Figure 9.5: DCU with a direct connection to the camera 

NOTE: It is possible to run the DCU in static IP mode as long as the 
address is in the same subnet as the camera. For the default IP address of 
90.0.0.1, assign it an address of 90.0.0.20.
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 9.6. DCU Connection through an HSU 
for HG-100K/LE/XR/XL/TH/CH
Attach the DCU to the network through the DCU port on the HSU.    

The DCU must move between cameras and hubs quickly and efficiently without worrying 
about resetting IP parameters. It uses DHCP for this dynamic configuration capability. In 
this case, there are DHCP clients running in the camera, Camera Controller, CCU and 
DCU. There must also be a DHCP server somewhere on the network; typically, this is the 
CCU. A DHCP server does not come standard with the Windows® operating systems. 
Redlake has tested a DHCP server called vDHCP Server for Windows®, a product from 
Paul Smith Computer Services. Contact them on the web at http://www.pscs.co.uk.

It is also possible to run the above system in Static IP mode, in this case the DCU will 
have to have its DHCP client turned off and assigned a unique static IP address in the 
192.168.0.x range like any other device in the system.

 Figure 9.6: DCU connection with an HSU

NOTE:  All seven Ethernet ports on the HSU follow the same rules of 
configuration as described in the multi-camera DHCP system.

NOTE:  The IP address of the camera DCU port CANNOT be changed. The 
DCU port is a permanent DHCP server.
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 9.7. Legacy Cameras
It is possible to connect legacy cameras to the HG-100K/LE/XR/XL/TH/CH system using a 
junction box. Use a D-Box for one legacy camera on the system; use a J-Box for multiple 
legacy cameras. Legacy cameras always run at 100 Mbits and always use static IP 
addressing. 

Legacy Camera Static IP Configuration
In this configuration, all devices on the network are using static IP addresses including the 
cameras and the Camera Head HD ports on the Camera Controllers. The network 
administrator must ensure that all devices have a unique static IP address in the same 
subnet.

Legacy Camera DHCP Configuration
In this configuration, there will be a mix of static IP addresses used for the legacy cameras 
and DHCP served addresses used in the HG-100K/LE/XR/XL cameras and HD ports on 
the HG-TH Camera Controller. A DHCP server must be running (likely on the CCU) with 
DHCP client mode turned on for each camera, Camera Controller and CCU. This server 
will be leasing addresses to each DHCP client in a range of addresses. The server will 
only lease addresses from this range. The most important thing to guarantee is that there 
will be no chance of assigning duplicates; this could happen for instance if the legacy 
static addresses were in the same range of addresses that the DHCP server is leasing. 

A common approach to eliminate duplicates that works on any DHCP server is to set up 
the DHCP server with the range of addresses that it will serve, and set up the static 
cameras or HD ports on the Camera Controller to be outside this range. The administrator 
must understand what ranges of addresses the DHCP server will be leasing. 

The vDHCP server from Paul Smith Computer Services http://www.pscs.co.uk has a few 
advanced features to help with this type of mixed system. These are:

• Assign the IP addresses as normal within the legacy cameras and set an exclusion in 
vDHCP so that it does not assign that IP address to the cameras or HD ports on the 
Camera Controllers.

• Set up a reservation in vDHCP so that it will automatically assign a certain IP address 
to a specific named camera or HD port on the Camera Controller. 

 Figure 9.7: Current and legacy camera set up using a J-Box
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 9.8. Setting IP Address Parameters

 9.8.1.  Camera High-G Port 
The high-G ports of all HG-100K/LE/XR/XL cameras shipped have a factory-default static 
IP address of <192.168.0.2>. It is recommended that the subnet remain the same for 
networks using static IP addresses, and that new IP addresses be assigned starting with 
<192.168.0.21>. This will simplify the administration of cameras added to the network. 

New cameras should be added one at a time, (since they all have the same IP address) 
and changed accordingly. The camera’s high-G port IP parameters should be set up 
through the MotionCentral software from either the CCU or the DCU. 

 9.8.2.  Change/Set Static the IP Address From the DCU Port 
1. Connect either the CCU or a DCU (Set to Obtain IP Address automatically) to the 

DCU Port on the camera. 

2. Run MotionCentral, and Attach the camera. 

3. Select the camera to be changed from the Camera List, and click on the System 
Tab from the CCU, or the Network Tab from the DCU. The current static IP 
address and Subnet Mask of the high-G port of the selected camera will be shown 
in the text boxes at the top of the tab. 

4. Change the IP address (and Subnet mask if desired) using standard decimal 
notation <xxx.xxx.xxx.xxx>. 

5. To turn the DHCP Client on, click on the System Tab and set the IP address and 
the Subnet Mask to <0.0.0.0>. 

6. Click Set or Apply. 

 9.8.3.  CCU/DCU 
Network parameters for the CCU and the DCU are set up using the Windows® TCP/IP 
configuration screens found under the Windows® Network control panel. 

 9.8.4.  Change/Set the Static IP Address of the High-G Port 
on a Static IP Network From the High-G Port 

1. Ensure the CCU, and the camera to be changed, are on the same subnet, so the 
CCU will recognize the camera on the network. (Ex. <192.168.0.X>). If the IP 
address of the camera is unknown, follow the instructions to Change/Set the 
Static IP address from the DCU Port

2. Launch MotionCentral and Attach the camera 

3. Select a camera from the Camera List and click on the System Tab on the Control 
Panel. The current static IP address and Subnet Mask of the high-G port of the 
selected camera will be shown in the text boxes at the top of the tab. 

4. Change the IP address (and Subnet mask if desired) using standard decimal 
notation <xxx.xxx.xxx.xxx> 

5. To turn the DHCP Client on, set the IP address and the Subnet Mask to <0.0.0.0>. 

6. Click Set. 

NOTE:  The IP address of the camera DCU port CANNOT be changed. 
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 9.8.5.  Change/Set the Static IP Address of the HG-TH 
Camera Controller Camera Port (HD) on a Static IP 
Network 

1. Ensure the CCU, and the Camera Controller port to be changed, are on the same 
subnet, so the CCU will recognize the camera on the network. (Ex. <192.168.0.X>).

2. Launch MotionCentral and Attach the camera. 

3. Select a camera from the Camera List and click on the System Tab on the Control 
Panel. The current static IP address and Subnet Mask of the high-G port of the 
selected camera port will be shown in the text boxes at the top of the tab. 

4. Change the IP address (and Subnet mask if desired) using standard decimal 
notation <xxx.xxx.xxx.xxx>. 

5. To turn the DHCP Client on, set the IP address and the Subnet Mask to <0.0.0.0>. 

6. Click Set. 

 9.9. Setting the Camera ID and Camera Name
Each camera has a Camera ID number and Camera Name. Both are user configurable 
fields. The Camera ID field accepts any number from 1 to 255. The Camera Name field 
accepts up to 50 characters. Invalid entries will be ignored and the values will remain 
unchanged.

To change the Camera ID and Camera Name:

1. Launch MotionCentral and attach the camera.

2. Select the camera from the Camera List, and click the Set button.

3. Input the desired Camera ID number and Camera Name, and click the OK button. 

4. Verify the information has been accepted by viewing the field next to the Set button.

 Figure 9.8:  Camera ID and Camera Name

Note:  The user is responsible to ensure each camera has a unique Camera ID 
and Name. 
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 9.10. Linking Multiple Hub Sync Units
Up to five Hub Sync Units (HSUs) can be linked sequentially, also known as a daisy chain.  
One HSU operates as the Root Hub, designated by the Root Hub Cap connected to the 
Link port.  The Root Hub is connected by one of it’s camera ports to the second HSU’s 
Link port. The second HSU is connected from one of it’s camera ports to the third HSU’s 
Link port, and so on.

Additional HSUs can be added at each level to support a maximum of 250 cameras.

The Root Hub controls a 1MHz signal communicated to each HSU and automatically 
adjusts the signal by 100µs per HSU, to account for connection time transmitting the 
signal from one HSU to the next.
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10. MotionCentral

MotionCentral is the camera control software supplied by Redlake, designed to run the 
MotionXtra family of cameras. MotionCentral can provide control for single cameras or for 
multiple cameras over a network, including individual camera settings, overall system 
settings, recording and playback. An example of MotionCentral is shown in Figure 10.1.

 Figure 10.1:  MotionCentral
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 10.1. Window Positioning
MotionCentral consists of a View area, which remains visible at all times, and four 
repositionable windows:  Control Panel, Camera List, System Status, and Command. 
Each of these four repositionable windows has a title bar, showing the name of the 
window, with various window control icons depending on the state of the window. These 
icons are explained below, and illustrated in Figure 10.2.

• The pushpin icon indicates a window is docked to the MotionCentral window. Clicking 
the pushpin changes the state of the docked window. A vertical pushpin indicates the 
window remains visible. A sideways pushpin indicates the window collapses to a tab 
when not in use. Clicking a tab shows the window again.

• When a window has a vertical pushpin or no pushpin, the window can be repositioned 
by either double-clicking or dragging the title bar. When dragging a window, a series 
of positioning cursors appear onscreen. Dragging the window onto a positioning 
cursor snaps the window to that position. The middle positioning cursor, which looks 
like a window with tabs, combines the window with others as a tab. Clicking the tab 
shows the window again.

• Clicking the X icon closes the window. If a window within MotionCentral is closed, 
it can be opened again by selecting it from the View menu.

• A box icon indicates the window size can be toggled, larger or smaller, when windows 
are sharing an area of the screen within MotionCentral.

   

 Figure 10.2:  MotionCentral Window Positioning

Tabs        Positioning Preview      Positioning Cursors             Title Bar           Pushpin            Box            X



MotionXtra User’s Manual

Redlake 7/26/07 47

 10.2. Control Panel
Settings in the Control Panel are grouped by functionality, accessed by clicking tabs along 
the side of the Control Panel. These tabs include Record, Download, System, HG/CR/TX, 
Video, and Time, as shown in Figure 10.3. Each tab is explained below.

 10.2.1.  Record
The Record tab on the Control Panel, shown in Figure 10.3, controls how cameras 
capture image data. Video settings include the recording Mode, Resolution, and 
Exposure. Session Length can also be specified. Frame Rates and Trigger can be set 
individually for Pre-trigger, Post-trigger, and Trigger Delay. Session ID allows the 
session to be labeled. Buttons at the bottom of the control panel include Standby, 
Record, Trigger, and Erase.

 Figure 10.3:  Control Panel, Record Tab
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 10.2.2.  Download
The Download tab on the Control Panel is shown in Figure 10.4. File settings specify file 
Format, Name, and Directory location for camera downloads. Other Download settings 
include a specific Frame Range and buttons to specify the computer hard disk drive or 
PCMCIA location.

 Figure 10.4:  Control Panel, Download Tab
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 10.2.3.  System
The System tab on the Control Panel, shown in Figure 10.5, allows the user to set 
Network Settings, Date & Time, and modify trigger and synchronization port hardware 
settings.

 Figure 10.5:  Control Panel, System Tab
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 10.2.4.  HG/CR/TX
The HG/CR/TX tab on the Control Panel, shown inFigure 10.6, allows the user to control 
legacy cameras. 

 Figure 10.6:  Control Panel, HG/CR/TX Tab
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 10.2.5.  Video
The Video tab on the Control Panel, shown in Figure 10.7, is used to set video-out formats. 
Clicking on the button that looks like a video monitor turns the Output on or off. In the on 
state the video monitor button appears as a color chart test pattern (see Figure 10.8).

 Figure 10.7:  Control Panel, Video Tab

 Figure 10.8:  Video Output On
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 10.2.6.  Time
The Time tab on the Control Panel, shown in Figure 10.9, allows the user to set the 
external synchronization source and time stamp.

 Figure 10.9:  Control Panel, Time Tab
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 10.3. Menus
The following menus are available at the top of the MotionCentral window:  File, Edit, 
View, and Help. The functionality available within each menu is explained below.

 10.3.1.  File
The File menu, shown in Figure 10.10, contains options for working with computer files. 
New, Open, Close, Save, Save As, Save As Avi, and Save As New Format manipulate 
image and video files on the computer or transfer images to a video file format. Create 
Film Index builds an index of “.bay” files in the Bayer format, from legacy cameras and 
other systems, so they can be played in MotionCentral. Save Settings and Load Settings 
allow users to recall changes made to the MotionCentral interface. Save Camera Settings 
and Load Camera Settings allow users to recall changes made to Control Panel settings. 
Setup opens the Configuration window for network settings and method of white balance 
(see Figure 10.11). Exit shuts down the MotionCentral program.

 Figure 10.10:  File Menu

 Figure 10.11:  Setup, Configuration Window
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 10.3.2.  Edit
The Edit menu, shown in Figure 10.12, includes functionality to Select All, Cut, Copy, 
and Paste data from an active window to the computer system clipboard file and back 
again.

 Figure 10.12:  Edit Menu
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 10.3.3.  View
The View menu, shown in Figure 10.13, allows a user to Refresh the active window,  
or choose to display the Control Panel, Camera List, System Status, and Command 
windows.

 Figure 10.13:  View Menu



MotionXtra User’s Manual

Redlake 7/26/07 56

 10.3.4.  Help
The Help menu, shown in Figure 10.14, includes a Camera Upgrade Wizard for updating 
camera firmware, and an About window showing the MotionCentral software version 
release number and copyright information. The About window also contains functionality 
for gathering system information about the computer itself.

 Figure 10.14:  Help Menu
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 10.4. Camera List
The Camera List in MotionCentral shows a thumbnail image and status icon for each 
camera attached to the network. For more information about thumbnail windows,  
see section 10.7. 

 Figure 10.15:  Camera List Window

 10.5. System Status
The System Status window shows a live feed of information about each camera on the 
network. This is used primarily by Service personnel for diagnostic purposes.

 Figure 10.16:  System Status Window

 10.6. Command
The Command window enables single commands to be sent to individual cameras or a 
group of cameras on a network. This is used primarily by Service personnel for diagnostic 
purposes.

 Figure 10.17:  Command Window
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 10.7. Thumbnail
The thumbnail window appears inside the Camera List window. One thumbnail is shown for 
each camera connected to the network.  The state of the camera is indicated by the status 
icon in the title bar of the thumbnail window.  See Table 10.1 for status icon descriptions.

When the tether cable is disconnected from the camera head, a Try Head Reconnect 
button will  appear on the thumbnail image (See Figure 10.18 ). Plug the tether cable into 
the head, then click on the button.

 Figure 10.18:  Thumbnail Window

Icon Appearance Status Models
White Circle Standby:  occurs about 30 seconds after camera is taken 

out of live mode
All camera systems

Green Circle Live:  camera thumbnail is active, or composite video out 
is active, or camera is in full image mode

All camera systems

Orange Circle 
(Blinking)

Ready:  camera is in record mode but has not yet been 
triggered

All camera systems

Film Reel 
(Blinking)

Record:  camera has been triggered and is recording All camera systems

Film Reel Record Done:  recording is complete and camera 
memory contains recorded data

All camera systems

Green Arrows 
(Blinking)

Download:  recorded images are being transferred or 
viewed over the Ethernet

All camera systems

Film Reel with 
Red Slash 
(Blinking)

Record Done with Error:  camera contains data but 
recording did not finish correctly

HG-TH and HG-CH only

Camera with  
Red Slash 
(Blinking)

Standby No Tether:  controller port is configured but 
tether cable is disconnected (only when no recording is 
present in memory)

HG-TH and HG-CH only

Camera with Red 
Exclamation Mark 
(Blinking)

Standby No Head:  controller port is configured but head 
is disconnected from tether cable (only when no recording 
is present in memory)

HG-TH and HG-CH only

Grey Wrench 
(Blinking)

Reconfiguring Heads:  occurs briefly when a head is 
being reconfigured by the controller (only when no 
recording is present in memory)

HG-TH and HG-CH only

Blue and Red 
Vertical Stripes

Unconfigured Head:  head is detached and can not be 
reconfigured because a recording is present in memory

HG-TH and HG-CH only

Table 10.1: Thumbnail Status Icons

Status Icon                                                           Button
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 10.8. Live
The Live window shows either a live image from a camera selected in the Camera List, 
playback of images from camera memory, or playback of a saved image file on the computer.

Tabs located at the bottom of the Live window provide controls for viewing the image, 
adjusting color, and operating remote control lenses.

 Figure 10.19:  Live Window, View Tab with Reticle on Image

 Figure 10.20:  Live Window, View Tab in Playback Mode

Live Window              Tabs
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 Figure 10.21:  Live Window, Color Tab for Monochrome Cameras

 Figure 10.22:  Live Window, Color Tab for Color Cameras

To select a White Balance Method, click the File menu, choose Setup, and select  
either the Automatic method to adjust white balance using a white target or the  
Color Temperature method if you know the color temperature of your light source.  
See Figure 10.11.

When three Color Gain sliders are present on the Color tab, clicking the Lock checkbox 
makes all three sliders move together. See Figure 10.22.
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 Figure 10.23:  Histogram

The Histogram window appears when the Histogram button (next to the Neutral button) is 
clicked on in the Color tab of the Live window (see Figure 10.22).

 Figure 10.24:  Live Window, Lens Tab

Clicking the Power On button on the Lens tab activates the lens controls, for cameras 
equipped with remote control lenses. There may be a slight delay before the controls 
become active.
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 10.9. Add Cameras Using MotionCentral
1. Locate the desired camera in the Camera List window.

2. Right-click the exclamation point icon on the Thumbnail window, and click on the 
word Attach in the pop-up menu. 

There may be a delay of several seconds between the actual connection or disconnection 
event and the panel update. Updates occur at least every polling period (approximately 
every 10 seconds).

As cameras connect and disconnect from the system, the Camera List panel refreshes, 
adding or removing the corresponding icons from the panel. Control activities initiated 
through the Control Panel affect all selected cameras in the Camera List window. 

 10.10. Select Cameras Using MotionCentral
1. Locate the desired camera in the Camera List window.

2. Click the Thumbnail window to select it. The window frame will turn yellow when 
selected. Any control or status operation command will apply to that camera. To 
select more than one camera at a time, hold down the Ctrl key on the keyboard 
and click on the Thumbnail windows. 

When multiple cameras are selected, any changes made will affect parameters for all the 
cameras selected. MotionCentral highlights the parameter values when the cameras have 
different values. The highlighted field will represent the value of the last camera it 
scanned. Such a parameter field remains highlighted until the user changes it, thereby 
resetting that parameter for any selected camera(s). The Control Panel commands only 
affect the non-blank, non-highlighted parameters. Commands do not force commonality 
where it is not wanted. 

 10.11. Control the Thumbnail Views Using MotionCentral

 10.11.1.  Live Thumbnail View
1. In the Camera List window, right-click on the thumbnail image for the camera.

2. In the pop-up menu, choose Thumbnail and select Live. The thumbnail image will 
continually update approximately every second. See Figure 10.26.

 Figure 10.25:  Camera Thumbnail with exclamation icon selected
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 10.11.2.  Still Thumbnail View
1. In the Camera List window, right-click on the thumbnail image for the camera.

2. In the pop-up menu, choose Thumbnail and select Still. This will stop the 
acquisition of thumbnail images, displaying the last acquired image in the 
thumbnail window. See Figure 10.26.

     

 10.11.3.  Play an Image Using the Film Reel Icon
1. In the Camera List window, right-click the film reel icon in the title bar of the 

thumbnail window (the film reel icon indicates images are in camera memory).

2. In the pop-up menu, select Play. This will display the images in a new window 
(or, if the window is already open, it will bring it to the front). See Figure 10.27.

 10.11.4.  Erase an Image Using the Film Reel Icon
1. In the Camera List window, right-click the film reel icon in the title bar of the 

thumbnail window (the film reel icon indicates images are in camera memory).

2. In the pop-up menu, select Erase, and click OK to confirm. This will erase any 
recorded images in camera memory. See Figure 10.27.      

NOTE:  Thumbnail image features are not available for legacy cameras. 
Legacy cameras will display an icon indicating the camera type.

 Figure 10.26:  Camera List, thumbnail context menu

 Figure 10.27:  Camera List, Film Reel context menu
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 10.11.5.  Arrange Cameras in the Thumbnail View
1. Select the System Tab from the Control Panel.

2. Use the drop-down list to select either alphabetical or chronological and click on 
the Sort button. 

 10.11.6.  Thumbnail Exposure
This control specifies how a remote HG-100K/LE/XR/XL/TH/CH camera should set its 
exposure for thumbnails either Normal for full (brightly lit) recording illumination, or Low for 
setup illumination (with bright recording illumination off). MotionCentral always uses 
Normal exposure setting while recording.

1. Select the System Tab from the Control Panel.

2. Use the radio buttons to select either Normal or Low. 

 10.12. View a Live Image in MotionCentral
1. Locate the desired camera in the Camera List window.

2. Double-click on the Thumbnail image. This will start a live image display for that 
camera in the View window.

For more information, see “View a Live Image Using MotionCentral” on page 76.

 10.13. Save and Load Interface Settings Using 
MotionCentral

The Save and Load Settings function saves time by creating 
a file with the software interface settings that can be saved 
and loaded to use with a particular camera setup. The 
following settings are saved with this option:

• Panel Docking and Pinning options

• Size of the viewing area 

 10.13.1.  Save Interface Settings
1. Set up the panels and viewing area as desired. 

1. From the main Toolbar, Click on the File drop-down 
menu.

2. Select Save Settings.

3. Type a file name and click on the Save button

 10.13.2.  Load Interface Settings
1. From the main Toolbar, Click on the File drop-down 

menu.

2. Select Load Settings.

1. Select a file to open and click on the Open button.

NOTE:  Select appropriate alpha names for the cameras if they should 
consistently display in the same order. 
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 10.13.3.  Context Menus
Context menus are available in many areas of MotionCentral by right-clicking. For 
example, right-click inside the View window area to display a pop-up menu of options. 
See Figure 10.28.

For more information on context menus for a live image, see page 80 and page 81.

For more information on context menus for image playback, see page 91

 Figure 10.28:  Context Menu
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11. Set up the Camera Using MotionCentral

 11.1. Record Modes 
Use External Sync, ROC, BROC, and Ready mode settings in conjunction with the 
Configurable Input BNC labeled Sync In on the back of the camera or Camera Controller.

1. From the Record Tab, use the drop-down list to select from the following modes:

• Normal – records into the camera’s circular buffer and 
waits for a trigger.

• External Sync – takes one frame per pulse the 
camera receives from the Configurable Input. 

• ROC (Record on Command) – takes frames 
whenever the pulse is true. 

• BROC (Burst Record on Command) – takes a set number of frames each 
time the camera recieves a pulse until the number of frames specified in the 
Session Length are recorded.

• Ready – records when the configurable input goes true. When the camera is 
in Ready mode, the camera records pre-trigger frames into the buffer and 
waits for a trigger signal.

For related information, see “Appendix D Connectivity/Connector Function” on page 120.

 11.2. BROC Length
If the Record Mode is BROC, use the BROC Length to set number of frames to save to 
memory for each pulse received at the Sync-In BNC.

1. Select Record from the Control Panel.

2. Select the number of frames using the BROC Length 
drop-down list. 

 11.3. Sync In 
Defines the polarity of the Sync Signal, and sets the Sync to be active on the positive or 
negative signal pulse or the switch closure. 

1. Select the System Tab from the Control 
Panel.

2. From the Sync In (Configurable Input) drop-
down list, select Positive, Negative or 
Switch Closure. 
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 11.4. Resolution 
The Resolution box offers standard resolutions plus a user-
defined option. The HG-100K and HG-XR/XL are capable of 
capturing images at user-defined resolutions up to 
1504 x 1128. The HG-100K and HG-XR/XL/CH horizontal 
resolutions may be set at increments of 32 and the vertical 
resolution may be set at increments of 8. The HG-LE is capable 
o f capturing images at resolutions up to 752 x 1128. The 
horizontal resolution for the HG-LE may be set at increments of 
16 and the vertical resolution may be set at increments of 8. 
The HG-TH/CH is capable of capturing images at resolutions 
up to 752 x 564. The horizontal resolution for the HG-TH/CH 
may be set at increments of 16 and the vertical resolution may 
be set at increments of 4.

1. Select the Record Tab from the Control Panel.

2. Use the Resolution drop-down list to select a resolution or select User to manually 
type in a resolution. 

 11.5. Exposure 
1. Select the Record Tab from the Control Panel.

2. At the Exposure box, use the radio buttons to select one of the following options:

• Live Low – places the camera in low-light mode for framing and focusing the 
camera. This allows for a longer exposure than during actual recording.

• Live Normal – sets the exposure to the same setting used during recording.

3. Type the exposure in microseconds directly into the text box or use the up and 
down arrow keys to select the exposure.

4. Click on the f-stop buttons to adjust the f-stop in 1/2 f-stop increments.

 11.6. Session Length 
1. Select the Record Tab from the Control Panel. 

2. In the Session Length section, type 
the number of frames directly into 
the text box or use the up and down 
arrow keys. The box to the right 
indicates the session length in 
seconds. The numbers below the 
Session Length text box indicate 
the maximum number of frames 
allowed. 

For related information, “Frame Storage Capacity” on page 100

NOTE:  The choice of resolution sets a limit for maximum frame rate. 

NOTE:  If the selected camera is a legacy TX model, this will become a 
drop-down box with the possible values listed. Other legacy models do not 
have selectable session lengths.
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 11.7. Session ID 
The Session ID box permits attaching a name to the recording run. It can be any string of 
up to 51 characters. When viewing border data in Live or Playback modes only the first 
three characters of the Session ID will be visible. The remaining characters are present in 
the headers of all downloaded TIFF, JPEG and Type-2 files.

1. Select the Record Tab from the 
Control Panel. 

2. Type the new name for the 
recording using up to 51 
characters.

 11.8. Trigger Positioning and Frame Rate 
When the camera is in Normal or External mode it receives the trigger signal, it names the 
current frame 0. All of the frames before the trigger are pre-trigger frames and all of the 
frames after the trigger are post-trigger. (The trigger frame (0) is considered the first post-
trigger frame.)

With the HG-100K/LE/XR/XL/TH/CH camera it 
is possible to record an event with up to three 
different frame rates in one session.  
Pre-trigger frames may be recorded at a 
different frame rate than Post-trigger frames. 
Post-trigger frames can be divided into 2 
regimes that may, in turn, have different frame 
rates.

 11.8.1.  Select Frame Rate
1. Select the Record Tab from the 

Control Panel. 

2. From the Frame Rate drop-down list, 
select the desired frame rate for Pre- and Post-trigger. Select User from the 
Frame Rate drop-down to select a frame rate from 25 fps to the maximum frame 
rate allowed for the specified resolution. Frame rates are selectable in increments 
of 5 fps. 

 11.8.2.  Set Pre-trigger and Post-trigger (Dividing Session 
Length)

Once the Resolution and the Session Length are set, the session length can be divided 
between Pre-trigger and Post-trigger.

1. Select the Record Tab from the Control Panel. 

2. Type the number of frames directly into the text box or use the up and down arrow 
keys. The box below the frame rate indicates the Pre-trigger in seconds. 
Alternatively, Pre- and Post-trigger can be set by clicking and dragging the slider 
tabs on the Trigger slider bar. 

NOTE:  The frame rate for the example is 10,000 frames per second.  
At 1,000 frames per second with a Debounce Delay of 100 microseconds 
the time stamp (offset to trigger) will usually be a negative number. 
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 11.8.3.  Trigger Delay 
The Trigger Delay specifies the delay, in milliseconds, between receipt of the trigger and 
assertion of frame 0.

1. Select the Record Tab from the Control Panel. 

2. Use the up or down arrow keys to set the Trigger Delay. 

 11.9. Trigger 

 11.9.1.  Configure Trigger and Time Stamp Setup 
1. Select the System Tab from the Control Panel.

2. Use the Trigger Input drop-down list to define 
the polarity of the Trigger In signal. It may be 
set to positive for a rising TTL signal, or 
negative for a falling TTL signal or switch 
closure, or it may be disabled.

3. Use the up and down arrow keys to define the Trigger Debounce Delay, which is 
the length of time in microseconds that the trigger input signal must be “true” 
before it is considered valid by the camera.

4. Each frame includes a time stamp in microseconds. The time stamp value is 
included in frame’s border data. Use the Timestamp drop-down list to select from 
the following options: 

• Trigger Validation – each frame’s time stamp measures from the end of the 
trigger debounce time. Frame 0 will generally have a negative time stamp.

• Trigger – each frame’s time stamp measures from the actual time a valid 
trigger is received. This mode is not valid if using an HSU for the frame and 
trigger timing. Frame 0 may be either negative or positive depending on the 
frame rate, debounce delay, and the actual time within frame 0 that the trigger 
is validated.

• Beginning of Frame 0 – each frame’s time stamp measures from the 
beginning of frame 0 exposure. Frame 0 will always have a time stamp of 0 in 
this mode. Frame 1 will have a time stamp of 0 + 1/frame rate, etc.       

 Figure 11.1: Trigger and Time Stamp Setup
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 11.9.2.  Offset and Trigger Timing
The HG-100K/LE/XR/TH writes a time stamp into the border data of each captured frame. 
The following examples will help you understand the meaning of this measurement and 
how the setup and trigger mechanism affect its interpretation.

The MotionXtra system asserts the trigger in the following forms: 

• Software trigger from MotionCentral.

• A switch closure or TTL pulse applied directly to a camera not on a network using an HSU.

• A switch closure applied to an HSU on a network where a valid root hub is present.

An HG-100K/LE/XL/TH/CH camera can be set up to reference its time stamp to one 
of the following three points in time:

• Trigger – is the actual time that the trigger is activated.

• Trigger Validation – is post signal validation.

• Beginning of Frame 0 – is the beginning of the exposure.

Example 1 Software Trigger 
In the case of a camera or a network of cameras triggered via software, it is unknown how 
much time will elapse between the time when an operator clicks on the trigger icon and 
when any given camera validates that trigger. All cameras on the network will trigger at 
different times, therefore, the offset time from Trigger or Trigger Validation will not be 
applicable. Setting the time stamp reference to the Beginning of Frame 0 will give an 
accurate measurement for each camera. The time stamp for frame 0 will be zero, and the 
time stamp for frame 1 will be 1/frame rate, etc. If there is more than one camera, it is 
difficult to discern an accurate relative timing for each camera’s frame 0.

Example 2 Hardware trigger applied to Trigger In BNC (not on an HSU network with 
a valid root hub)
If the camera’s time stamp reference is set to Trigger, the time stamp offset will be the 
time between when the valid trigger is asserted and frame 0. In Figure 11.2 the trigger 
occurred 74 microseconds before frame 0. In this case, the time stamp for frame 0 will be 
74 microseconds.     

If the camera’s time stamp reference is Trigger Validation, the measurement in the border 
data is the offset from the trigger validation time. In Figure 11.3 the trigger occurred 74 
microseconds before frame 0 but trigger validation occurs 111 microseconds later. If the 
time stamp reference is Trigger Validation, the offset of frame 0 is -37 microseconds. 

 Figure 11.2: Time stamp offset to Trigger +74 microseconds

 
 

Trigger is Validated 
in HG-100K 

 
 

 

Offset to Trigger : +74    μsec
 

111 μsec 
Debounce 

Delay

Start of 
Exposure

Actual Hardware 
Trigger at Trigger BNC

Frame -1Frame -2 Frame +1Frame 0

74μsec 37μsec 

74μsec 



MotionXtra User’s Manual

Redlake 7/26/07 71

The trigger offset is ignored if the camera’s time stamp is set to the Beginning of Frame 0. 
The time stamp for frame 0 will be zero and the time stamp for frame 1 will be 1/frame 
rate, etc.     

Example 3 Hardware trigger applied to any camera or HSU with cameras attached to 
an HSU network with a valid root hub.
A root hub on the camera LAN, sends an encoded clock signal for frame timing, time 
stamp and Trigger.

In this case, there is a relatively small, unknown propagation delay between the trigger 
pulse and the arrival of the pulse at the root hub. There is a 100 microseconds uncertainty 
from the time the root hub gets the trigger and when the trigger is encoded into the sync 
line and is sent to all the cameras. For this reason, using Trigger for the camera’s time 
stamp reference will not give accurate results. 

Use Trigger Validation for the camera’s time stamp reference, because the cameras will 
validate the triggers at the same time.

At each camera, there is an additional 0 to 500 microsecond countdown to trigger before 
trigger validation, depending on the number of hubs between the camera and the root 
hub. The result is that the trigger validation will be 500 to 600 microseconds after the time 
the trigger is sent. The cameras will validate their triggers at the same time and 
synchronize to the trigger output sent to the legacy cameras. 

The IRIG Trigger (output) at each HSU is true at the same time all of the cameras validate 
the trigger. The value of the offset to frame 0 when using an HSU network represents the 
time (within a microsecond or so) that the IRIG Trigger on any hub goes true.

To calculate exactly when frame 0 occurred when using an IRIG Trigger: 
1. Set the time stamp reference to Trigger Validation.

2. Monitor the time the IRIG Trigger at any HSU goes true.

3. Subtract the border data frame 0 offset (setting the time stamp reference to trigger 
with a valid root hub will not yield accurate results).

If the camera’s time stamp is set to the Beginning of Frame 0, the camera will ignore the 
trigger offset. The time stamp for frame 0 will be zero, and the time stamp for frame 1 will 
be 1/frame rate, etc.

 Figure 11.3: Time stamp offset to trigger validation -37 µs
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 11.10. IRIG and GPS Support
IRIG (Inter-Range Instrumentation Group) and GPS (Global Positioning System) ensure 
synchronization to a known reference time for all data collection equipment used on a 
range. They provide a standard day of the year, hour, minute and second data time stamp 
for cameras even if the cameras are several kilometers apart from each other. This 
standardized time reference helps to provide accurate data analysis.

For Related information:

• “HG-XR/XL Connectors and Indicators” on page 9

• “Frame Synchronization” on page 66

• “Time Tab” on page 72

 11.11. Time Tab
The Time Tab is used to set the Time Source and IRIG/GPS settings.

 11.11.1.  IRIG Time Stamp Offset
The IRIG Time Stamp Offset is a drop-down list for setting the relation between the 
exposure and the IRIG time stamp. Choices include Start, Middle, and End. If this is set to 
Start, all IRIG and GPS timestamps will reflect the time at the beginning of each exposure. 
If it is set to Middle, all IRIG and GPs timestamps will reflect the time at the Middle of each 
exposure. If it is set to End, all IRIG and GPS timestamps will reflect the time at the end of 
each exposure.

 11.11.2.  IRIG Phase Shift
When IRIG or GPS is used as a Time Source, the camera will synchronize its frame clock 
with the IRIG or GPS signal received. IRIG Phase Shift is used to control the phase 
relationship between the frame clock and IRIG/GPS time. If this parameter is set to 0, 
there will always be one frame whose exposure begins precisely (within 1µsec) of every 
even second, with subsequent frames taken at 1/framerate thereafter. A distribution 
cameras all set with this parameter the same will thus be frame synchronized. 

IRIG Phase Shift may be used to vary the phase relationship between the frame captures 
of several cameras. For example, if two cameras, capturing frames at 1000 fps, are either 
using IRIG or GPS as a time source, they may be set 180° out of phase with each other by 
setting this parameter to 0 for one and +500µsec for the other.

 11.11.3.  Time Source
The Time Source pull down allows the user to select the time source used for frame timing 
of the camera. The dialog box will be populated according to the features available for the 
selected camera.

• Camera – This is the default setting. The camera will use its internal clock or the an 
HSU sync clock (if available) for all frame timing.

• Camera IRIG – This is available only for HG-XR cameras. The camera will use the 
IRIG signal, if available, for frame synchronization.

• GPS – Available only for the HG-XR and HG-XL cameras, the camera will use the 
GPS signal, if available, for frame synchronization.

• PC IRIG – This will become active only if MotionCentral detects an IRIG board 
(ITS6146G).    

NOTE:  IRIG settings apply only to HG-XR cameras. GPS settings apply to 
HG-XR and HG-XL cameras.



MotionXtra User’s Manual

Redlake 7/26/07 73

 11.12. PC IRIG 
The HG-100K/LE/XR/XL/TH/CH system connects to a CCU that has an ITS6146G IRIG 
board installed to provide IRIG/GPS timing data for captured recordings.

At initialization, MotionCentral scans the CCU and if an IRIG board is found, it appends 
the Timing Source drop-down list in the control panel, and adds IRIG: True to the border 
data for that camera session.

When using PCIRIG, the camera and IRIG board must share a common trigger.

 11.13. System Date and Time 
This area contains text boxes to display and set the time settings internal to the camera. 

1. Select the System Tab from the Control 
Panel. 

2. To load the current camera time settings, 
press the Update button in the Date & Time 
section. Alternatively, to force a date and 
time setting to a camera, set the desired 
values in the text boxes and click the Set button.

 Figure 11.4: IRIG Time Controls

NOTE:  Select all cameras on the camera LAN before setting date and time. 
Camera clocks will run independently and not synchronously, so 
occasional re-synchronizing may be necessary.
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 11.14. Strobe 
Strobe Out provides a sync signal for equipment such as strobe lights or other cameras. 
The signal is true for the interval that the exposure is true.

The Strobe Out delay function allows adjustments the beginning of the pulse to 
accommodate for timing differences in equipment. It is adjustable in increments of 5 
microseconds from -100 to Exposure -7 microseconds depending on the exposure. As 
exposure approaches the upper limits, it reduces the amount of negative adjustment. 
When exposure is set to the maximum possible, there is no negative delay adjustment 
allowed. As exposure approaches the lower limits, the amount of positive adjustment is 
impacted. When exposure is set to 5 microseconds, there is no positive delay allowed. 
Select the System Tab from the Control Panel.

1. In the Strobe Out section, use the drop-down 
list to select the Strobe Out polarity.

2. Use the up and down arrow keys to adjust 
the Strobe Out Delay. 

 11.15. Border Data Setup
The Border Data button opens a dialog box that provides checkboxes for each of the 
possible border data items. Border data can be displayed on the image in either Live or 
Playback mode. Border Data can be added to the following file formats:

• AVI

• JPEG

• TYPE2

• TIFF

1. In the Control Panel select the System tab.

2. Click on the Border Data button.

3. Select the checkboxes for Border Data 
items to display on the image.       

 Figure 11.5: Border data display selections
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 11.16. Camera Control Using Command Protocol 
1. Click on the Command tab.

2. The drop-down list offers a quick reference for command numbers. Enter the 
command number into the text box.

3. Check the Global box to send the command using the broadcast port to all 
connected cameras. The camera will not send a response to a command sent 
using the broadcast port.

4. Click on the Send button.     

 11.17. Save and Load Camera Settings
The Save and Load Camera Settings function 
creates a file with the basic camera setting that 
can be saved and loaded to a camera. The 
following settings are saved with this option:

• Record Mode

• Resolution

• Exposure

• Session length

• Trigger and Frame Rate settings

• Camera orientation

 11.17.1.  Save Camera Settings
1. From the main toolbar, Click on the File 

drop-down menu.

2. Select Save Camera Settings.

3. Type a file name and click on the Save 
button.

 11.17.2.  Load Camera Settings
1. From the main toolbar, Click on the File 

drop-down menu.

2. Select Load camera Settings.

3. Select a file to open and click on the Open button.

 Figure 11.6: Command tab
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12. View a Live Image Using MotionCentral

 12.1. Open a Live Image in the View Window
1. In the Camera List, double-click on the thumbnail image. This will start a live 

image in the View window. See Figure 12.1.

 Figure 12.1: Live Image

 12.2. Display Control Options
Controls are located along the bottom of the View window, below the image, organized in 
a tabbed interface. These controls include display options and color correction.

 12.2.1.  Focus the Image at the Selected Resolution 
For resolutions on a HG-100K/XR/XL above 600x800, the viewable area within the View 
window reduces to 25 percent of the actual resolution.

1. Select the View tab near the bottom of the screen.

2. Select the Focus checkbox. This zooms to the center of the image and displays 
the image pixel-for-pixel. 

 12.2.2.  Change the Display Rate
1. Select the View tab near the bottom of the screen.

2. Use the drop-down menu to select the desired display rate.

NOTE:  Display rates depend on network performance. 
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 12.2.3.  Zoom In or Zoom Out on the Image
1. Select the View tab near the bottom of the screen.

2. In the Zoom control box, click the + button to zoom in, click  
the – button to zoom out, or click the Reset button for normal 
magnification.

 12.2.4.  Display the Reticle
The reticle is a pair of white crossed lines drawn over the image. When the reticle is 
enabled, a position indicator beside the reticle control button shows the current pixel 
position of the reticle cross point.

1. Select the View tab near the bottom of the screen.

2. In the Reticle control box, click the + button.

3. To move the reticle, click and drag the crosshairs on the 
image to the desired position.

 12.2.5.  Camera Orientation 
The HG-100K/LE/XR/XL/TH/CH cameras allow different mounting orientation options. 
MotionCentral allows the orientation of the live image or playback image to match the 
physical orientation of the camera setup. This information is available in the border data. 

1. In the Control panel select the System Tab.

2. Use the Camera Orientation drop-down 
menu to select the orientation that 
matches the physical setup.

 12.2.6.  Select Camera Orientation
1. Select the View tab near the bottom of the screen.

2. To use the same camera orientation as selected in the 
System Tab, check the Use Camera Orientation box.

 12.2.7.  White Balance Correction
A color camera that is not properly white balanced will create an image in which the colors 
are incorrect, often creating a green or red tinge to objects that should appear white. If the 
system is adjusted so the color white displays properly, then other colors will display 
accurately.

White balancing a camera requires imaging a gray card surface and then adjusting the 
RGB values under White Balance until the digital number for the pixel data in each color 
plane is approximately equal. The values should be approximately equal because in 
electronic imaging systems the color white is created by displaying equal amounts of red, 
green, and blue. 

1. Select the Color tab below the image in the View window.

2. Select a neutral-gray target object in the field of view illuminated by the same 
lighting used during recording. A photographic gray card is ideal.

3. Click on the White Balance reticle button and move the reticle so that the central 
box is located completely within the target object. 

4. Change the gain values of the image by moving the adjacent sliders. To move all 
three Gain sliders together, select the Lock checkbox. 

5. Observe the reticle pixel values and adjust the exposure setting or illumination of 
the target object until none of the values is at or near saturation (255).
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6. Click the Apply button until all pixel values are within a few counts of each other 
and/or the color of the scene displays true.     

 12.2.8.  Gamma Correction
The Gamma Correction Slider adjusts the image to suit the gamma curve of the display 
device. Gamma values for CRT displays are likely to be in the 1.8 to 2.2 range, while 
values for LCD/TFT displays are likely to be in the .8 to 1.2 range. If the gamma is set too 
low, images will tend to appear dark and have too much contrast. If the gamma is set too 
high, images will tend to appear light and washed-out with too little contrast.

1. Select the Color tab below the image in the View 
window.

2. Click and drag the Gamma Slider to adjust the color 
values for Gamma

 12.2.9.  Color Correction for Images
Color corrections can be saved to the following image formats:

• AVI

• JPEG

• TIFF

• TYPE2
1. Select the Color tab below the image in the View window.

2. Click and drag the appropriate slider to adjust the color values. The following 
sliders are available: 

• Brightness

• Contrast

• Hue

• Saturation

3. Select the Neutral button to set the values back to their original state or download 
the image. 

 12.2.10.  Display the Histogram 
1. Select the Color tab below the image in the View window.

2. Click on the Histogram icon. The Histogram displays values for the following: 

• Luminosity

• Red

• Green 

• Blue    
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 12.3. View a Live Image on a NTSC/PAL Monitor 
The HG-XR/XL/TH/CH systems provide a connection to an NTSC/PAL monitor for viewing 
images while in Live mode. Control the output using the MotionCentral software or directly 
from the HG-TH Camera Controller or HG-XR/XL Camera.

 12.3.1.  Control the Output to a NTSC/PAL Monitor from the 
HG-TH Camera Controller

1. Connect one end of the BNC cable to the NTSC/PAL monitor and connect the 
other end to the BNC connector below the Head Select button on the HG-TH 
Camera Controller. 

2. To output the video to the NTSC/PAL Monitor press the Head Select button on the 
Camera Controller. In multi-camera configurations, press the Head Select button 
again to view the video from other Camera Heads. 

 12.3.2.  Control the Output to a NTSC/PAL Monitor from the 
HG-XR/XL

1. Connect one end of the BNC cable to the NTSC/PAL monitor and connect the 
other end to the BNC connector COMP OUT on the HG-XR/XL Camera. 

2. To output the video to the NTSC/PAL Monitor press the Live button on the back 
panel Camera. 

3. Click on the Live button to select a different Live Low setting: 

• 33ms

• 15ms

• 5ms

• 1ms

• Live Normal

 12.3.3.  Control the Output to a NTSC/PAL Monitor with 
MotionCentral

1. Connect one end of the BNC cable to the monitor:

• If using an HG-TH controller, connect the other end to the BNC connector 
below the Head Select button on the HG-TH Camera Controller. 

• If using an HG-XR/XL, connect the other end to the BNC connector labeled 
Comp Video Out. 

2. From the Camera List, select the desired Camera. 

3. From the Control Panel, select the Video tab.

4. From the drop-down list, select NTSC or PAL video output.

5. From the On Screen Display drop-down list, select one of the following on-screen 
information options:

• OFF

• Time

• Name and ID

• Time, Name and ID 

6. Click the Video Output On/Off monitor icon to output the video to the monitor. In 
multi-Camera Head configurations, click on the Video Output On/Off monitor icon 
to select a different Camera Head to output to the NTSC/PAL monitor. 
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 Figure 12.2: Video tab for NTSC/PAL output

 Figure 12.3:  Copy a Live Image

 12.3.4.  Copy a Live Image
1. Right-click on the live image in the View window. A pop-up menu displays.

2. From the pop-up menu, select Copy. The image in the View window is copied to 
computer memory (the clipboard) and can be pasted into another program.
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 12.3.5.  Border Data Context Menu
1. Right-click on the live image in the View window. 

2. From the pop-up menu, select Border Data.  
A sub-menu offers the following options:

• Show adds border data to the View window.

• Hide removes border data from the View 
window.

• Select Fields opens a sub-menu to choose 
what elements of border data will display.

 12.3.6.  Rotate the Image
1. Right-click on the live image in the View 

window. A pop-up menu displays.

2. From the pop-up menu, select Rotate.  
A sub-menu offers the following options:

• Reset brings the image back to its original 
orientation (not rotated).

• 180° rotates the image one half turn 
(upside-down).

• 90° CW rotates the image a quarter turn 
clockwise (right).

• 90° CCW rotates the image a quarter turn counter-clockwise (left).

• Flip Horizontal changes the image so left becomes right (mirrored).

• Flip Vertical changes the image so top becomes bottom (inverted).

 12.3.7.  Toggle Between Live Image and Reference Image 
1. Right-click on the live image in the View window. A pop-up menu displays.

2. From the pop-up menu, select Image. A sub-menu offers the following options: 

• Open enables the selection of a reference image (a saved image file).

• Toggle switches between the reference image and the live image.

• Continuous Toggle switches between the reference image and the live image 
at a regular interval using the values set in the System tab of the Control 
Panel (see 12.3.8.)

 12.3.8.  Toggle Rate
1. In the Control Panel, select the System tab.

2. At the bottom of the System Tab, use the Image Toggle Rate up and down arrows 
to set the delay in seconds. This is the amount of time each image will display, 
alternately, when Continuous Toggle is selected (see 12.3.7.)

NOTE:  Border Data settings apply to the selected camera only, for as long 
as the view remains open.
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13. Record an Event Using MotionCentral

 13.1. Overview
MotionCentral has several camera settings such as resolution, frame rate, and exposure 
that require configuration before recording an event. For more information on these 
settings, see “Set up the Camera Using MotionCentral” on page 66. The Record Controls 
provide the means to begin a recording, send a software trigger, stop recording, and 
delete the recording from camera memory.

 13.2. Record Controls
MotionCentral provides four buttons to control recording, as follows: 

• Standby – restores the camera 
system to Standby mode, canceling 
any recording in process. Standby 
mode is not available after the camera 
system receives a trigger. On legacy 
camera systems it cancels the live 
image displayed on a video monitor.

• Record – puts the camera into Record mode, or Ready. In this mode the camera 
records pre-trigger frames, storing them into a circular buffer until it receives a trigger.

• Trigger – sends a software trigger signal to all currently selected cameras over the 
camera LAN.

• Erase – deletes the images stored in camera memory.

 13.2.1.  Access the Record Controls
1. On the Control Panel, select the Record tab.

2. At the bottom of the Record tab, select the desired Record control button. 

For information on how to playback the session and select viewing options, see “Playback 
Image Files Using MotionCentral” on page 87.

For information on how to download the session, see “Download, Open and Save Image 
Files Using MotionCentral” on page 83.

NOTE:  After the recording is complete, the View window automatically 
switches to playback mode, displaying images from camera memory. 
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14. Download, Open and Save Image Files Using 
MotionCentral

 14.1. File Download
1. Select the Download tab from the Control Panel.

2. Type a directory name in to the Directory text box or use the “...” button to select a 
directory. 

3. Type a file name in to the Name text box. If the text box is blank, the frame 0 
filename will be [Camera Name Shown in Camera List].[extension]. Entering a 
prefix in the box, will replace the [Camera Name Shown in Camera List] in the 
filename.

4. Click on the Increment Directory Name check box to specify the selected directory 
for the next download. This is especially useful when downloading multiple 
cameras. 

5. Click on the Use Camera Name check box to add the camera name that captured 
the session as shown in the Camera List.

6. Select the download options from the panel such as file format and border data.

7. Click on the Download icon to begin the download. While the download is 
underway, a progress bar is visible. The progress bar window contains an Abort 
button to terminate the download if necessary.

 14.2. Download Options

 14.2.1.  Select File Format (Raw, AVI, etc.)
1. Select the Download tab from the Control Panel. 

2. Use the Format drop-down list to select from the following options for an  
HG-100K/LE/XR/XL/TH/CH camera (options will differ for Legacy cameras):

• JPEG

• TIFF

• TYPE2

• TYPE2 Continuous

• AVI

 14.2.2.  Save Border Data to XML
MotionCentral creates a separate XML-based file to store the border data. The XML file is 
ideal for viewing archived data without parsing the image file or opening MotionCentral. 

1. Select the Download tab from the Control Panel.

2. Click on the Save Border Data to XML check box.

NOTE:  Disable the Windows® XP Service Pack 2 Firewall component when 
downloading large files such as TYPE2 and TIFF. To disable the Firewall 
component of Service Pack 2 from the PC, select the Windows® Control 
Panel > Network Connections > Select the camera network connection > 
Properties tab > deselect the Firewall option. 
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 14.2.3.  Download and Create AVI Formatted File
The Download and Create AVI feature creates a motion video file in AVI format. The AVI 
files are ideal for fast previews from the MotionCentral’s Playback View. 

1. Select the Download tab from the Control Panel.

2. Specify a download file name and directory. 

3. Check the Download and Create AVI check box.

4. From the Download tab, click on the Download button.

5. From the Download as AVI window, select the Video Compression mode. 

6. Use the Frames Per Second pull-down list to select a different playback speed for 
viewing the AVI file using a standard media player, if desired.

7. Use the Key Frames pull-down list to set the interval between Key Frames, 
if desired. The Key Frames will remain uncompressed files.

8. Check the Add Border Data to AVI, if desired.       

 14.2.4.  Apply Color Changes when Downloading a File
MotionCentral supports saving changes to the hue, gamma and white balance of AVI, 
JPEG, TIFF, and TYPE2 formatted files. 

1. Select the Download tab from the Control Panel.

2. Check the Apply Color Changes on Download check box. 

 Figure 14.1 AVI Setup

NOTE:  Downloading files with color changes requires much greater PC 
processing than without color changes and will cause the download to 
take longer.  The actual speed will depend on the PC performance.
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 14.2.5.  Set Automatic Download
MotionCentral provides an option for automatically downloading a session when the 
recording is complete. The selected download options are applied to the file. 

1. Select the Download tab from the Control Panel.

2. Select the file directory and name of the file. 

3. Check the Automatic Download check box.

 14.2.6.  Select a Frame Range to Download
1. Select the Download tab from the Control Panel.

2. Click on the up or down arrow keys to enter the frame limits or use the sliders to 
select the frame range.

3. Click on the Reset button to revert to the full range.     

 Figure 14.2: Download tab
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 14.3. Open a Downloaded File
1. Select File at the top of the MotionCentral 

toolbar. 

2. From the drop-down list, select Open. 

3. Select the Film Index folder and select the 
desired AVI, TYPE2, JPEG, TIFF, or IDX 
file. An IDX file is an index of still files 
created by the software and added to the 
image file folder. An AVI file is a motion file 
and is ideal for fast previews from 
MotionCentral’s Playback View.

 14.4. Convert Files to AVI Format
1. Select File at the top of the MotionCentral 

toolbar. 

2. Select Save As .AVI from the File drop-
down list.

3. From the Open File menu, select the .IDX 
of the files to convert. The AVI Setup 
Dialog box will display.

4. From the Video Compressor drop-down 
list, select the desired video compression 
method.

5. Check the No Compression box for highest quality images.

6. Use the Quality slider to select the desired video quality. Selecting a higher 
percentage number will result in a higher quality image and a larger image size.

7. Under Options, check the Add Border Data to AVI box if you would like 
MotionCentral to add border data to the *.AVI file. Under Destination, select where 
you would like to save the file.

8. Click OK. 

 14.5. Convert Files to TIFF Format
1. Select File at the top of the MotionCentral toolbar. 

2. Select Save As New Format from the File drop-down list.

3. From the Open File menu, select the .IDX of the files to convert.

4. Under Destination, select target folder.

5. Click OK. 

NOTE:  MotionCentral supports the viewing of images captured using 
legacy cameras. Using the Create Film Index option, from the File drop-
down list, an *.IDX file can be built by selecting saved images from legacy 
cameras.
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15. Playback Image Files Using MotionCentral

 15.1. Overview
MotionCentral can play recorded image sequences from a camera. A camera containing a 
recorded image displays a film reel icon on the Thumbnail View title bar. Once the 
Playback window is open, a number of controls are available in addition to those available 
for a live image. Older cameras (HG2000, CR2000, and HG-TX models) can playback a 
recorded image to an attached video monitor.      

 15.2. Open an Image for Playback
1. After recording an image, the camera’s Thumbnail title bar will display a film reel 

icon. 

2. From the Camera List, double click on the desired camera’s Thumbnail view. An 
image will display in the Camera Playback window. View and Color control tabs 
will display at the bottom of the Camera Playback window. 

 Figure 15.1: Playback from camera window
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 15.3. Set Display Controls
1. Select the View tab below the playback window.

2. Click one of the following display option buttons:

• Ping-Pong Mode – repeats image sequence continuously, playing 
from beginning to end, then backwards from end to beginning.

• Continuous Play – repeats image sequence continuously, playing 
from beginning to end. 

• Trigger Frame – click on this icon and Frame 0, the trigger frame, 
is displayed.

 15.4. Display the Frame Position Based on Frame 
Number

1. Select the View tab below the Playback window.

2. Enter the desired frame number in the F box. 

 15.5. Display the Frame Position Based on Time Relative 
to the Trigger Time

1. Select the View tab below the Playback window.

2. Enter the frame’s time stamp relative to the trigger time in 
seconds.

 15.6. Change the Frame Rate
1. Select the View tab below the Playback window.

2. Use the drop-down list to change the frame rate.

 15.7. Select Start and End Boundaries
1. Select the View tab below the Playback window.

2. Use the sliders on either side of the green band to select the start and end of the 
session.

3. Click on the Reset button to return to the session to its full size. 

 15.8. Zoom In or Zoom Out on the Image
1. Select the View tab below the Playback window.

2. To zoom in on the image, click on the + button adjacent to the 
Positional icon. To zoom out on the image, click on the – button. 

3. To reset the zoom, click on the Reset button. 
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 15.9. Display the Reticle
The reticle is a pair of white crossed lines drawn over the image. When the reticle is 
enabled, a position indicator beside the reticle control button shows the current pixel 
position of the reticle cross point.

1. Select the View tab below the Playback window.

2. Click on the reticle icon.

3. To move the reticle, place the cursor over the crosshairs and 
drag it to the position desired.

 15.10. Set Camera Orientation
1. Select the View tab below the Playback window.

2. Click on the Use Camera Orientation check box to 
display the image in the same orientation as selected in 
the System Tab. 

 15.11. Download from the View Tab
1. Select the View tab below the Playback from camera mode window.

2. Click on the Download icon to begin the download. While the 
download is underway, a progress bar is visible. The progress bar 
window contains an Abort button to terminate the download if 
necessary.     

 15.12. Select a Frame in Playback from Disk Mode
1. Select the View tab below the Playback window.

2. Use the slider to scroll through the frames.      

 15.13. Crop an Image
JPEG and TIFF images can be cropped to view a particular area of the image. 

1. In the Playback View window, place the cursor over the area of the image to be 
cropped. 

2. Hold down the CTRL button on the keyboard and the left mouse button and drag 
the cursor to expand the area. The cropped image is displayed in the shaded box. 

3. Release the CTRL button and the left mouse button to select the cropped area.

4. To return to the original image, click on the Original button.

 Figure 15.2: View tab in Playback from camera mode
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 15.14. Color Correction for Playback Images
1. Select the Color tab below the Playback View window.

2. Click and drag the appropriate slider to adjust the color values. The following 
sliders are available: 

• Brightness

• Contrast

• Hue

• Saturation

• Gamma

3. Select the Neutral button to set the values back to their original state. 

 15.15. Set the Dynamic Range for TYPE2 Images
1. Select the Color tab below the Playback View window.

2. Use the Dynamic Range pull-down list select a different 
dynamic range.     

 15.16. Copy an Image
1. Right click on the image in the playback view. The pop-up menu 

will display. 

2. Select Copy from the pop-up menu. The image in the Playback 
View window will be copied to the Clipboard.

 Figure 15.3: Color tab in Playback mode
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 15.17. Control Border Data Menu Display from the Con-
text Menu

 Border Data can be added to the following file formats:

• AVI

• JPEG 

• TYPE2

• TIFF

1. Right-click on the image in the Playback View window. A pop-
up menu will display.

2. Select Border Data. An additional menu offers the following 
options: 

• Select Show to enable border data display.

• Select Hide to disable border data display.

• Select Fields to open an additional menu and select the border data 
elements.

 15.18. Rotate the Image
1. Right-click on the image in the Playback View window. A pop-up menu will 

display.

2. Select Rotate. An additional menu offers the following options:

• 90° CW (clockwise, or right)

• 90° CCW (counter-clockwise, or left)

• 180° Flip (reflect) Horizontal 

• Flip Vertical 

• Reset command restores the image to its original state.

 15.19. Toggle Between Live Image and Reference Image
1. Right-click on the image in the Playback View window. A pop-up menu will 

display. 

2. An additional menu offers the following options: 

• The Open… command opens a file browser to select a previously saved 
image to reference against the live image.

• The Toggle command switches the displayed image between the newly 
opened reference image and the live image.

• The Continuous Toggle command toggles the two images at a regular 
interval using the values set in the System tab. 

NOTE:  This controls the displayed border data for this camera only, for as 
long as the view remains open.
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 15.19.1.   Set the Toggle Rate between Live and Reference 
Images

1. Select the System Tab on the Control Panel. 

2. At the bottom of the System Tab, use the Image Toggle Rate up and down arrows 
to select the toggle rate in seconds.

 15.20. View a Playback Image on an NTSC/PAL Monitor 
with the HG-XR/XL/TH/CH Systems

The HG-XR/XL/TH/CH systems provide a connection to an NTSC/PAL monitor for viewing 
images while in Playback. Control the output using the MotionCentral software or directly 
from the Camera Controller. 

 15.20.1.  Output Playback to an NTSC/PAL Monitor with 
MotionCentral

1. Connect one end of the BNC cable to the monitor:

• If using an HG-TH controller, connect the other end to the BNC connector 
below the Head Select button on the HG-TH Camera Controller. 

• If using an HG-XR/XL, connect the other end to the BNC connector labeled 
COMP OUT.

2. From the Camera List, double click on the desired camera’s Thumbnail view. An 
image will display in the Camera Playback window. 

3. Click the Play button on the View tab at the bottom of the Playback window.

4. From the Control Panel, select the Video tab.

5. From the drop-down list, select NTSC or PAL video output.

6. From the On Screen Display drop-down list, select one of the following on-screen 
information options:

• OFF

• Time

• Name and ID

• Time, Name and ID

7. Click the Video Output On/Off monitor icon to start outputting to the monitor. 

8. In multi-Camera Head configurations, click on the Video Output On/Off monitor 
icon to select a different Camera Head to output to the NTSC/PAL monitor.
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16. Legacy Cameras

The HG/CR/TX tab on the Control Panel supports legacy camera models including the 
HG2000, CR2000, and HG-TX. The following chapter applies to legacy cameras only.

 16.1. Network Settings
Legacy cameras require the PC to be configured to a similar network IP Address.  
A video monitor must be connected to Video Out on the rear panel of the legacy camera. 
Video images will display on the video monitor, not the computer display.

1. When the camera is properly connected and powered on, the video monitor will 
display the camera’s IP Address.

2. Configure the computer’s network adapter to a similar IP Address:

• In Windows, open the Control Panel, and open Network Connections.
• Right-click the network adapter connected to the camera, and click Properties.
• Scroll down, and click on Internet Protocol (TCP/IP), but be careful not to 

deselect the checkbox, just highlight the item.
• Click the Properties button.
• Enter the new IP Address, similar to the camera’s IP Address (for example, 

if the camera is 192.168.248.105, try entering 192.168.248.106).
• Press the Tab key to auto-fill the Subnet Mask (for example, 225.225.225.0).
• Click the OK button on each screen to exit.

3. In MotionCentral, click the File menu and choose Setup. The Configuration screen 
will appear. Select the Support HG/CR/TX checkbox to enable legacy cameras. 
Make sure the correct network adapter is selected from the dropdown menu (the 
one you just configured). Click the OK button to exit the Configuration screen.

4. Click the thumbnail window in the Camera List so the thumbnail window is 
highlighted. Click the HG/CR/TX tab in the Control Panel, and the controls should 
now appear active (not greyed-out).

5. When camera operation is finished, to reset your network settings, repeat the 
bulleted steps above but select Obtain An IP Address Automatically.     

 Figure 16.1:  Network Settings for Legacy Cameras
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 16.2. Rear Panel Lockout
The buttons on the rear panel of a legacy camera can be disabled through MotionCentral.

1. On the HG/CR/TX tab of the Control Panel, click on the Rear Panel Lockout 
button (the button looks like a padlock). When the padlock appears closed,  
the camera buttons are disabled.

2. Click the Rear Panel Lockout button again. When the padlock appears open,  
the camera buttons are enabled.

 Figure 16.2:  HG/CR/TX Tab for Legacy Cameras

 16.3. Output
A video monitor must be connected to Video Out on the rear panel of the legacy camera. 
Video images will display on the video monitor, not the computer display.

1. On the HG/CR/TX tab of the Control Panel, click the Setup White Balance & 
Reticle button.

2. In the HG/CR/TX Setup screen, click the Output On/Off button (the button looks 
like a video monitor). The button should change to look like a test pattern.

3. Use the drop-down list to select NTSC or PAL video modes. 

4. Click the Done button.     

 Figure 16.3:  White Balance for Legacy Cameras
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 16.4. White Balance
A video monitor must be connected to Video Out on the rear panel of the legacy camera. 
Video images will display on the video monitor, not the computer display.

1. On the HG/CR/TX tab of the Control Panel, click the Setup White Balance & 
Reticle button.

2. Select a white or neutral-gray target object in the field of view illuminated by the 
same lighting to be used during recording. A photographic gray card is ideal.

3. Use the arrow buttons to move the crosshairs across the video monitor, 
positioning the central box completely within the target area. Selecting the Coarse 
checkbox will make the arrow buttons move the crosshairs in greater increments.

4. Click the Set button to send the setting to the camera.

5. A drop-down list box at the bottom of the dialog allows control of the camera’s 
internal white balance setting.

 16.5. Reticle
A video monitor must be connected to Video Out on the rear panel of the legacy camera. 
Video images will display on the video monitor, not the computer display.

1. On the HG/CR/TX tab of the Control Panel, click the Setup White Balance & 
Reticle button.

2. Click the Reticle tab.

3. Use the arrow keys to move the reticle across the video monitor. Selecting the 
Coarse checkbox will make the arrow buttons move the crosshairs in greater 
increments.

 Figure 16.4:  Reticle for Legacy Cameras
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 16.6. Playback
A video monitor must be connected to Video Out on the rear panel of the legacy camera. 
Video images will display on the video monitor, not the computer display.

1. On the HG/CR/TX tab of the Control Panel, click the Playback button.

2. The Remote Playback screen provides typical playback controls such as Stop, 
Rewind, and Fast-Forward, as well as more specific controls such as Rate of 
playback in fps (frames per second).

 Figure 16.5:  Playback Controls for Legacy Cameras

 16.7. PCMCIA File System
The PCMCIA button opens a dialog for configuring the PCMCIA file system. Legacy 
camera models support an internal PCMCIA module for downloading recorded images. 

 Figure 16.6:  PCMCIA for Legacy Cameras

 16.7.1.  Select Local or Remote Output of Commands
1. On the HG/CR/TX tab of the Control Panel, click the PCMCIA button.

2. Select the Local radio button to direct output to the large text area to the right of 
the dialog. Select the Remote radio button to direct output to the video monitor.

 16.7.2.  Directory Settings
1. On the HG/CR/TX tab of the Control Panel, click the PCMCIA button.

2. Use the Directory Settings buttons for the following options: 

• Change – changes the current working directory to what is in the text box at 
the top of the group box.

• Create – creates a directory name.
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• Delete – removes the directory.

• List – produces a listing of the contents of the specified directory, either to the 
text area in the dialog (if Local is selected), or to the attached monitor (if 
“Remote” was selected).

• More – advances the list as necessary.

 16.7.3.  Delete Files
Click a file in the text list area to display its name in the File box text area. Click a directory 
to display its name in the text box.

1. On the HG/CR/TX tab of the Control Panel, click on the PCMCIA button.

2. Enter the file name in the Files text box.

3. Click the delete button.

NOTE:  Live, Playback, and thumbnail images from HG-100K/LE/XR/XL/TH/
CH cameras will stop when legacy cameras download images. 
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17. Appendix A Camera Specifications

 17.1. Description
HG-100K, HG-LE, HG-XR, HG-XL, HG-TH, and HG-CH are High-G cameras that use a 
high-performance CMOS sensor. Each camera system can be configured with different 
amounts of memory. All camera systems have a battery backup for retaining images 
during a power fault for up to six hours. The MotionCentral software installed on the  
CCU/DCU provides all camera control functions.

 17.2. Memory
Cameras may be configured with different amounts of memory, as shown in Table 17.1.  
HG-XR and HG-XL cameras offer the largest available memory configuration of 32 GB.  
HG-TH Controllers contain 4 GB or 8 GB of memory, and split the memory based on the 
number of HG-TH and HG-CH camera heads attached (1 to 4 heads per controller).

 17.3. Frame Rate/Resolution
The HG-100K, HG-XR, and HG-XL are capable of capturing images at user defined 
resolutions up to 1504 x 1128. The HG-LE provides resolutions up to 752 x 1128.  
The HG-TH and HG-CH are capable of capturing images at resolutions up to 752 x 564. 
The resolutions for the HG-100K, HG-XR, and HG-XL are user-definable in increments of 
32 pixels horizontally and 8 pixels vertically. The resolutions for the HG-LE are user 
definable in increments of 16 pixels horizontally and 8 pixels vertically. The resolutions for 
the HG-TH and HG-CH are user-definable in increments of 8 pixels horizontally and 
4 pixels vertically.

The following tables show all possible frame rates and the highest possible corresponding 
resolutions.

 17.3.1.  HG-100K, HG-XR, and HG-XL    

Model 1 GB 2 GB 4 GB 8 GB 16 GB 32 GB
HG-100K
HG-LE
HG-XR and HG-XL
HG-TH Controller

Table 17.1:  HG-100K/LE/XR/XL/TH/CH Available Memory Configurations

FPS ~ 4:3 1:1 ~ 3:1
<1,000 1504 x 1128 1120 x 1120 1504 x 584
2,000 1056 x 792 896 x 896 1504 x 488
3,000 832 x 632 704 x 704 1312 x 432
5,000 640 x 480 544 x 544 992 x 328
10,000 416 x 320 352 x 352 672 x 216
20,000 256 x 192 224 x 224 416 x 136
30,000 192 x 152 160 x 160 320 x 104
50,000 96 x 72 96 x 96 192 x 64
100,000 32 x 24 — 64 x 24

Table 17.2:  HG-100K/XR/XL Frame Rates and Resolutions
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 17.3.2.  HG-LE

 17.3.3.  HG-TH and HG-CH

FPS 1:1
1,500 752 x 752
2,000 656 x 656
2,500 576 x 576
3,000 512 x 512
5,000 400 x 400
10,000 256 x 256
20,000 176 x 176
30,000 128 x 128
50,000 64 x 64

Table 17.3:  HG-LE Frame Rates and Resolutions

FPS 1:1
1,000 752 x 564
1,600 512 x 512
1,800 480 x 480
2,000 512 x 408
2,600 480 x 320
3,700 320 x 320
5,000 320 x 240
10,000 256 x 136
30,000 128 x 64
50,000 80 x 40

Table 17.4:  HG-TH/CH Frame Rates and Resolutions
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 17.4. Frame Storage Capacity

 17.4.1.  HG-100K 
The HG-100K is available with 2 GB or 4 GB of memory. 

• 2 GB = 1,264 full frames (1.2 seconds record time at 1000 fps.)

• 4 GB = 2,528 full frames 
Longer record times are possible at resolutions less than 1504 x 1128. In addition, the 
HG-100K offers the capability for varying the frame rate during the same recording, 
allowing you to achieve greater record times during a single event.

 17.4.2.  HG-LE
The HG-LE is available with 1 GB or 2 GB of memory. 

• 1 GB = 1,264 full frames

• 2 GB = 2,528 full frames

 17.4.3.  HG-XR and HG-XL
The HG-XR/XL is available with 8 GB, 16 GB, or 32 GB of memory.

• 8 GB = 5 seconds 1504 x 1128 at 1000 fps

• 16 GB = 10 seconds 1504 x 1128 at 1000 fps

• 32 GB = 20 seconds 1504 x 1128 at 1000 fps

 17.4.4.  HG-TH and HG-CH
The HG-TH Controller is available with 4 GB or 8 GB of memory, split between the 
number of HG-TH and HG-CH camera heads attached (1 to 4 heads per controller).

• 4 GB with 1 camera head =  10,108 full frames

• 4 GB with 2 camera heads = 5,056 full frames

• 4 GB with 3 camera heads = 3,370 full frames

• 4 GB with 4 camera heads = 2,528 full frames

• 8 GB with 1 camera head =  20,216 full frames

• 8 GB with 2 camera heads = 10,112 full frames

• 8 GB with 3 camera heads = 6,740 full frames

• 8 GB with 4 camera heads = 5,056 full frames
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 17.5. HG-100K Camera Specifications

 17.6. HG-100K Sensor Specifications

Sensor 1504 x 1128 pixels, CMOS
Resolution 1504 x 1128; 8 bits (mono), 24 bits (color) pixel depth
Recording Rates 25, 30, 60, 125, 250, 500, 1000 full fps; up to 100,000 partial fps;  

variable frame rate via external source
Shutter Global Electronic Shutter variable from 1/frame rate -5 µs
Trigger Frame Variable position from start to the maximum available frame capacity
Trigger Mode TTL, 5 V-tolerant, user selectable polarity, or switch closure
Synchronization All cameras are synchronized to a master precision clock
Record Time Standard: 1.2 sec @ 1000 full fps; Longer record times possible at 

slower frame rates and/or reduced resolution
Camera Size (H x W x L) 135 mm x 282 mm x 105 mm (5.33" x 4.15" x 11.10”)
Camera Weight 5 kg (11 lbs)
Camera Interface Camera Network (100/1000Base-T Ethernet); Sync I/O; Trigger In; 

Power; Strobe Out
Cable Lengths Camera to Hub: up to 100 m (328 ft);  

Hub to Hub/Control PC: up to 100 m (328 ft)
Lens Mount C-mount, F-mount, and high-G mounts available
Power Camera: +24 to 50 VDC @ 42 W; 

UL Listed device with rated output max 50 VDC, 4.5 A
Shock 100 G @ 5 ms min. any axis, 1000 cycles
Operating Temperature 0° C to + 45° C Ambient (14° F to 113° F)
Control Software MotionCentral CCU. Windows® 2000, XP
File Formats Type-2 Bayer (10 bits), TIFF (8 bits), JPEG, AVI, Type2 Continuous
Reticle Full Screen Crosshair with X, Y Coordinate Display
Options Tablet Style Display Control Unit (DCU)
Emission/Safety Meets all applicable international standards

Table 17.5:  HG-100K specifications

Sensor Type Complementary Metal Oxide Semiconductor (CMOS)
Sensor Resolution 1504 x1128 Pixels, each pixel 12 microns square
Readout Sequence Progressive scan
Shutter Type Synchronous with variable integration time
Dark Current 330 pA/cm2 at 21° C (69.8° F) with microlenses and color filters
Dynamic Range 62 dB
Fill Factor 45%

Table 17.6:  HG-100K sensor specifications
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 17.7. HG-100K Camera Dimensions and Mounting 
Instructions

There are five 1/4-20 threaded holes in the bottom plate of the camera. Four of the holes 
are in a standard rectangular configuration for attaching a small mounting plate and the 
fifth hole is provided as a central position for a conventional tripod mount.

   

 Figure 17.1:  HG-100K dimensions and mounting holes, front and side (in mm)

 Figure 17.2:  HG-100K dimensions and mounting holes, bottom (in mm)
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 17.8. HG-LE Camera Specifications

 17.9. HG-LE Sensor Specification

Sensor Array 16-Channel, 752 x 1128 pixels, CMOS Sensor, Color or Monochrome
Image Resolution Up to 752 x 1128
Dynamic Range 62 dB at sensor and 25° C (77° F) ambient temperature
Recording Rates 25, 30, 60, 125, 250, 500, 1000 full fps; up to 100,000 partial fps;  

variable frame rate via external source
Shutter Global Electronic Shutter variable to 5 µs
Trigger Frame Variable position from start to the maximum available frame capacity
Trigger Mode TTL, 5 V-tolerant, user selectable polarity, or switch closure
Synchronization All cameras are synchronized to a master precision clock when using 

optional Hub Sync Unit within +/- 1.25 µs
On-Board Storage 1 GB memory storage, 2 GB optional
Camera Size (H x W x L) 135 mm x 105 mm x 282 mm (5.33" x 4.15" x 11.10”)
Camera Weight 4.5 kg (9.9 lbs)
Camera Interface Camera Network (100/1000Base-T Ethernet); Sync I/O; Trigger In; 

Power; Strobe Out
Cable Lengths Camera to Hub: up to 100 m (328 ft);  

Hub to Hub/Control PC: up to100 m (328 ft)
Lens Mount C-mount, F-mount, and high-G Box-mounts available
Power Camera: +24 to 50 VDC @ 40W; 

UL Listed device with rated output max 50 VDC, 4.5 A
Shock Camera and Hub: 100 G @ 5 ms min. any axis, 1000 cycles
Operating Temp. 0° C to +45° C Ambient (32° F to 113° F)
Control Software MotionCentral, Windows® 2000, XP
File Formats Type-2 Bayer (10 bits), TIFF (8 bits), JPEG, AVI, Type2 Continuous
Reticle Full Screen Crosshair with X, Y Coordinate Display
Options Tablet Style Display Control Unit (DCU)
Emission/Safety CE approved, FCC Class B compliant, UL recognized (camera),  

UL listed (Hub Sync Unit)

Table 17.7:  HG-LE specifications

Sensor Type Complementary Metal Oxide Semiconductor (CMOS)

Sensor Resolution 1128 x 752 Pixels, each pixel 12 microns square

Readout Sequence Progressive scan

Shutter Type Synchronous with variable integration time

Dark Current 330 pA/cm2 at 21° C (69.8° F) with microlenses and color filters

Dynamic Range 62 dB

Fill Factor 45%

Table 17.8:  HG-LE sensor specifications
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 17.10. HG-LE Camera Dimensions and Mounting 
Instructions

There are five 1/4-20 threaded holes in the bottom plate of the camera. Four of the holes 
are in a standard rectangular configuration for attaching a small mounting plate and the 
fifth hole is provided as a central position for a conventional tripod mount.

 Figure 17.3:  HG-LE dimensions and mounting holes, front and side (in mm)

 Figure 17.4:  HG-LE dimensions and mounting holes, bottom (in mm)
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 17.11. HG-XR/XL Camera Specifications

 17.12. HG-XR/XL Sensor Specification

Sensor 1504 x 1128 pixels, CMOS
Resolution 1504 x 1128 at 1000 fps
Recording Rates Selectable, 25 to 100,000 fps in 5 fps increments; variable frame rate 

via external source
Shutter Global Electronic Shutter variable to 5 µs
Trigger Frame Variable position from start to the maximum available frame  

capacity
Trigger Mode TTL, 5 V-tolerant, user selectable polarity, or switch closure;  

variable debounce delay
IRIG Synchronization (HG-XR only)  IRIG B decoder with accuracy within +/-1 µs  

unmodulated, +/- 10 µs modulated in a multi-camera network.
HSU Synchronization The optional Hub Sync Unit (HSU) provides accurate synchronization 

within +/- 1.25 µs
GPS Synchronization When the cameras are able to maintain a GPS lock, all cameras will 

be synchronized to within +10 µs of each other.
Record Time 8 GB: 5 seconds; 16 GB: 10 seconds; 32 GB: 20 seconds
Camera Size (H x W x L) 170 mm x 115 mm x 284.3 mm (6.69” x 4.53” x 11.19”)
Camera Weight 6.5 kg (14.3 lbs)
Camera Interface Camera Network (100/1000Base-T Ethernet); Sync I/O; Trigger In; 

Power; Strobe Out
Cable Lengths Camera to Hub: up to 100 m (328 ft);  

Hub to Hub/Control PC: up to 100 m (328 ft); 
Longer distances can be achieved with fiber media converters

Lens Mount C-mount, F-mount, and high-G mounts available
Power Camera: +24 to 50 VDC @ 65 W Max.; 

Hub: +24 to 50 VDC @ 50 W Max.
Shock 100 G peak @ 6 ms min. any axis, 1000 cycles
Operating Temperature -10° C to + 45° C Ambient 
Control Software MotionCentral CCU. Windows® 2000 and XP 
File Formats Type-2 Bayer (10 bits), TIFF (8 bits), JPEG, AVI, Type2 Continuous
Reticle Full Screen Crosshair with X, Y Coordinate Display
Options Tablet Style Display Control Unit (DCU)
Emission/Safety CE approved, FCC Class B compliant, UL recognized (camera), 

UL listed (HSU)

Table 17.9:  HG-XR/XL specifications

Sensor Type Complementary Metal Oxide Semiconductor (CMOS)

Sensor Resolution 1504 x 1128 at 1000 fps

Readout Sequence Progressive scan

Shutter Type Synchronous with variable integration time

Dark Current 330 pA/cm2 at 21°C (69.8°F) with microlenses and color filters

Dynamic Range 62 dB at sensor and 25° C (77° C) ambient temperature

Fill Factor 45%

Table 17.10:  HG-XR/XL sensor specifications
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 17.13. HG-XR/XL Camera Dimensions and Mounting 
Instructions

There are six 1/4-20 threaded holes in the bottom plate of the camera. Four of the holes 
are in a standard rectangular configuration for attaching a mounting plate and the other 
two holes are provided as central positions for a conventional tripod mount.

 Figure 17.5:  HG-XR/XL dimensions, side (in mm)
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 Figure 17.6:  HG-XR/XL dimensions, front (in mm)

 Figure 17.7:  HG-XR/XL dimensions and mounting holes, bottom (in mm)
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 17.14. HG-TH/CH Camera Specifications 

 17.15. HG-TH/CH Sensor Specifications

Sensor Array 8-Channel, 752 x 564 pixels, CMOS Sensor, Color or Monochrome
Image Resolution Up to 752 x 564 at 1000 fps
Dynamic Range 62 dB at sensor and 25° C (77° F) ambient temperature
Recording Rates Selectable, 25 to 10,000 fps in 5 fps increments; variable frame rate 

via external source
Shutter Global Electronic Shutter variable to 5 µs
Trigger Frame Variable position from start to the maximum available frame capacity
Trigger Mode TTL, 5 V-tolerant, user selectable polarity, or switch closure, variable 

debounce delay
Synchronization All cameras are synchronized to a master precision clock when using 

optional Hub Sync Unit within +/- 1.25 µs
On-Board Storage 4 GB or 8 GB memory storage
Camera Size (H x W x L) HG-TH Controller: 168 mm x 94 mm x 202 mm (6.61” x 3.70” x 7.95”) 

HG-TH Head: 95 mm x 95 mm x 68 mm (3.74" x 3.74" x 2.68”) 
HG-CH Head: 109 mm x 67.76 mm x 41.65 mm (4.28” x 2.67” x 1.64”) 
HG-CH Interface Unit: 139.89 mm x 94 mm x 60.19 mm (5.51” x 3.7” x 2.37”)

Camera Weight HG-TH Controller: 4.3 kg (9.5 lbs) 
HG-TH Head: 1.25 kg (2.75 lbs) 
HG-CH Head: 0.7 kg (1.5 lbs) 
HG-CH Interface Unit: 0.8 kg (1.7 lbs)

Tethered Cable 3 m, 6 m, and 10 m length at 8 mm, 9 mm, and 10 mm diameter 
respectively

Camera Interface Camera network (100/1000Base-T Ethernet); Sync I/O; Trigger In; 
Power; Strobe Out

Controller Cable 
Lengths

Camera to hub/PC: up to 100 m (328 ft);  
Hub to Hub/Control PC: up to 100 m (328 ft)

Lens Mount C-mount and high-G box-mounts available
Power Camera: +24 to 50 VDC @ 40 W
Shock Camera and Hub: 100 G @ 5 ms min. any axis, 1000 cycles
Operating Temp. 0° C to +40° C Ambient (32° F to 104° F)
Control Software MotionCentral (version 3.2.76 or higher for HG-CH),  

Windows® 2000 or XP
File Formats Type-2 Bayer (10 bits), TIFF (8 bits), JPEG, AVI, Type2 Continuous
Reticle Full screen crosshair with X, Y coordinate display
Options Tablet Style Display Control Unit (DCU)

Table 17.11:  HG-TH specifications

Sensor Type Complementary Metal Oxide Semiconductor (CMOS)
Sensor Resolution 752 x 564 pixels, each pixel 12 microns square
Readout Sequence Progressive scan
Shutter Type Synchronous with variable integration time
Dark Current 330 pA/cm2 at 21° C (69.8° F) with microlenses and color filters
Dynamic Range 62 dB
Fill Factor 45%

Table 17.12:  HG-TH sensor specifications
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 17.16. HG-TH Camera Controller Dimensions and 
Mounting Holes

There are four 1/4-20 threaded mounting holes in the wide surface plate of the Camera 
Controller and four 1/4 -20 threaded mounting holes in the small end surface plate 
opposite the connectors. The most reliable mounting position for high-G environments is 
to mount the Camera Controller with the wide end attached to the surface and the 
connectors facing opposite direction of the impact. When mounting the Camera Controller 
upright with the small end plate connected to a surface, use brackets to help stabilize it.       
     

 Figure 17.8:  HG-TH Controller dimensions, front (in mm)

 Figure 17.9:  HG-TH Controller dimensions, side (in mm)
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NOTE:  Mounting screws should be inserted no more than 6 mm into any 
mounting hole to avoid damaging the case and internal components.

NOTE:  The HG-TH Camera Controller has optional rubber feet and a 12 mm 
heat sink device attached. For more information, see “Precautions” on 
page 6.

 Figure 17.10:  HG-TH Controller mounting holes, rear (in mm)

 Figure 17.11:  HG-TH Controller mounting holes, bottom (in mm)
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 17.17. HG-TH Camera Head Dimensions and Mounting 
Instructions

There are four 1/4-20 threaded mounting holes and four M4X0.7 mounting holes on the 
front plate of the Camera Head. There are two M4X0.7 mounting holes on each side of the 
Camera Head. The most reliable method for mounting the Camera Head in a high-G 
environment is to use at least four holes to connect the head to the surface.

            

NOTE:  Mounting screws should be inserted no more than 6 mm into any 
mounting hole to avoid damaging the case and internal components.

 Figure 17.12:  HG-TH Camera Head dimensions and mounting holes, front (in mm)

 Figure 17.13:  Camera Head dimensions and mounting holes, side (in mm)
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 17.18. HG-CH Camera Head Dimensions and Mounting 
Instructions

There are two M4X0.7 mounting holes on each side of the Camera Head, and two 4.20 
through-holes extending from one side to the other.  The most reliable method for 
mounting the Camera Head in a high-G environment is to use at least four holes to 
connect the head to the surface.

 

NOTE:  Mounting screws should be inserted no more than 6 mm into any 
M4X0.7 mounting hole to avoid damaging the case and internal 
components.

 Figure 17.14:  HG-CH Camera Head dimensions and mounting holes, front (in mm)

 Figure 17.15:  HG-CH Camera Head dimensions and mounting holes, side (in mm)
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 Figure 17.16:  HG-CH Camera Head Mounting Hardware, Angle Bracket (in mm)

 Figure 17.17:  HG-CH Camera Head Mounting Hardware, Dovetail Clamp (in mm)
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 17.19. HG-CH Interface Unit Dimensions and Mounting 
Instructions

There are four M4X0.7 mounting holes on each side of the Interface Unit. The most 
reliable method for mounting the Interface Unit in a high-G environment is to use at least 
four holes to connect the unit to the surface.

 

NOTE:  Mounting screws should be inserted no more than 6 mm into any 
M4X0.7 mounting hole to avoid damaging the case and internal 
components.

 Figure 17.18:  HG-CH Interface Unit dimensions and mounting holes, front (in mm)

 Figure 17.19:  HG-CH Interface Unit dimensions and mounting holes, side (in mm)
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 Figure 17.20:  HG-CH Inteface Unit Mounting Hardware, Angle Bracket (in mm)

 Figure 17.21:  HG-CH Interface Unit Mounting Hardware, Dovetail Clamp (in mm)
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18. Appendix B Hub Sync Unit (HSU) 
Specifications

 18.1. HSU and Synchronization
The root hub manages the distribution of synchronization and trigger signals to the 
cameras, hubs, and legacy boxes. All of the devices in the camera network synchronize 
with the root hub. The root hub is the hub at the top of a fan-out tree distribution, and has 
a Root Hub Cap which screws on to the upper Link port on the hub. The root hub 
originates a sync signal with encoding for frame synchronization, time stamping, and 
triggering of the camera array.

If a HSU loses the root hub sync signal, the sync signal generated at the hub indicates a 
loss of sync with the Root Hub and each camera will tag its subsequent image files with a 
loss of sync marker that displays in the border data.

A hardware trigger can be received anywhere on the network, camera or HSU. If the 
trigger connects to the camera or the Hub, it propagates back to the Root Hub via the 
Trigger Return signal for encoding onto the sync signal. 

 18.2. HSU Specifications

NOTE:  In systems with multiple cameras connected through HSUs, 
connect and power up before placing any camera in ready state. 
Connecting additional cameras to the HSU may inadvertently trigger 
previously connected cameras.

DC Power Connector ITT Cannon, Mil-Spec, 8-pin, circular
Ethernet Connector RJ-45, hardened to withstand high-G environment
Sync/Trigger/Pwr  
Connector

18-Pin high-G Connector

Trigger Input Connector BNC
IRIG Clk Connector BNC (not implemented)
IRIG Trig Connector BNC (not implemented)
HG J/D Box 26-Pin high-G connector
Dimensions (H x L x W) 330 mm x 22.6 mm x 330 mm (13.0" x 0.89" x 13.0”)
Weight 5.35 Kg (11.8 lbs)
Power 20 to 50 VDC input, 30 VDC out to camera
Shock 100 G @ 5 ms min. any axis, 1000 cycles
Temperature Operating:  -10 to 45° C (14 to 113° F)

Non-Operating:  -25 to 65° C (-13 to 149° F)
Humidity Operating:  Max. 80%, non-condensing, at 45° C (113° F) for 8 hours.

Non-Operating:  Max. 40%, non-condensing, at 65° C (149° F) for 48 hours.
Altitude Operating:  Max. 3,048 m (10,000 feet) with an ambient temperature of  

0 to 25° C (32 to 77° F). Non-Operating:  Max. 15,240 m (50,000 feet). 

Table 18.1:  HSU Specifications
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 18.3. HSU Mounting Dimensions

 Figure 18.1: Hub Sync Unit (HSU)

 Figure 18.2: Hub Sync Unit (HSU) mounting dimensions, front (in mm)
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 18.4. HSU Legacy Port
The HSU has an integrated legacy D- or J-Box port designed to support the use of older 
cameras such as the HG-TX, HG2000, and CR2000. 

The Legacy Communications (COM) Cable is required to connect the D- and J-Boxes to 
the HSU. One end attaches to the Output connector on the J- or D-Box and the other end 
connects to the HG J/D Box connector on the camera. Camera commands, Trigger, and 
Sync (at 1000FPS) transfer over this communication/data link between the CCU and the 
Legacy cameras.

The HSU does NOT provide power to Legacy cameras and J/D boxes. The J/D boxes 
connect to their own power supplies.

A 1 KHz sync signal is active on the Legacy Port of the HSU. If Legacy cameras are set to 
External mode when in record, it will receive a 1 KHz pulse that is frame synchronized with 
the HG-100K/LE/XR/XL/TH/CH camera, regardless of frame rate.

 Figure 18.3: Hub Sync Unit (HSU) mounting dimensions, side (in mm)
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19. Appendix C DCU Specifications

Fujitsu Stylistic® ST4000 Series Tablet PC      

1) The internal modems on all Fujitsu pen tablet PCs from Fujitsu PC Corporation are only qualified 
for use with telephone systems in selected countries, including the United States and Canada. For a 
list of certified countries, please check http://www.fujitsupc.com/modems

2) Actual speeds over U.S. telephone lines vary, and are less than 56Kbps due to the current FCC 
regulations and line conditions.

3) Service and warranty turnaround time may vary by country and product. International warranty 
valid only for products purchased in North, Central, and South America.

4) Battery life estimates reflect the results of Ziff Davis Business Winstone 2001 Battery Mark 1.0 as 
performed upon systems with maximum battery life settings enabled. Actual battery life will vary 
based on screen brightness, applications used, features selected, power management settings, 
battery conditioning, and other customer preferences.

Processor Ultra-Low Voltage Mobile Intel® III processor 800 MHz – M which 
supports enhanced Intel® SpeedStep technology; 512KB on-die L2 
cache; 133MHz system bus speed

Display 10.4” XGA TFT, indoor viewable
Digitizer Electromagnetic (Active)
Memory 256 MB on board, one DIMM slot available; maximum memory to 768 MB  

(512MB x 1)
Hard Drive 20 GB Ultra DMA 100, shock-mounted hard disk drive
Video Controller Integrated Intel Direct AGP Graphics with up to 48MB Dynamic Video 

Memory Technology
Operational  
Temperature

Operating Temperature (with power management):  
41° to 95°F (5° to 35°C)

Humidity Operating: 20% to 85% (non-condensing);  
Non-operating: 8% to 85% (non-condensing)

Storage Temperature 5° to 140°F (-15° to 60°C) 
Communications Multinational1 56K2 V.90 modem, 10/100 Base-TX Ethernet, and optional 

wireless LAN (802.11b)
Ports Two USB 1.1, Infrared port (IrDA 1.1-compatible, 4 Mbps),  

external monitor, modem (RJ-11), Ethernet (RJ-45), IEEE 1394, and 
system interface connector

PC Card Slot One Type I or Type II slot; 32-bit PC CardBus architecture

Battery4 Lithium ion; 6-cell 10.8V, 4000mAh; Up to 4.5 hours using main battery

Power AC Adapter -- Auto-sensing dual voltage support, 100-240V AC;  
DC 16V, 3.75A

Dimensions 11.86"(h) x 8.66"(w) x .82-.88"(d)
Weight Approximately 3.2 lbs
Operating System Microsoft® Windows® XP Tablet PC Edition
Agency Approval Emissions: EN55022 (CISPR22) Class B; FCC 15, Class B; FCC15C, 

15.247; EN 300-328; ICES-003; Canada RSS-210 
Immunity: EN55024 (1998); EN 301-489-17 V.1.1.1 (2000-9) 
Safety: UL and cUL Listed, UL 1950, 3rd edition; TuV T-Mark, EN60950 
Telecom: FCC Part 68; IC CS-03

Warranty Fujitsu one-year or three-year International Limited Warranty3
 ;  

24/7 technical support

Table 19.1: DCU specifications
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20. Appendix D Connectivity/Connector Function

 20.1. Network Connectors
The following network connectors are on the rear panel of the camera or controller:

• One ruggedized RJ-45 connector for 100/1000Base-T communications. 

• One standard RJ-45 connector for 100Base-TX communication with the DCU for 
image display during focus and set up of the camera. This connector is not high-G 
rated and is not intended for use during high-G events.

• Pinouts of all RJ-45 network connectors are standard Ethernet according to IEEE  
and EIA/TIA.

 20.2. HG-TH Controller Composite Video Output BNC
The HG-TH Camera Controller connects to a NTSC/PAL monitor to output composite 
video in Live mode or Playback mode.

 Figure 20.1: HG-TH Controller composite video out BNC
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 20.3. Configurable Input Connector (Sync In)
This LEMO connector is software configurable. Select one of the following options: 

• External Frame Sync Input – synchronizes frame timing with an external clock. 
Frame rates less than 1 Hz may compromise Image quality.

• ROC (Record on Command) – the camera saves images into memory for the interval 
that the configurable input is held true and idles when configurable input in untrue – in 
other words separate and distinct sequences of images can be saved until the 
memory is full.

• BROC (Burst Record on Command) – each time the configurable input becomes true, 
the camera will save a predefined number (burst) of frames to memory, until the 
memory is full. 

• Ready/Record – is a hardwired record button. The camera will record when the 
configurable input goes true. When the camera is in the Ready mode, the camera is 
recording pre-trigger frames into the buffer and is waiting for a trigger. 

NOTE:  This is a TTL compatible input (0-5VDC). Always check the voltage 
on the trigger line before connecting to the camera. Signal levels above 5 
volts at the Sync in and Trigger in TTL inputs can cause permanent 
damage to the system.

 Figure 20.2: HG-100K/LE/XR/XL configurable input (Sync In) LEMO connector

 Figure 20.3: HG-TH Controller configurable input (Sync In) LEMO connector
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 20.4. Trigger Input Connector
Using a LEMO connector, the Trigger Input has a programmable polarity. The trigger may 
be a positive-going pulse, a negative-going pulse or a switch closure. Threshold voltage 
for positive going system is 2.4 VDC. The threshold for a negative going system is  
below 0.8 VDC.

NOTE:  This is a TTL compatible input (0-5 VDC). Always check the voltage 
on the trigger line before connecting to the camera. Signal levels above 5 
volts at the Sync in and Trigger in TTL inputs can cause permanent 
damage to the system.

 Figure 20.4: HG-100K/LE trigger-input LEMO connector

 Figure 20.5: HG-XR/XL and HG-TH Controller trigger-input LEMO connector
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 20.5. Strobe Output Connector
The Strobe Output generates pulses that synchronize the timing of a strobe (or other 
peripheral device) with the camera’s exposure. It may be either a positive-going pulse, or 
a negative-going pulse. The pulse can be set with precision to occur any time from 100µs 
before the beginning of exposure up to 5µs before the end of exposure.

 Figure 20.6: HG-100K/LE/XR/XL strobe out BNC connector

 Figure 20.7: HG-TH and HG-CH strobe out LEMO connector 
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21. Appendix E Image File Formats

The HG-100K/LE/XR/XL/TH/CH is capable of outputting three image file types:  
TIFF, JPEG, and Type-2. The TIFF file format is uncompressed, while the JPEG file 
format uses standard JPEG compression. Both TIFF and JPEG file format include the 
common border data in the image file header, as defined in the following table. 

Type-2 files use the RAW image file data appended with the common border data,  
which is located at the end of the file data as defined in the following table. 

The following Common Border Data Format definition employs a language-independent 
offset / size / type / content description format. All numeric multi-byte fields are in  
network byte order (big-endian).

Name Offset Size Type Description

Common.FileSignature 0 8 char[8] “HG-100K” + trailing NULL
Common.VideoType 8 1 enum Color = 1, Mono = 2, Unknown = 0
Common.SessionID 9 1 uint8 0 thru 255
Common.CameraID 10 1 uint8 0 thru 255 (default = 1)
Common.RecordRate 11 1 enum 0 = Unknown, 1 = 30 fps, 2 = 60 fps,  

3 = 125 fps, 4 = 250 fps, 5 = 500 fps,  
6 = 1 K fps, 7 = 2 K fps, 8 = 3 K fps,  
9 = 5 K fps, 10 = 10 K fps, 11 = 50 K fps,  
12 = 100 K fps

RESERVED 12 1 N/A RESERVED
Common.RecordMode 13 1 enum 0 = Record, 1 = Stop, 2 = Trigger,  

3 = Trigger2
Common.WhiteBalance 14 1 enum 0 = Daylight, 1 = Tungsten, 2 = HMI,  

3 = User, 4 = Unity (all ones)
Common.LightSource 15 1 enum 0 = Daylight, 1 = Tungsten, 2 = HMI,  

3 = User, 4 = Unity
Common.McdlPresent 16 1 enum 0 = Absent, 1 = Present
Common.IrigPresent 17 1 enum 0 = Absent, 1 = Present
Common.WhiteBalanceCoefs.Red 18 4 float IEEE-768, in network byte order
Common.WhiteBalanceCoefs.Green 22 4 float IEEE-768, in network byte order
Common.WhiteBalanceCoefs.Blue 26 4 float IEEE-768, in network byte order
Common.FrameNumber 30 2 int16 Signed, relative to trigger frame  

(16-bit version of Hg100k.FrameNumber)
Common.IsTriggerFrame 32 1 enum 0 = NOT trigger frame, 1 = IS trigger frame
Common.RealTimeDate.Seconds 33 1 BCD Upper nibble is 10s, lower is 1s
Common.RealTimeDate.Minutes 34 1 BCD Upper nibble is 10s, lower is 1s
Common.RealTimeDate.Hours 35 1 BCD Upper nibble is 10s, lower is 1s
Common.RealTimeDate.Day 36 1 BCD Upper nibble is 10s, lower is 1s
Common.RealTimeDate.Month 37 1 BCD Upper nibble is 10s, lower is 1s
Common.RealTimeDate.Year 38 1 BCD Upper nibble is 10s, lower is 1s
Common.IrigTime.Day100s 39 1 uint8 0 thru 3
Common.IrigTime.Day10s 40 1 uint8 0 thru 9
Common.IrigTime.Day1s 41 1 uint8 0 thru 9 (0 thru 366 with above)
Common.IrigTime.Hour10s 42 1 uint8 0 thru 2
Common.IrigTime.Hour1s 43 1 uint8 0 thru 9 (0 thru 59 with above)
Common.IrigTime.Minute10s 44 1 uint8 0 thru 5
Common.IrigTime.Minute1s 45 1 uint8 0 thru 9 (0 thru 59 with above)
Common.IrigTime.Second10s 46 1 uint8 0 thru 5
Common.IrigTime.Second1s 47 1 uint8 0 thru 9 (0 thru 59 with above)

Table 21.1: Common border data format 
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Common.IrigTime.Microseconds 48 4 uint32 0 thru 999,999
Common.ElapsedTime.Minutes 52 2 int16 Signed, relative to trigger time.
Common.ElapsedTime.Microseconds 54 4 int32 Signed, relative to trigger time.
Common.MdclData 58 60 uint16[30] UNUSED
RESERVED 118 1 N/A RESERVED
Common.Exposure 119 4 uint32 23 thru 33330 μs
Hg100k.InterfaceZone 123 4 uint32 Always zero
Hg100k.BorderDataFormat 127 1 enum 0 = HG/CR/TX, 100 = HG-100K
Hg100k.CameraName 128 51 char[51] A null-terminated ASCII text string
Hg100k.SessionName 179 51 char[51] A null-terminated ASCII text string
Hg100k.FirstPixelType 230 1 enum 0 = Red, 1 = Blue,  

2 = Green on a Red Row,  
3 = Green on a Blue Row

Hg100k.SerialNumber 231 4 uint32 Must match camera label
Hg100k.SensorActiveArea.x 235 2 uint16 32 thru 1504 by steps of 32
Hg100k.SensorActiveArea.y 237 2 uint16 8 thru 1128 by steps of 8
Hg100k.PipelineState 239 4 uint32

(bit vector)
Root Hub Absent = 0x00008000
All other bits are RESERVED, and may have 
arbitrary values.

Hg100k.EdgeEnhancement 243 1 enum 0 = None, 1 = 0.5, 2 = 1.0, 3 = 1.5, 4 = 2.0
Hg100k.ColorCorrectionMatrix.R0C0 244 4 Radix16 16.16 fixed point ( / 65536.0)
Hg100k.ColorCorrectionMatrix.R0C1 248 4 Radix16 16.16 fixed point ( / 65536.0)
Hg100k.ColorCorrectionMatrix.R0C2 252 4 Radix16 16.16 fixed point ( / 65536.0)
Hg100k.ColorCorrectionMatrix.R1C0 256 4 Radix16 16.16 fixed point ( / 65536.0)
Hg100k.ColorCorrectionMatrix.R1C1 260 4 Radix16 16.16 fixed point ( / 65536.0)
Hg100k.ColorCorrectionMatrix.R1C2 264 4 Radix16 16.16 fixed point ( / 65536.0)
Hg100k.ColorCorrectionMatrix.R2C0 268 4 Radix16 16.16 fixed point ( / 65536.0)
Hg100k.ColorCorrectionMatrix.R2C1 272 4 Radix16 16.16 fixed point ( / 65536.0)
Hg100k.ColorCorrectionMatrix.R2C2 276 4 Radix16 16.16 fixed point ( / 65536.0)
Hg100k.FrameNumber 280 4 int32 -1,864,134 thru 1,864,134 (approx.)
Hg100k.TimeSincePriorFrame 284 4 uint32 Microseconds
Hg100k.FrameFormat 288 1 enum 0 = RGB, 1 = Type-2, 2 = JPEG
Hg100k.ImageSize.x 289 2 uint16 Post crop/decimate
Hg100k.ImageSize.y 291 2 uint16 Post crop/decimate
Hg100k.MaxPixelValue 293 2 uint16 Always 255
Hg100k.BlackOffset 295 2 uint16 Always 0
Hg100k.PixelEncoding 297 1 enum 0 = 2nd order, 1 = linear
Hg100k.Gamma 298 1 fp8 4.4 fixed point (divide by 16.0)
Hg100k.JPEGRestartInterval 299 2 uint16 See PM-36 Data Sheet
Hg100k.JPEGQualityFactor 301 2 uint16 See PM-36 Data Sheet
Hg100k.ExpandPixels 303 512 uint16[256] 8-to-16-bit LUT, reverses PixelEncoding to 

generate 16-bit linear pixels. N/A for JPEG, 
use three times for RGB.

Hg100k.ExtendedFrameRate 815 4 uint32 Frame Rate, in frames per second.
Hg100k.AncillaryData 819 32 uint8[32] User-supplied data. Image slider location 

data.
Hg100k.CameraOrientation 851 2 uint16 User-supplied data. 

0000 = upright
005A = right side
00B4 = upside down
010E = left side 

Hg100k.TimeZeroReference 853 1 uiint8 01=Timestamps referenced to Trigger time.
02=Timestamps referenced to Frame Zero 
start of exposure.

Name Offset Size Type Description

Table 21.1: Common border data format (Continued)
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Hg100k.TimestampOffset 854 4 int32 Signed offset added to a frame’s  
timestamp.

Hg100k.TriggerDebounceTime 858 4 uint32 Trigger debounce delay.
RESERVED AREA 862 158 uint8[158] Always zero
EndOfBorderData 1020 4 char[4] 4 ASCII chars = “EoBD”  

(End of Border Data) = 0x456F4244 integer

Name Offset Size Type Description

Table 21.1: Common border data format (Continued)
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22. Appendix F Maintenance & Warranty

 22.1. Maintenance
Use dust free compressed air to clean the lens. Clean the exterior of the camera with a 
soft, dry, lint-free cloth. For stubborn dirt, dampen the cloth with a mild soap solution. The 
battery module is the only user replaceable part inside the camera (see Section 22.1.1.). 
Contact your  technical support representative for all other maintenance issues (see 
Contact Information on page 1).

 22.1.1.  Battery Module
The HG-100K, HG-LE, HG-XR, HG-XL, and the HG-TH Controller each contain a battery 
module to maintain data in memory during brief power interruptions.       

To replace the battery module:

• Obtain a replacement battery module for the specific camera model

• Ensure camera memory is clear, and camera system is completely powered off

• Locate the battery module (see the figures below)

• Remove four screws from the HG-XR/XL/TH or two screws from the HG-100K/LE

• Lift the battery module up out of the HG-XR/XL or sideways out of the HG-110K/LE/TH

• Align the pin connectors of the replacement battery module, and press firmly into place

• Reinstall the screws and hand-tighten (do not torque or use thread locking compound)

 Figure 22.1:  HG-100K Battery Module Location

WARNING:  Battery module contains small amounts of harmful substances. 
Handle with caution to prevent injury to either personnel or equipment.  
To prevent explosion, do not expose to fire or water, short-circuit or 
disassemble. Replace with a Redlake replacement battery module only.  
Do not discard in trash that is disposed of in landfills. When disposing of 
depleted batteries, comply with local ordinances or regulations and your 
company’s safety standards.

Battery Module
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 Figure 22.2:  HG-LE Battery Module Location

 Figure 22.3:  HG-XR/XL Battery Module Location

 Figure 22.4:  HG-TH Controller Battery Module Location

Battery Module

Battery Module

Battery Module
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 22.2. Warranty
For a period of one (1) year from the date of shipment, Redlake, Inc. (hereafter referred to 
as Redlake), warrants that the MotionXtra camera system, and accessories manufactured 
by Redlake (collectively the “Product”) are in conformity with published specifications and 
that such items are of good material and workmanship. If any item is defective in material 
or workmanship or otherwise fails to meet the specifications, or fails to function properly, 
the Purchaser shall have the right to return such defective or nonconforming products to 
Redlake for correction or replacement.

Redlake agrees to repair or replace, at Redlake’s discretion, without charge, any item that 
is returned to Redlake for inspection, provided such inspection discloses to the 
satisfaction of Redlake that the defects are as specified and conform to the provisions of 
the New Product Warranty. Redlake shall have no obligation under this New Product 
Warranty to provide local repair or replacement services for the Product, but will, at 
Redlake’s sole discretion, provide repair or replacement services at its own factory or a 
designated service facility. Products shall not be returned to the Redlake factory or a 
designated service facility for inspection, replacement, or repair without specific written 
authorization from Redlake. Redlake will grant such authorization with the issuance of a 
Return Material Authorization (RMA) number provided that the Purchaser shall have 
notified Redlake of any defect or nonconformance within thirty (30) days after Redlake’s 
shipment of the Product.

THIS WARRANTY DOES NOT APPLY TO THE FOLLOWING CONDITIONS:

Damage caused by a failure to operate the Product in accordance with Redlake’s written 
instructions as provided in the Redlake user’s manual, including but not limited to, 
environmental specifications, evidence of Product being subjected to accidental damage, 
misuse, abuse, or tampering including the removal, alteration or defacing of Product 
identification markings. Refer to the Precautions and Hardware Setup sections of this 
manual for information regarding environmental specifications and proper setup.

Damage resulting from the unauthorized attempt to repair or modify the Product by non-
Redlake personnel; Damage caused during shipment.

This warranty and Redlake’s obligation hereunder are in lieu of all other warranties and 
Redlake makes no other warranties, express or implied, including, but not limited to, 
warranties of fitness, non-infringement, or merchantability. Under no circumstances shall 
Redlake be liable for special or consequential damages, including, but not limited to, any 
claimed loss of profits. Redlake’s liability shall be exclusively limited to the repair or 
replacement of any defective or nonconforming Product and the Purchaser expressly 
waives any other remedy or measure of damage, statutory or otherwise.
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23. Appendix G Formulas

 23.1. Definitions

 23.2. Session Length 
The number of frames that will fit into capture memory (i.e. the maximum session length) 
is given by the following equations.

Session length equation for all models:     

HG-100K with 2 GB of memory:     

HG-100K with 4 GB of memory:     

HG-LE with 1 GB of memory:     

INT Integer function: round down to nearest integer (i.e., truncate fractional part).
Width Sensor active area width, in pixels. Width must always be an integral multiple of 32, 

greater than or equal to 32.
Height Sensor active area height in pixels. Height must always be an integral multiple of 8, 

greater than or equal to 16.
SessionLength Number of frames that the camera can hold in its image memory.
Rate Maximum record frame rate allowed by camera, expressed in frames per second.
FPS Frames Per Second
ExposureSetting The nominal exposure, in microseconds, set in the camera (e.g. via the 

“Set Exposure” command).
ExposureTime Actual light integration time for the camera’s CMOS sensor, in microseconds.
ExposureStartDelay The time, in microseconds, between an active edge on Sync In and camera shutter open.
StrobeDelaySetting The nominal strobe delay, in microseconds, set in the camera.
StrobeDelay Difference between the active edge at the camera’s strobe output and the actual start 

of integration time at the camera’s CMOS sensor, in nanoseconds.
TriggerDelaySetting The nominal Trigger Delay, in microseconds, set in the camera.
TriggerDelay Difference between the detection of an active Trigger input (camera or hub) and the 

recognition of the trigger event by cameras, in microseconds.

SessionLengthMIN 1=

SessionLengthMax 2 INT×
268 435 424, ,

Width Height×
4

---------------------------------------- 32+
----------------------------------------------------

⎝ ⎠
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Width Height×
4

---------------------------------------- 32+
----------------------------------------------------
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HG-LE with 2 GB of memory:     

HG-XR/XL with 4 GB of memory:     

HG-XR/XL with 8 GB of memory:      

HG-XR/XL with 16 GB of memory:     

HG-XR/XL with 32 GB of memory:    

HG-TH/CH with 4 GB of memory:     

HG-TH/CH with 8 GB of memory:     

Frame Rates
Running in Normal mode, the camera uses its internal frame rate generator. The internal 
frame rate generator supports a set of specific frame rates (60, 125, 250, etc.), as 
described in the HG-100K/LE/XR/TH Command Protocol document. The camera will only 
accept frame rate settings that do not exceed RateMax as given. For example, at 
1504 × 1128, RateMax is 1034.6 frames per second. The fastest rate available from the 
internal frame rate generator that does not exceed this value is 1000 frames per second.

When using the camera’s SYNC IN input, the camera is not limited to the specific frame 
rates generated by the internal frame rate generator. In this mode, the camera will run at 
any frame rate, provided RateMax is not exceeded. 
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Frame Rate Equation for all models:     

HG-100K/XR/XL:       

HG-LE:       

HG-TH/CH:          

Frame rate calculation is adapted from sensorFpga.c:sensorFpgaMinFsync(), its 
subroutines and various constants.

Rates lower than 30 fps may be applied at the camera’s SYNC IN input when the camera 
is running in External Sync mode. At frame rates lower than 30 fps, the picture quality may 
degrade.

Rates greater than RateMax may be applied at the camera’s SYNC IN input when the 
camera is running in External Sync mode. However, the camera will only recognize a 
request to start a new exposure (active edge on SYNC IN) after 1/RateMax seconds have 
passed since the start of the last exposure. That is, the camera will not expose frames at a 
rate greater than that allowed by the current sensor area (resolution) and exposure 
settings.

NOTE:  That the maximum frame rate is limited by both the sensor 
resolution and by the exposure setting, whichever is most restrictive.
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 23.2.1.  External Sync Exposure Timing
With the camera in External Sync mode, the user may configure the SYNC IN input to 
recognize either rising or falling edges as requests to begin an exposure. The camera will 
recognize a rising edge as the input level rises through the +1.2V to +2.1V range. The 
camera will recognize a falling edge as the input level falls through the +1.4V to +0.5V 
range. Long transition times on SYNC IN will introduce greater uncertainty in the precise 
time that the camera starts an exposure, as shown. To minimize the uncertainty in 
exposure timing, keep transitions times on SYNC IN short.

Each time the camera completes an exposure, it begins a readout process that moves 
captured image data from the sensor’s photodiodes to the camera’s image memory. The 
sensor’s pixels read out row by row. The sensor requires a brief pause between each row 
read out. The sensor’s shutter only opens during these pauses, or after the read out 
process for the previous frame has completed. This means that the camera may not be 
able to open the shutter precisely on the active edge of SYNC IN, or even with a 
consistent delay after the active edge. There is some variation in when the shutter will 
actually open, based on when the active edge arrives relative to the read out of the 
previous frame.

The minimum delay from SYNC IN to start of exposure (ExposureStartDelayMin) will 
occur when the sensor readout process has completed by the time the SYNC IN edge 
arrives at the camera. In this case, there is no additional delay required for the exposure 
process to synchronize with the sensor readout process.

External Sync Exposure:    

HG-100K
Exposure start delay is 128 or 129 30MHz clocks in the CIB FPGA. (1 or 2 clocks through 
two-stage synchronizer, 7 clocks of other logic, plus 120 clocks to implement the 4 
microsecond debounce delay. There is an additional 3 or 4 clocks (60MHz) delay in the 
Sensor FPGA. This gives a total of between 259 and 262 60MHz clock periods from the 
time the camera sees an edge on SYNC IN, and the time it de-asserts reset. The minimum 
259 clocks gives 4.31666… microseconds, minimum, for the delay.

 Figure 23.1:  External sync timing diagram

+1.2V
+2.4V

Rising Edge Falling Edge

+0.5V
+1.4V

timing window

ExposureStartDelayMin 0.0=

ExposureStartDelayMax 2.3 0.01667 Width
8

---------------⎝ ⎠
⎛ ⎞+=
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HG-LE/TH
Exposure start delay is 128 or 129 30MHz clocks in the CIB FPGA. (1 or 2 clocks through 
two-stage synchronizer, 7 clocks of other logic, plus 120 clocks to implement the 4 
microsecond debounce delay. There is an additional 3 or 4 clocks (60MHz) delay in the 
Sensor FPGA. This gives a total of between 259 and 262 60MHz clock periods from the 
time the camera sees an edge on SYNC IN, and the time it de-asserts reset. The minimum 
259 clocks gives 4.31666… microseconds, minimum, for the delay.

In order to recognize a valid exposure request, an input pulse on SYNC IN must be at 
least 4 micro seconds wide.

ExposureStartDelayMax 2.3 0.01667 Width
4

---------------⎝ ⎠
⎛ ⎞+=
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 23.3. Exposure Time
The actual time that the sensor’s shutter is open is longer than the nominal exposure time 
set through the camera’s command interface. In addition, for reasons similar to those 
described above for the variations in exposure start times, there is some variation in actual 
exposure times that depends on the arrival time of an exposure request relative to the 
sensor readout process.

 23.3.1.  For Exposure Settings of 5 or 6 microseconds

Exposure Settings of 5 or 6 microseconds:     

 23.3.2.  For Exposure Settings 7 microseconds and Longer

HG-100K
Exposure start delay is 128 or 129 30MHz clocks in the CIB FPGA. (1 or 2 clocks through 
two-stage synchronizer, 7 clocks of other logic, plus 120 clocks to implement the 4 
microsecond debounce delay. There is an additional 3 or 4 clocks (60MHz) delay in the 
Sensor FPGA. This gives a total of between 259 and 262 60MHz clock periods from the 
time the camera sees an edge on SYNC IN, and the time it de-asserts reset. The minimum 
259 clocks gives 4.31666… microseconds, minimum, for the delay.

HG-LE/TH

The shortest exposure occurs when the active edge of Frame Sync arrives just as a row 
readout is starting. In this case, the start of exposure is delayed for one complete row 
readout time (0.267+Width/8), and then delayed by the TsuSRS (1.7 microseconds). 
These delays are subtracted from the “normal” long exposure time. The net is an 
exposure that runs a couple of microseconds longer than the setting, instead of 4.2 
microseconds longer.    

ExposureTime ExposureSetting 0.1±=

ExposureTimeMin ExposureSetting 2.1 0.01667 Width
8

---------------⎝ ⎠
⎛ ⎞+⎝ ⎠

⎛ ⎞–=

ExposureTimeMin ExposureSetting 2.1 0.01667 Width
4

---------------⎝ ⎠
⎛ ⎞+⎝ ⎠

⎛ ⎞–=

ExposureTimeMax ExposureSetting 0.1+=
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 23.4. Strobe Output Timing (with internal frame rate 
generator)

When the Strobe Delay setting in the camera is less than or equal to zero, the Strobe 
output will lead the actual start of exposure. The minimum lead time is given by:     

The maximum lead-time is given by:

HG-100K with a Strobe Delay Setting of +0.10:     

HG-LE/TH with a Strobe Delay Setting of +0.10:     

HG-100K with a Strobe Delay Setting of -0.10:     

HG-LE/TH with a Strobe Delay Setting of -0.10:     

StrobeDelayMin StrobeDelaySetting–=
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 23.5. Hardware Trigger Delay Through Hubs
The camera will designate one frame in its image memory as Frame 0. Frames recorded 
after Frame 0 are numbered 1, 2, 3…. Those recorded prior to Frame 0 are numbered  
–1, –2, –3…. Frame 0 is the frame whose exposure started most recently at the time the 
camera recognized the Trigger event. That is, the time that the camera recognizes the 
Trigger event is always prior to the time Frame 1’s exposure started, but after (or at) the 
time Frame 0’s exposure started.

There is always a delay from the time the Trigger signal enters the system (at a Hub or 
camera TRIGGER input), until the cameras recognize the Trigger event. The minimum 
and maximum delays are expressed here in microseconds:

The variations between minimum and maximum trigger delays shown above apply from 
one recording to the next. For one recording, the variation in the trigger delay among 
cameras in a system is limited to ±1 microseconds.
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24. Appendix H Cable Specifications

 24.1. Camera Power Pigtail
The 2 m power pigtail cable carries power to the camera.

      

 Figure 24.1:  Cable specifications for the camera power pigtail

 24.2. HSU Power Cable
The HSU power cable carries power to the cameras.

     

 Figure 24.2:  Cable specifications for the HSU power cable

 24.3. STP Cable Lengths and Timing
The Sync/Trigger-Return/Power (STP) cables that connect cameras to hubs, and hub to 
hubs, carry the signals that cameras use to synchronize themselves to one another. 
Differences in total STP cable length between the root hub and various cameras will 
introduce small skews in the timing among cameras. 

The STP cables add about 6 ns per meter of propagation time to the trigger and 
synchronization signals. Therefore, in a five-hub, two-camera system, one camera could 
be connected with a short (5 m) STP cable, while the other could have a total of 500 m of 
cable in the path to the root hub, for a cable length difference of 496 m. The downstream 
camera’s timing would be skewed almost 3 µs behind the upstream camera. This skew 
would affect the frame synchronization between the two cameras. In addition, this delay 
will add to the Trigger Delay time, if the trigger signal applies to the downstream camera.

Pin Signal Name Color
B CAM_PWR_RET GREEN
C CAM_PWR ORANGE
D CAM_PWR RED
E CAM_PWR WHITE
F CAM_PWR_RET BLACK
N CAM_PWR_RET BLUE
P CAM_PWR YELLOW
S CAM_PWR_RET BROWN

Pin Signal Name Color
A CAM_PWR ORANGE
B CAM_PWR RED
G CAM_PWR WHITE
F CAM_PWR YELLOW
C CAM_PWR_RET GREEN
D CAM_PWR_RET BLUE
E CAM_PWR_RET BROWN
H CAM_PWR_RET BLACK

L
KMN

A
B

C
P U T

J
HSR

D
GFE
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 24.3.1.  STP Cable Pins and Signals
This cable carries synchronization and power from the HSU to the cameras, and returns 
trigger from the cameras to the HSU. Order it in lengths from 1 m to 100 m. The cable has 
a nominal outside diameter of 0.43 inches (10.92 mm). Cable pins and signals are as 
follows.

 24.4. Ethernet Communications Cable
Low-g Applications: Standard Ethernet Cable with RJ-45 connectors.

High-G Applications: Ethernet Cable with RJ-45 connectors with hardened shroud and 
threaded locking ring. 

HSU -side Camera -side
Pin Signal Name Pin Signal Name Wire Type/Size

G TRIG_RET- J TRIG_RET- 24AWG, Blue/White
H TRIG_RET+ K TRIG_RET+ 24AWG, Red/White
T SHIELD GND T SHIELD GND 24AWG, Red/White
J SYNC_OUT- G SYNC_IN- 24AWG, Blue
K SYNC_OUT+ H SYNC_IN-+ 24AWG, Red
T SHIELD GND T SHIELD GND 24AWG, Red
A PWR_RSTA A PWR_RSTA 20AWG, Jumper
L PWR_RSTB L RWR_RSTB 20AWG, Jumper
B CAM_PWR_RET B CAM_PWR_RET 20AWG, Single, Black
C CAM_PWR C CAM_PWR 20AWG, Single, Red
D CAM_PWR D CAM_PWR 20AWG, Single, Red
E CAM_PWR E CAM_PWR 20AWG, Single, Red
F CAM_PWR_RET F CAM_PWR_RET 20AWG, Single, Black
N CAM_PWR_RET N CAM_PWR_RET 20AWG, Single, Black
P CAM_PWR P CAM_PWR 20AWG, Single, Red
R CAM_PWR R CAM_PWR 20AWG, Single, Red
S CAM_PWR_RET S CAM_PWR_RET 20AWG, Single, Black
U CAM_PWR_RET U CAM_PWR_RET 20AWG, Single, Black
M NOT CONNECTED M NOT CONNECTED

Table 24.1: Pin and Signal Names
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 24.5. HG-TH Tethered Head & HG-CH Compact Head 
Cables

• Trigger/Sync In Cable, OB Series, LEMO, 3 m, FGG-08-302-CLCD31,  
Part Number:  30007084-001

• Sync/Strobe Out Cable, 00 Series, LEMO, 3 m, FGG-00-302-CLAD30,  
Part Number:  30007083-001

• 3 m Cable for clamp style Camera Controller, Part Number: 03100324-004

• 6 m Cable for clamp style Camera Controller, Part Number: 03100324-005

• 10 m Cable for clamp style Camera Controller, Part Number: 03100324-006 

• 3 m Cable Assy, straight ends, tethered, Part Number:  30007082-004

• 6 m Cable Assy, straight ends, tethered, Part Number:  30007082-005

• 10 m Cable Assy, straight ends, tethered, Part Number:  30007082-006

• SDR Cable, left, Part Number:  30003401-001

• SDR Cable, right, Part Number:  30003402-001

• Connector; cbl, 2-pin male, solder, lemo plug, Part Number:  03100325-001

• Connector; cbl, 2-pin male, crimp, lemo plug, Part Number:  03100326-001
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25. Appendix I Troubleshooting

 25.1. About Box
The Help menu command opens an About dialog box containing revision, copyright and 
system information for the program. If you need to contact a field services technician 
regarding your system, your technician may ask you to provide this information in a text 
file to assist in troubleshooting your system.

 25.1.1.  Insert System Information
1. Click in the box labeled “Click here to gather system information.” 

2. MotionCentral will write the host PC information into the box. 

3. Copy this information to the Microsoft® Windows® clipboard and transfer it into a 
text file for reference. 

 25.2. Side Effect Alerts
There are dependencies among camera parameters where setting one parameter may 
affect another. For example, selecting a resolution of 1504 x 1128 requires that the 
camera has a frame rate of 1000 fps or less. If the operator selects a frame rate of 2000 
fps, and the resolution is set to 1504 x 1128 then the system will generate a message 
warning the user that setting this resolution will cause the Side Effect of reducing the 
frame rate.     

 Figure 25.1: About box
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Similarly, if the user specifies a frame rate too great for the currently specified exposure 
setting, the program displays an alert box. When this box displays, cancel the frame rate 
change, or accept it and the exposure will decrease to the largest value acceptable for the 
frame rate.

The resolution setting also affects the Session Length. If the user specifies a resolution 
too large for the currently specified Session Length, the program displays an alert 
indicating that the session length will be affected. Cancel the resolution change or accept 
it and the session length setting will decrease to a value compatible with the session 
length.

Session Length affects the position of the trigger among the saved frames. If the current 
trigger position would no longer be compatible with the pre- and post-trigger settings, the 
program displays an alert that the trigger position settings will be affected. Cancel the 
Session Length change or accept it, in which case the trigger position setting will change 
to an acceptable value.        
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26. Glossary

A 

Acid etching - Technique that uniformly thins CCDs to approximately 10 µm so that an 
image can be focused on the backside of the parallel register where there is no gate 
structure.

A/D - Acronym for Analog-to-Digital converter; electronic device that converts data from 
an analog domain to a digital representation. 

Adapter - In a camera, the device that allows the camera to be attached to a variety of 
scientific instruments or lenses. Also called mount adapter, lens mount adapter. See also 
C-mount, F-mount.

AGC - Automatic gain control.

AIA - Automated Imaging Association.

Aliasing - A pattern of image sampling error in digital systems. Aliasing forces spatial 
frequency components higher than a critical value (the Nyquist frequency) to be displayed 
at progressively lower frequencies. Aliasing introduces an undesirable moiré pattern when 
the spatial frequency of the signal exceeds the sampling rate in a digitizer.

Analog- An information representation scheme with continuous amplitudes. Contrasts 
with digital, where information is quantized into discrete steps.

Aperture - In an optical instrument, the opening of a lens or aperture stop.

Arc lamps - An electric lamp that produces light by an arc made when a current passes 
between two incandescent electrodes surrounded by gas. Also called arc light.

Array processor - A specialized digital signal-processing unit capable of handling large-
scale arrays (matrices) of computation (such as those encountered in fast Fourier 
transforms, matrix inversions, and so forth) used in some image-processing tasks.

ASCII (American Standard Code for Information Interchange) - An 8-bit code  
(7 bits plus 1 parity bit) commonly used to designate alphanumeric and other characters 
and symbols for computers.

Aspect Ratio - The ratio of width to height for the frame of the televised picture. 4:3 for 
standard systems, 5:4 for 1K x 1K, and 16:9 for HDTV. 

Asynchronous - Digital operations triggered by external, untimed events and not by a 
fixed frequency clock. Signals which clock independently from each other. 

Automatic Gain Control (AGC) - A circuit by which electronic gain is automatically 
adjusted as a function of input intensity or other specified parameter, in order to retain the 
output at constant level. 

B
Backside-illuminated CCDs - CCDs that have been uniformly reduced to a thickness of 
approximately 10 µm so that an image can be focused on the backside of its parallel 
register (where there is no gate structure). Thinned CCDs exhibit a high sensitivity to 
photons ranging from the soft x-ray to the near-infrared regions of the spectrum.

Back Porch - That portion of the composite picture signal which lies between the trailing 
edge of the horizontal sync pulse and the trailing edge of the corresponding blanking 
pulse. 

Bandwidth - The difference between the upper and lower limit of a frequency band 
expressed in number of cycles per second (hertz).

Baud rate - The number of bits per second at which a digital signal is transmitted from one 
digital computer to another, for example, over a telephone line.

Beamsplitter - A device for dividing a light beam into two or more separate beams. 
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Binned readout - Within a CCD, the process of moving charge that has been binned to 
an output amplifier for conversion to an image. Contrasts with CCD readout and subarray 
readout. See binning, output amplifier.

Binning - In CCD imaging technology, the technique of combining the charge from 
adjacent pixels so that the total charge can be read out as an image. See parallel binning, 
serial binning.

Binning factor - The number of pixels to be combined on the CCD during binning.  
A binning factor of 2x2 means that pixels in two rows and two columns (a total of four 
pixels) are combined for readout. See also parallel binning factor, serial binning factor.

Bit - A contraction of binary digit, the smallest unit of information in a notation using the 
binary system (1 or 0). A byte is commonly made up of 8 bits.

Bit depth - The number of bits that are digitized by the A/D converter.

Blooming - The defocusing of regions of the picture where the brightness is at an 
excessive level, due to enlargement of spot size and halation of the fluorescent screen of 
the cathode-ray picture tube. In a camera, sensor element saturation and excess which 
causes widening of the spatial representation of a spot light source. 

BNC connector - A coaxial type of connector used to couple coaxial cables to video and 
other high-frequency electronic equipment.

Bulb mode - Type of exposure wherein a trigger signal from an external source controls 
the start and end of the exposure.

Bus - A parallel set of wires in a computer over which control and data are exchanged 
between the various devices (terminal, CPU, memory, ALU, and so forth) connected to the 
bus. The bus can be standardized following IEEE recommended standards or may be a 
special bus (such as a video bus) that allows rapid interchange of specific information.  
A system-level bus will generally contain four component buses: the data bus, address 
bus, control or status bus, and power bus. The bus provides great flexibility to a computer, 
permitting different (internal and peripheral) devices to be plugged in, actuated, and 
signals to be exchanged.

C
Candela (cd) - The luminous intensity emitted by a standard source of light. One candela 
emits one lumen per steradian.

CCD - Charge-coupled device.

CCTV - Closed-circuit television

cd - Abbreviation for candela.

Charge - In CCD cameras, a measure of the number of electrons confined by a pixel.

Charge smearing - Residual charge left behind in potential wells when an image is 
shifted within a CCD.

Charge transfer - (1) In CCD image technology, the ability of the CCD to transfer the 
charge in each individual pixel onto the next pixel without any loss in the charge during the 
transfer. Scientific-grade CCDs typically have a CTE of 99.9998%, where 100% is perfect. 
(2) Process by which the electrons in a given potential well are moved into an adjacent 
well. Also called charge-transfer efficiency (CTE).

Charge-coupled device (CCD) - A light-sensitive imaging silicon chip used in cameras.

Chip - A very small piece of silicon processed or burned to form an integrated circuit. 
Short for integrated-circuit chip. See integrated circuit.

Chroma - That quality of color which embraces both hue and saturation. White, black, and 
grays have no chroma. 

Chroma Control - A control of color television receiver that regulates the saturation 
(vividness) of colors in a color picture. 
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Chroma Detector - Detects the absence of chrominance information in a color encoder 
input. The chroma detector automatically deletes the color burst from the color encoder 
output when the absence of chrominance is detected. 

Chromatic Aberration - An optical defect of a lens which causes different colors or wave 
lengths of light to be focused at different distances from the lens. It is seen as color fringes 
or halos along edges and around every point in the image. 

Chromaticity - The color quality of light which is defined by the wavelength (hue) and 
saturation. Chromaticity defines all the qualities of color except its brightness. 

Chrominance - A color term defining the hue and saturation of a color. Does not refer to 
brightness. 

Chrominance Signal - That portion of the NTSC color television signal which contains the 
color information. 

C-mount - Standard screw-in lens mount found on many scientific instruments, including 
most CCTV video cameras. The thread of the lens and lens mount is 1 inch in diameter 
with 32 threads/inch and with a back focal length of 17.52 mm.

CMOS (Complementary Metal Oxide Semiconductor) - A high-volume, low cost 
process of chip manufacturing. Photon collection, timing, control and signal processing 
are combined on the chip.

Coaxial cable - An electrical cable with a central conductor surrounded by a low-loss 
insulating sleeve and insulated ground shield. A coaxial cable is capable of passing very 
high-frequency electronic signals with low signal loss and noise pickup.

Color Burst - That portion of the composite color signal, comprising a few cycles of a sine 
wave of chrominance subcarrier frequency, which is used to establish a reference for 
demodulating the chrominance signal. Normally approximately 9 cycles of 3.579545 MHz. 

Color Edging - Extraneous colors appearing at the edges of colored objects, and differing 
from the true colors in the object. 

Color Encoder - A device which produces an NTSC color signal from separate R, G, and 
B video inputs. 

Color Fringing - Spurious colors introduced into the picture by the change in position of 
the televised object from field to field. 

Color Purity - The degree to which a color is free of white or any other color. In reference 
to the operation of a tri-color picture tube it refers to the production of pure red, green or 
blue illumination of the phosphor dot face plate. 

Color Saturation - The degree to which a color is free of white light. 

Color Sync Signal - A signal used to establish and to maintain the same color 
relationships that are transmitted. 

Color Transmission - The transmission of a signal which represents both the brightness 
values and the color values in a picture. 

Compatibility - The ability of one piece of equipment to interface and function with another.

Composite Video Signal - The combined picture signal, including vertical and horizontal 
blanking and synchronizing signals. 

Contrast - A measure of the gradation in luminance that provides gray-scale (or color) 
information. Contrast is expressed as the ratio (difference in luminance)/(average luminance) 
in adjoining areas of the scene. Under optimum conditions, the human eye can just detect 
the presence of 2% contrast.

Contrast enhancement/stretching - In digital image processing, the enhancement of 
contrast by using an image histogram and lookup table. Can also be achieved with analog 
devices.

Contrast range - The range of gray between the lightest and darkest parts of an image; 
expressed as a ratio of light to dark. See also dynamic range.
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Cooled CCD - A CCD image pickup device that operates at temperatures below ambient 
to reduce or eliminate dark current. Cooling is usually done with Peltier coolers or cooled 
liquid gases.

Counts - See digital number.

D
D/A converter - A circuit used at the output of a digital computer or processor to provide 
analog signals of power. A DAC is sometimes used to drive a standard video monitor.

Dark current - (1) In the absence of light, charge accumulated in a well. (2) The 
background current that flows in a photodetector such as an image intensifier, VIDICON, 
or CCD. Usually it can be eliminated, when required, by cooling the photodetector's 
primary image pickup surface such as the photoconductor or photocathode. Also called 
thermally generated charge.

Dark noise - Dark current and any other noise accumulated in the absence of light.  
Also called dark current noise.

Definition - The degree of detail or sharpness in a displayed image.

Depth of field - The distance between the closest and farthest objects in focus within a 
scene as viewed by a lens at a particular focus and with given settings. The depth of field 
varies with the focal length of the lens and its f-stop setting or NA (numerical aperture) and 
the wavelength of light.

Depth of focus - The range of distances between a lens and image plane (target in the 
pickup device) for which the image formed by the lens at a given setting is clearly focused.

Digital number (DN) - A number representing the CCD output. Also called counts.

Digital signal - A signal whose units are represented by either one of only two states: on 
or off, yes or no, 1 or 0. Since no gradations in between are permitted, digital signals are 
precise, unambiguous, and quite immune to noise. See also analog.

Digital-to-analog converter - See D/A converter.

Digitize - To convert (as data or an image) to digital form.

Digital Number (DN) - The gray level output from a digital camera (0-255 for an 8-bit 
system or 0-4095 for a 12-bit system).

Dynamic range - The ratio of the maximum to minimum signal levels that introduce no 
more than acceptable levels of signal amplitude distortions.

E
Electronic camera - A camera that produces an electronically scanned image or series of 
images. Both tube and CCD cameras are electronic cameras, as opposed to a camera 
whose output is film.

Exposure - The total radiant energy incident on a surface per unit area. It is the product of 
integration time and the radiant flux density. 

Exposure time - Length of time the CCD is accumulating charge; in CAMTEST™, a 
software setting that determines the length of time the CCD is accumulating charge but 
does not include the time the shutter is opening or closing. In CCD camera technology, 
the length of time for a full parallel shift sequence to occur.

EXSYNC - The synchronization control signal to a camera. The variable frequency signal 
EXSYNC triggers line or frame transfer from the sensor to the readout registers and so 
controls output line or frame rate of the camera. 

F
Faceplate - The window that the input or output radiation passes through on a camera 
tube, monitor picture tube, and solid-state array. Sometimes used to support a target or 
phosphor.

Fiberoptics - Thin transparent fibers of glass or plastic that are enclosed by material of a 
lower index of refraction and that transmit light throughout their length by internal 
reflections. Also, a bundle of such fibers used in an instrument.
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Field of View - The total area of object space imaged at the focal plane of a camera. 

Fill factor - As relates to the light gathering area of a sensor such as a CCD. For example, 
10% of a pixel's area may be used to conduct the charge out of the pixels there, making 
this area insensitive to light. Therefore, in this example, the CCD sensor would only have 
a 90% fill factor.

Fixed Pattern Noise (FPN) - Pixel to pixel output nonuniformity measured under dark 
conditions. 

Flat Field Correction - Flat Field correction involves subtracting the image information 
from an empty field of view from that of the same field of view with the sample added. This 
process subtracts all background image information associated with such things as 
uneven lighting sources, lens dust etc. 

F-mount - Standard lens mount found on many scientific instruments. The thread of the 
lens and lens mount is 2.5 mm in diameter with a back focal length of 46.5 mm.

Focal Length - The distance from a lensf principal point to the corresponding focal point.  
Also referred to as the equivalent focal length and the effective focal length; e.g. a 50mm 
lens.

Focal Plane - A plane orthogonal to the optical axis of a lens at which the CCD array 
resides. 

Focus - The point or plane in which light rays form a minimum-sized spot that has the 
proper intensity distribution. Also the act of bringing light to a fine spot.

Footcandle (ft) - A measurement of illuminance, or illumination expressed in lumens per 
square foot. It is the amount of illumination from 1 international candle (the candela) falling 
on a 1-ft. surface at a distance of 1 foot. In SI units, 1 fc = 10.764 lux (1x). See Burle 
Electro-Optics Handbook.

FPS - Frames per second.

Frame - A two-dimensional array of pixels or pixel information or a complete read-out of all 
pixels from a camera.

Frame buffer - In a digital image processor, the hardware in which the frame memory 
resides. The frame memory is a RAM that stores a full frame of the video image signal.

Framegrabber - Adevice which interfaces between a camera and computer. 

Frame Rate or Read Out Rate - The speed at which images are captured by an imaging 
system is called the frame rate and is expressed as number of frames per second EFPS. 
Higher frame rates are far better for easier focusing and sample positioning and general 
ease of use. Live action on a television is typically 28FPS, which prevents stuttering on the 
image. 

Frame transfer - See frame-transfer CCD camera.

Frame-transfer CCD camera - A type of CCD camera used for quantitive electronic 
imaging. The frame-transfer CCD camera divides the parallel register into two areas 
(arrays): image array (for image collection) and storage array (for image storage). After 
the image array is exposed to light, the electronic image is shifted to the storage array and 
readout. A frame-transfer CCD camera can operate without a shutter, running 
continuously and at a high rate. Contrasts with full-frame-transfer CCD camera and 
interline-transfer CCD camera.

Frequency - The number of times per second a repetitive signal undergoes a full cycle of 
vibration. Frequency units are hertz (Hz). For spatial frequency, the number of cycles of 
image brightness variation along a scan direction, generally expressed in lines per 
millimeter or line pairs per millimeter.

Front Porch - The portion of a composite picture signal which lies between the leading 
edge of the horizontal blanking pulse and the leading edge of the corresponding sync 
pulse. 

f/Stop - Also called F Number and F System. Refers to the speed or ability of a lens to 
pass light. It is calculated by dividing the focal length of the lens by its diameter. 
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f/Stop Ratio - This number is the ratio that describes the focal distance, as determined by 
the diameter of the lens aperture. So the greater the aperture the lower the f-stop value; 
the more light strikes the sensor, the greater the sensitivity. Zoom capability is sacrificed 
with very low f-stops. 

Full-frame - See full-frame CCD camera.

Full-frame CCD camera - The simplest type of CCD camera. The full-frame camera uses 
the entire parallel register to expose photons and to integrate and transport charge. It uses 
a shutter to control the exposure and to block light during readout, preventing charge 
smearing. Contrasts with frame-transfer CCD camera and interline-transfer CCD camera.

Full-well capacity - Number of electrons that can be held in one potential well.

G
Gain - In digital cameras, system gain defines the relationship between the number of 
electrons acquired on the CCD and the analog-digital units (ADUs) generated.

Gamma - A numerical value, or the degree of contrast in a television picture, which is the 
exponent of that power law which is used to approximate the curve of output magnitude 
versus input magnitude over the region of interest. 

Gamma Correction - To provide for a linear transfer characteristic from input to output 
device. 

Gate structure - This polysilicon structure located on the parallel register of a CCD. A 
gate is transparent at long wavelengths, but becomes opaque at wavelengths shorter than 
400 nm.

Gray level - The brightness of pixels as related to a digitized image; commonly expressed 
in integers ranging from 0 (black) to 255 (white) for an 8-bit digital signal.

Gray scale - The various shades of gray or luminance values in a displayed image. An 
analog scale that goes from 0 (black) to 10 (white). There are two versions: one is linear, 
the other is logarithmic.

Gray value - See gray level.

H
High-current switching devices - Any electrical or electronic circuit that turns the current 
on or off to devices that consume large amounts of current.

High-speed framing - Process by which frames are read from the CCD at a rapid rate.

Host computer - The primary or controlling computer for a digital camera.

Hue - Corresponds to colors such as red, blue, etc. 

Hz (hertz) - Cycles per second. MHz (megahertz) is a million cycles per second.

I
IC - Integrated circuit.

Illuminance - The density of luminous flux incident on a uniformly illuminated area, 
measured in footcandles (lumens per square foot) or lux (lumens per square meter).

Iillumination - See illuminance.

Image - An optical counterpart of an object formed by lenses or mirrors.

Image analysis - The use of digital computers to derive numerical information regarding 
selected image features, such as contour lengths, areas, shape, size distribution, and so 
forth.

Image array - The half of a frame-transfer CCD camera that is exposed to light and in 
which an image is collected. After the CCD camera is exposed, it is shifted to and stored in 
the other half of the CCD, the storage array.

Image averaging - A way of reducing snow and other random image noise by averaging 
the pixel brightness in several successive video frames. Achieved with a digital image 
processor or by photographic integration.
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Image convolution - In manipulating an image with a digital image processor, the 
substitution of the gray value of each pixel with another gray value that takes into account 
the gray values of the neighboring pixels. The convolution mask, or kernel, used to 
calculate the influence of the neighbors, determines the degree to which the image is 
sharpened or smoothed by the convolution process. Contrasts with point operation, where 
the gray value of each pixel is transformed without considering the neighbors. Also called 
convolution.

Image enhancement - A procedure for manipulating the signal to sharpen or otherwise 
improve the image.

Image intensifiers - A light-in, light-out vacuum-tube device capable of amplifying low-
light images. The tube consists of a photocathode on the input and a phosphor on the 
output, and sometimes a microchannel plate for increased gain characteristics. They are 
made in two different types: inverter and proximity focused. The inverter type 
electrostatically focuses and inverts the image inside the tube. The proximity focused type 
has all of the elements closely spaced, has no need for focus electrodes, and is much 
more compact.

Image processing - Generally refers to digital or analog enhancement and geometric 
manipulation of the video signal. Contrasts with image analysis, which emphasizes the 
measurement of image parameters. See also image analysis, image enhancement.

Image segmentation - In digital image processing, the partitioning of the image into 
nonoverlapping regions according to gray level, texture, and so forth.

Indium tin oxide - See ITO.

Infrared - Lying outside the visible spectrum at its red end.

Input/out (I/O) bus - See bus.

Integrated circuit (IC) - Electronic circuit conducted on a single semiconductor wafer or 
microchip.

Integration - The act of accumulating signal or charge on a video sensor such as a CCD. 
Usually done by inhibiting readout via electronic control of the scan.

Integration Time - The integration time is the time interval that the photoelements are 
allowed to collect charge. 

Interface - Hardware and/or software required to connect peripheral to computer system, 
one computer system to another, or for user's access to system; point at which any two 
parts of system connect.

Interline mask - In CCD image technology, opaque strips that span an interline-transfer 
CCD camera and act as storage areas. See also interline-transfer CCD camera.

Interlaced - A format of video display. Video is produced by updating the odd-number 
lines on the first scan and the even-numbered lines on the second scan.

Interline transfer - See interline-transfer CCD camera.

Interline-transfer CCD camera - A type of CCD camera in which the parallel register is 
subdivided so that, like a Venetian blind, opaque strips span and mask the columns of 
pixels. The masks act as storage areas. When the CCD is exposed to light, the image 
accumulates in the exposed areas (photosites) of the parallel register. In the serial 
register, the entire image is under the interline mask when it shifts for readout. Contrasts 
with frame-transfer CCD camera and full-frame CCD camera.

Inverted operation - See multi-pinned-phase (MPP) operation.

Iris - An adjustable aperture built into a camera lens to permit control of the amount of light 
passing through the lens. 

ITO - Indium tin oxide. A material used in CCD gates to provide higher quantum efficiency.

L
Lens - Transparent pieces of optical glass with curved surfaces that transmit light and 
cause it to converge or diverge into real or virtual images. 
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Lumen - A unit of luminous flux, equal to the flux through a unit solid angle (steradian) 
from a uniform point source of 1 cd. or 1 FC (foot candle) per sq. foot. (See Burle Electro-
Optics Handbook, Section 2.1)

Lumigen - A fluorescent coating applied to a CCD to enhance the UV response. Similar to 
Metachrome.

Luminance - Photometric brightness, or the brightness of light calibrated for a sensor 
whose spectral response is similar to the light-adapted human eye; measured in nits or 
footlamberts. See also photometric units.

Lux - The amount of visual light measured in metric units at the surface that the light is 
luminating. One lux equals one lumen per square meter. One footcandle equals 
10.764 lux. (See Burle Electro-Optics Handbook, Section 2.1).

M
Magnification - Relationship of the length of a line in the object plane to the length of the 
same line in the image plane. It may be expressed as image magnification  
(image size/object size) or it's inverse, object magnification. 

Mask - See interline mask.

Metachrome® II - A coating on a CCD that extends the CCD's sensitivity to below 200 
nm. Metachrome II is transparent from 400 to 1100 nm. The coating does not degrade 
over time.

Moiré - Irregular, wavy pattern.

Monitor - A device that converts the video signal from a camera, VTR, computer, etc. into 
an image that is displayed on its cathode-ray tube. Compared to a TV receiver that must 
first decode an RF-modulated video signal, the monitor has no tuner and accepts the 
signal from the source without demodulation, thus permitting the use of a higher 
bandwidth and providing greater resolution.

Monochrome - Black and white with all shades of gray. 

MPP - Multi-pinned-phase (MPP) operation. Procedure that reduces the rate of dark-
current generation by a factor of 20 or more, and thus relaxes CCD cooling requirements 
to the level where a thermoelectric cooler is sufficient for most applications. Also called 
inverted operation.

Multi-Camera Synchronization - A feature allowing multiple cameras to have time 
synchronized data for the purpose of interfacing to a single framegrabber. Allows 
simultaneous data acquisition from multiple cameras into one framegrabber. 

N
Noise - (1) An unwanted signal or a disturbance (as static or variation of voltage) in an 
electronic device or instrument; electromagnetic radiation (as light or radio waves) that is 
composed of several frequencies and that involves random changes in frequency or 
amplitude. (2) A disturbance, especially a random and persistent disturbance, that 
obscures or reduces the quality or clarity of a signal.

NTSC - Abbreviation for National Television Systems Committee. A committee that 
worked with the FCC in formulating standards for the present day United States color 
television system. 

Nyquist Theorem - A theorem that, applied to image processing systems, states that the 
original image can be reconstructed without distortion if it is sampled at a spatial 
frequency (2f) at least twice that of the maximum constituent frequency (f). 

O
Offset - An electronic process that alters the voltages representing an image, putting them 
into the optimal range for the A/D converter. Offset can be used to compensate for 
background noise or amplification due to gain. 

Opaque mask - In CCD imaging technology, a light-impenetrable material that is used to 
shield selected parts of a photosensitive surface. Opaque masks are used in interline- and 
frame-transfer CCD cameras.
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Optical coupling - The act of transferring the image from the optical output of one 
detector to another using lenses. As in optically coupling an image intensifier to a CCD 
camera.

Optical noise - Image defects that become especially conspicuous when the image is 
enhanced. In video microscopy, includes hot spots, mottle, uneven illumination.

Origin - In a CCD, the point located closest to the output node.

Output amplifier - In CCD image technology, mechanism in the CCD that takes the 
electrons in the output node and amplifies them sufficiently to get the signal to the analog-
to-digital converter. The output amplifier is the source of read noise.

Output node - The location on the CCD where charge is collected as a discrete picture 
element for readout.

P
Parallel binning - In CCD imaging, the accumulation of charge (in a pixel) in the CCD's 
parallel register before the charge is shifted to the serial register. The amount of charge to 
be shifted is defined by the user-specified binning factor. See binning factor.

Parallel binning factor - In the parallel register of a CCD, the number of pixels (in the 
parallel direction) to be shifted to the serial register, read out, and processed into an 
image. The binning factor is specified by the user in the imaging software prior to 
exposure of the CCD.

Parallel direction - In a serial, parallel (s, p) coordinate system, the direction that starts 
from the origin and and runs perpendicular to the serial register.

Parallel offset - In a CCD parallel register, the distance (in pixels) between the serial axis 
and user-defined, rectangular exposure area on the CCD.

Parallel register - In a CCD, a large, square array that contains many potential wells 
(pixels). When the CCD is exposed to light, charge accumulates in the potential wells, 
which, when shifted and read out, form an image.

Parallel shift - In a CCD, columnar movement of charge from one or more pixels to an 
adjacent row. The movement continues until the number of pixels the user specifies to be 
binned are emptied into the serial register.

Parallel size - In CCD image technology, the size of the region of interest (in pixels) 
extending in the parallel direction.

Phosphor - Substance that is capable of luminescence.

Photometric units - The units (1 m, l x, cd/m, etc.) that are used to measure the amount 
of light (illuminance) or the brightness of an object or image (luminance), taking into 
account the sensitometric characteristics (wavelength-dependent response) of the human 
eye. Contrasts with radiometric units (for example, W/m), which measure light in terms of 
the physical energy independent of the sensitometric characteristics of the eye.

Photon - Massless quantum of electromagnetic radiation or light energy.

Photon (shot) noise - Unwanted or undesirable disturbance that is a fundamental 
property of the quantum nature of light. Created by photons emitting a steady source of 
time and photoelectrons collected by a CCD. Photon noise is unavoidable and is always 
present in an imaging system. It equals the square root of the mean signal.

Photon-limited operation - The use of chilled photomultipliers, charge-coupled devices, 
or intensifier camera tubes at levels of light and noise so low that individual photons can 
give rise to clearly detectable bursts of electrons. Commonly, about 10% of the absorbed 
photons trigger a signal, and the level of energy of the electrons is statistically distributed. 
Also called photon-counting mode, quantum-limited mode. 

Picture - A visual representation or image of something. See also image.

Pixel - Picture element; a single dot and smallest element in a visual display.

Poisson distribution - A probability density function that is often used as a mathematical 
model of the number of outcomes obtained in a suitable interval of time and space.
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POT - Potentiometer.

Potentiometer (POT) - A center-tapped variable resistor, generally used for adjusting the 
signal or bias voltage levels.

Preamplifier noise - In CCD imaging, unwanted signal or disturbance that is generated 
by the on-chip output amplifier. The noise can be reduced to a few electrons by modifying 
operating conditions. Also called read noise. See also output amplifier.

Primary Colors - Three colors wherein no mixture of any two can produce the third. In 
color television these are the additive primary colors red, blue and green. 

Progressive Scan - The progressive scan format outputs data from the camera (the 
signal) in sequential order as it is scanned. The scan format produces a full frame of video 
in a continuous stream, rather than half the image per output sequence in traditional RS-
170 CCD cameras. Standard RS-170 video is interlaced and output in two separate fields, 
generating essentially half the image at a time. With Cohu's new 6600 Series Progressive 
Scan Camera, a new, full image is output from the camera every 1/60th second, making it 
ideal for machines to more quickly process and display information, or act according to 
programmed instructions. 

Q
Quantum efficiency - The measure of the effectiveness of an camera to produce 
electronic charge from incident photons. Especially important to perform low-light-level 
imaging.

R
Read noise - See preamplifier noise.

Readout - In CCD imaging, the removal of charge from the serial register to signal 
processing. The signal processing translates the charge into an image.

Region - In CCD imaging, a user-defined, rectangular area on the CCD that is exposed 
and processed as an image.

Region definition - In CCD imaging, the area on a CCD that a user selects to be exposed 
as an image. The user defines the region by specifying coordinates in the serial, parallel 
(s, p) coordinate system. See serial, parallel (s, p) coordinate system.

Region of interest (ROI) - User-defined, rectangular exposure area on the CCD.

Resolution - A measure of how fine a detail can be detected, in terms of distance in 
space or passage of time. Note that the convention used to measure spatial resolution in 
video is every black and white line counted, giving the term "TV lines."

Responsivity - Similar to sensitivity; a rating of the output current from a camera tube or 
CCD divided by the incident flux of light, usually expressed in signal current per watt of 
input radiation at a specific wavelength.

ROI - Region of interest.

S
Saturation - In color, the degree to which a color is diluted with white light or is pure. The 
vividness of a color, described by such terms as bright, deep, pastel, pale, etc. Saturation 
is directly related to the amplitude of the chrominance signal. 

Scientific-grade CCD - Camera component that offers fewer defects than commercial 
cameras. Scientific-grade CCDs produce better resolution, have low noise, and enable the 
user to accurately measure intensity differences between objects.

Sensitivity - Similar to responsivity of a camera tube or CCD but numerically different. It is 
the signal current per unit of illuminance on the faceplate in lumens. It is expressed in 
amps/lumen. Unless otherwise specified, the radiation is understood to be that of an 
unfiltered incandescent source at 2,856 degrees K. See also responsivity.

Serial binning - The accumulation of charge in two or more rows of the serial register 
before the charge is shifted for readout.
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Serial binning factor - In the parallel register of a CCD, the number of pixels (in the serial 
direction) to be shifted to the serial register, read out, and processed into an image.  
The binning factor is specified by the user in the imaging software prior to exposure of the 
CCD.

Serial direction - In a serial, parallel (s, p) coordinate system, the direction originating 
from the origin and moving away from it in a direction parallel to the serial register.

Serial offset - In a CCD parallel register, the distance (in pixels) between the parallel axis 
and user-defined, rectangular exposure area on the CCD.

Serial, parallel coordinate system (s, p) - In CCD imaging technology, the point of 
orientation located on the parallel register in the corner closest to the serial register 
readout. Coordinates increase as the locations move away from the origin. “s” represents 
the serial coordinate; “p” represents the parallel coordinate.

Serial register - In a CCD camera, a one-dimensional CCD adjacent to the parallel 
register. When the CCD is exposed to light, the serial register receives charge from the 
parallel register and shifts it to readout to form an image.

Serial shift - In a CCD, the movement of charge (accumulated from the parallel register) 
to the output amplifier. The charge moves pixel by pixel. From the amplifier, the charge is 
processed and read out as an image.

Serial size - In CCD image technology, the size of the region of interest (in pixels) 
extending in the serial direction.

Shutter - A camera attachment that exposes the film or plate by opening and closing an 
aperture.

Signal-to-noise ratio (SNR) - In CCD imaging, the measure of the signal quality at a 
given pixel. It is the ratio of the measured signal to the overall noise at that pixel.

Silicon - A tetravalent nonmetallic element that occurs combined as the most abundant 
element next to oxygen in the earth's crust. Silicon is used especially in alloys and 
electronic devices. 

Slow scan - A system of video scanning in which the time used to read each line has 
been increased in comparison to standard video. The bandwidth needed to faithfully 
transmit or record the signal is reduced in inverse ratio to the scanning time. Slow scan 
allows the video signal to be transmitted over a telephone line, or line scans to be 
registered on a chart recorder without loss of spatial resolution.

Slow-scan camera - A camera designed to operate at a significantly lower speed than 
conventional video cameras.

Slow-scan CCD - A CCD image detector that has special circuits allowing for readout of 
the information at slower-than-standard video rates to reduce readout noise.

SNR - Signal-to-noise ratio. 

Spectroscopy - The production and investigation of spectra; the physics that deals with 
the theory and interpretation of interactions between matter and radiation (as 
electromagnetic radiation). 

Spike - In electronics, a sharp brief voltage pulse. Powerful RF spikes that can damage 
video equipment and computers are generated when mercury or xenon arc lamps are 
started. To a limited extent, spikes entering through the power line (but not those rated as 
RF) can be suppressed with spike arrestors (transient suppressors).

Storage array - In a frame-transfer CCD camera, the half of the parallel register that is 
covered with an opaque mask to provide temporary storage for collected charge. 

STROBE - A camera clocking signal; used for data acquisition. Sometimes referred to as 
the pixel clock. 

Sync - A contraction of "synchronous" or "synchronize". 

Sync Generator - A device for generating a synchronizing signal. 

Sync Level - The level of the peaks of the synchronizing signal. 
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Sync Signal - The signal employed for the synchronizing of scanning. 

Synchronizing - Maintaining two or more scanning processes in phase. 

System noise - In CCD imaging, undesirable signals or disturbance generated by 
electronic circuitry. System noise includes photon noise, preamplifier noise, and dark 
current noise.

T
TDI - Time-delay integration.

Thermally generated charge - See dark current.

Thermoelectric cooling - In CCD imaging, the process of pulling heat away from a CCD 
by using Peltier cooling devices.

Thinning - Process that uses acid etching to uniformly reduce the size of CCDs to 
approximately 10 µm so that an image can be focused on the backside of its parallel 
register (where there is no gate structure). Thinned CCDs exhibit a high sensitivity to 
photons ranging from the soft x-ray to the near-infrared regions of the spectrum.

Time-delay integration - An integration and readout mode that allows the acquisition of 
long swaths of a moving image.

Trigger - Signal (typically a TTL signal) that is transmitted to synchronize two or more 
instruments; something that acts like a mechanical initiator in setting up a process or 
reaction. 

U
Ultraviolet - Of or pertaining to the range of radiation wavelengths from about 4000 
angstroms (just beyond the violet in the visible spectrum) to about 40 angstroms  
(on the border of the x-ray region).

Unichrome - A coating on a CCD that extends the CCD's sensitivity to below 200 nm. 
Unichrome is transparent from 400 to 1100 nm. The coating does not degrade over time.

V
Video camera - Camera for electronically processed videotape that requires no 
developing.

Volt - The International System unit of electric potential and electromotive force, equal to 
the difference of electric potential between two points on a conducting wire carrying a 
constant current of one ampere when the power dissipated between the points is one 
watt.

Voltage - Electric potential or potential difference expressed in volts.

W
Wavelength - In a periodic wave, the distance between two points of corresponding 
phase in consecutive cycles.

Well Capacity - The total number of electrons a pixel can hold before blooming. Also 
called the Saturation level. 

X
X-ray - High-energy photon with a wavelength in the approximate range from 0.05 
angstroms to 100 angstroms.
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